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はじめに 
 

 
この度は、『SUZAKU スターターキット』をお買い上げいただきありがとうございます。 
 
本スターターキットは、FPGA 搭載ボード"SUZAKU"を初めて手に取る方にもお使いいただけるよう、第一歩を踏

み出すために必要な機材をセットにした学習用キットです。 
 
"SUZAKU"は FPGA（Field Programmable Gate Array）を搭載した組み込み機器開発ボードです。FPGA と

は簡単にいうとプログラミングすることができる LSI のことで、さまざまな設計データを送り込んで再構築させることが

可能なデバイスです。 
この FPGA は近年、より大規模化・低価格化してきています。現在では容易に入手できる FPGA ひとつで、内部

にプロセッサと複数の必要な周辺回路を同時に構成するといったことが可能となっています。例えば UART がいく

つも欲しい、GPIO ポートが大量に必要だ、画像処理を高速に行うための回路を投入したい、さらに、プロセッサを 2
つ持ちたいといった場合ですら、回路規模が許す限り自由に構成することが可能なのです。 

 
"SUZAKU"は、この FPGA の利点を最大限に生かすべく誕生した小型 FPGA ボードです。 
"SUZAKU"の特徴を以下に挙げます。 
 
○ 固定された外部インターフェースとして、Ethernet と RS-232C を持っています。 
○ マイクロコンピュータボードとして動作するために必要な要素であるクロック、DRAM、フラッシュメモリ、

Ethernet MAC/Phy、RS-232C ドライバ/レシーバが、基板上に実装されています。 
○ 電源は+3.3V 単一入力です。内部に FPGA 用の電源である 2.5V、1.2V を作る回路が組み込まれています。

また、FPGA を再コンフィギュレーション可能にするための回路が組み込まれています。 
○ 基板の外周に沿って 86 個（SZ310-U00 は 70 個）の空きピンが備えられています。これらはすべて FPGA

の I/O ピンに結線されており、外部デバイスや装置との接続のため自由に使用することができます。 
○ FPGA の中ではソフトプロセッサ（MicroBlaze）もしくはハードプロセッサ（PowerPC）が動いています。 
○ フラッシュメモリの中には、OS（Linux）、Ethernet などのデバイスドライバ、アプリケーション群が書き込まれ

ており、電源を入れるだけでこれらを利用することができるようになっています。 
○ 高機能である Linux を使用しながら、同時にリアルタイム処理を行うような用途向けに構成することも可能で

す。 
○ 基板上には SDRAM が 2 枚実装されており、これらを FPGA 内に構成した 2 つの CPU から独立して使用

させることができるため、片方で Linux を、他方でリアルタイム OS を動作させる、といった使い方ができます。
※ 

 
以上のように"SUZAKU"は、FPGA が持つ柔軟性と、Linux が持つ高機能性、豊富なソフトウェア資産等これら

の利点を同時に享受することができるプラットフォームです。これらの特徴を利用することにより、旧来の開発手法に

比べて開発期間を短縮し、コストダウンを実現することができます。 
 

"SUZAKU"上での開発作業の流れは、 
① FPGA 開発 
② ソフトウェア開発 
の 2 段階に大きく分けることができます。本書ではこのうち①FPGA 開発について、実際に"SUZAKU スターター

キット"を使用しながら解説していきます。②ソフトウェア開発については、本書と対となる"SUZAKU スターターキット

ガイド（Linux 開発編）"をご参照ください。 
本書を足掛かりとして、SUZAKU 開発者のスペシャリストを目指していただければ幸いです。 

 
 

                                                  
※ SDRAM が 2 枚実装されているのは SZ130-U00 および SZ410-U00 です。 
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・対象となる読者 
本書は SUZAKU の FPGA 開発者向けに書かれた入門書です。SUZAKU の FPGA には初めからプロセッサ

が搭載されており、ディジタル回路、プロセッサ、バス、メモリ等様々な要素が絡み合ってきます。このため、どこで何

が行われているのか分からない、やりたいことがあっても、それを実現するためにはどこをどうすればよいのか分から

ないという方もおられると思います。 
本書では、どこから手をつけていいか分からない方、SUZAKU をはじめて使う方、SUZAKU での FPGA 開発

方法について丁寧で分かりやすい説明を望む方を対象としています。 
 

・本書の構成 
本書では、SUZAKU スターターキットを使用してスロットマシンを製作しながら、SUZAKU の使い方について解

説してきます。内容は 3 部構成となっています。 
第 1 部では SUZAKU で FPGA 開発を行うために必要な知識や準備について説明をします。SUZAKU および

LED/SW ボードについて(第１、2、3 章)と、作業の前に必要な準備と簡単な SUZAKU の使い方（第 4、5、6 章）を

説明します。 
第 2 部では Xilinx の ISE というツールを用い、プロセッサを含まない FPGA の開発を実際に SUZAKU スター

ターキットを用いて体験します。まず、単色 LED を 1 つだけ点灯する簡単な回路の作成から始まり(第 7 章)、組み

合わせ回路、順次回路の説明をし(第 8 章)、これらを踏まえて、スロットマシンの要素となる回路(単色 LED 順次点

灯回路、7 セグメント LED デコーダ回路、ダイナミック点灯回路)を作成していきます(第 9 章)。 
第 3 部では Xilinx の EDK というツールを用い、プロセッサを含んだ FPGA の開発を実際に SUZAKU スター

ターキットを用いて体験します。まずは EDK がどのようなツールであるのかを説明し、SUZAKU のデフォルトの構

成を説明します(第 10 章)。その後、ISE で作成した回路を IP コアにして SUZAKU と接続し、スロットマシンを完

成させます(第 11 章)。最後に、こんなこともやってみよう、という例を示します(第 12 章)。 
スロットマシンを最後までつくり上げる頃には、SUZAKU の効果的な使い方を学んでいただけたるのではないか

と思います。 
 
・表記について 

本書は SUZAKU-S(SZ010-U00、SZ030-U00、SZ130-U00)、SUZAKU-V(SZ310-U00、SZ410-U00)を対象

に書かれています。内容によってはすべての SUZAKU に当てはまらない場合がございます。当てはまらないものが

ある場合は以下の記号で対象となる SUZAKU を示します。 

 
また、これ以降型番の-U00 を省略して表記します。 
 
本書では以下のようにフォントを使っています。 
 

フォント例 説明 
本文中のフォント 本文 
SUZAKU %  プロンプトの文字列 
std_logic_vector VHDL 記述 
#include C 言語記述 
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注意事項 
 

 
・安全に関する注意事項 
 

SUZAKU スターターキットを安全にご使用いただくために、特に以下の点にご注意くださいますようお願いいたし

ます。 
 

 
 

 
 

 

 

 

 

 

 

 

・保証に関する注意事項 
 
● 製品保証範囲について 

付属品（ソフトウェアを含みます）を使用し、取扱説明書、各注意事項に基づく正常なご使用に限り有効です。

万一正常なご使用のもと製品が故障した場合は、初期不良保証期間内であれば新品交換をさせていただきます。 
 
● 保証対象外になる場合 

次のような場合の故障・損傷は、保証期間内であっても保証対象外になります。 
1. 取扱説明書記載の使用方法、または注意に反したお取り扱いによる場合 
2. 改造・調整や部品交換による場合。または正規のものを使用していないか、あるいは過去に使用されてい

た場合 
3. お客様のお手元に渡った後の輸送、移動時の落下等お取り扱いの不備による場合 
4. 火災・地震・水害・落雷・その他の天災、公害や異常電圧による場合 
5. AC アダプタ・ケーブル等の付属品について、同梱のものを使用していない場合 
6. 付属品がすべて揃っていない場合 

 
● 免責事項 

弊社に故意または重大な過失があった場合を除き、製品の使用および、故障、修理によって発生するいかなる

損害についても、一切の責任を負わないものとします。 
 

 

 
 

 

 

本製品には一般電子機器用（ＯＡ機器・通信機器・計測機器・工作機械等）に製造さ

れた半導体部品を使用していますので、その誤作動や故障が直接生命を脅かした

り、身体・財産等に危害を及ぼす恐れのある装置（医療機器・交通機器・燃焼制御・

安全装置等）に組み込んで使用したりしないでください。また、半導体部品を使用し

た製品は、外来ノイズやサージにより誤作動したり故障したりする可能性があります。

ご使用になる場合は万一誤作動、故障した場合においても生命・身体・財産等が侵

害されることのないよう、装置としての安全設計（リミットスイッチやヒューズ・ブレーカ等

の保護回路の設置、装置の多重化等）に万全を期されますようお願い申しあげます。 
発熱により高温になる部品があります。周囲温度や取り扱いによってはやけどの恐れ

があります。電源が入っている状態および電源切断後しばらくは本製品に触れないよ

うお願い申しあげます。 

本製品は購入時の初期不良以外の保証を行っておりません。保証期間は商品到着

後 2 週間です。本製品をご購入しましたらお手数でも必ず動作確認を行ってからご

使用ください。本製品に対して注意事項を守らずに発生した故障につきましては保証

対象外となります。 
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・取り扱い上の注意事項 
 

劣化、破損、誤動作、発煙、発火の原因となることがあります。取り扱い時には以下のような点にご注意ください。 
 

● 入力電源 
 5V+5%以上の電圧を入力する、極性を間違う等しないでください。また、SUZAKU の＋3.3V 外部入力

(CON6)に電源を供給しないでください。 
 

● インターフェース 
 各インターフェース(外部 I/O、RS-232C、Ethernet、JTAG)には規定以外の信号を接続しないでください。

また、信号の極性、入出力方向を間違わないでください。 
 

● 本製品の改造 
 本製品について改造を行った場合は保証対象外となりますので、十分にご注意ください。（※コネクタ非搭載

箇所へのコネクタの増設を除く。） 

 コネクタを増設する際にはマスキングを行い、周囲の部品に半田くず、半田ボール等付着しない様十分にご

注意ください。 
 なお、改造を行う場合は、改造前の動作確認を必ず行うようお願いします。 

 

● FPGA プログラム 
 周辺回路(ボード上の部品も含む)と信号の衝突(同じ信号に 2 つのデバイスから出力する)を起こすような

FPGA プログラムを行わないでください。FPGA のプログラムを間違わないでください。 

 

● 電源の投入 
 本ボードや周辺回路に電源が入っている状態では絶対に FPGA I/O、JTAG 用コネクタの着脱を行わないで

ください。 

 

● 静電気 
 本ボードには CMOS デバイスを使用していますので、ご使用になるまでは帯電防止対策のされている、

出荷時のパッケージ等にて保管してください。 

 

● ラッチアップ 
 電源および入出力からの過大なノイズやサージ、電源電圧の急激な変動等で、使用している CMOS デバイ

スがラッチアップを起こす可能性があります。いったんラッチアップ状態となると、電源を切断しないかぎりこの状

態が維持されるため、デバイスの破損につながることがあります。ノイズの影響を受けやすい入出力ラインには保

護回路を入れる、ノイズ源となる装置と共通の電源を使用しない等の対策をとることをお勧めします。 

 

● 衝撃、振動 
 落下や衝突などの強い衝撃や、強い振動、遠心力を与えないでください。振動部や回転部などへの搭載はし

ないでください。 

 

● 高温低温、多湿 
 極度に高温や低温になる環境や、湿度が高い環境では使用しないでください。 

 

● 塵埃 
 塵埃の多い環境では使用しないでください。 
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・FPGA 使用に関しての注意事項 
 

本製品に含まれる FPGA プロジェクト(付属のドキュメント等も含む)は、現状のまま(AS IS)提供されるものであり、

特定の目的に適合することや、その信頼性、正確性を保証するものではありません。また、本製品の使用による結果

について、なんら保証するものではありません。 

本製品は、ベンダのツール(Xilinx 製 EDK、ISE やその他ベンダツール)やベンダの IP コアを利用し、FPGA
プロジェクトの構築、コンパイル、コンフィギュレーションデータの生成を行っておりますが、これらツールに関しての

販売、サポート、保証等は行っておりません。 
 

・ソフトウェア使用に関しての注意事項 
 

本製品に含まれるソフトウェア(付属のドキュメント等も含みます)は、現状のまま(AS IS)提供されるものであり、特

定の目的に適合することや、その信頼性、正確性を保証するものではありません。また、本製品の使用による結果に

ついて、なんら保証するものではありません。 
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1. SUZAKU について 
 

 
 

初めに"SUZAKU"がどのようなボードであるのか簡単に説明します。SUZAKU の詳細については本書内いたる

ところにちりばめられていますので、ここでは概要をつかんでください。 
 
1.1. SUZAKU の特徴 

SUZAKU（朱雀）は FPGA をベースとしたボードコンピュータです。 
FPGA 上にプロセッサと周辺ペリフェラルコアを構成し、オペレーティングシステムとして Linux を採用しています。 

 

 

図 1-1 SUZAKU とは 

● FPGA & Function 
Xilinx の FPGA を採用し、大規模で柔軟な拡張をすることが出来ます。SZ010、SZ030 は Spartan-3､

SZ130 は Spartan-3E、SZ310 は Virtex-Ⅱ Pro、SZ410 は Virtex-4 FX を搭載しています。FPGA の内部は

Xilinx やサードパーティ各社から供給される IP(Intellectual Property)を使用することで、必要な機能を容易に

追加することが出来ます。また、ユーザによってもカスタマイズが可能です。 
 
● CPU 

SZ010、SZ030、SZ130 は低コストで資産継承性の高いソフトプロセッサの MicroBlaze を採用し、SZ310、

SZ410 は高性能で実績の高いハードプロセッサの PowerPC を採用しています。 
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● Linux & Software 

Linux を標準のオペレーティングシステムとして採用しているので、アプリケーションソフトウェアの開発には

GNU のアセンブラや C コンパイラ等を使用することができます。SZ010、SZ030、SZ130 は MMU 不要の 
μCｌinux、SZ310、SZ410 は標準的な Linux に対応しています。デバイスドライバから各種サーバソフトウェアま

で、オープンソースで開発された Linux 対応の豊富なソフトウェア資産を活用することが出来ます。 
 
● I/O 

基板外周に SZ010、SZ030、SZ130、SZ410 は 86 ピン、SZ310 は 70 ピンのユーザが自由に使える外部 I/O
を実装しています。例えば、GPIO や UART の数を増やし、外部 I/O ピンに割り当てるなどのカスタマイズが簡単

に行えます。 
 
● Network 

ボードには LAN(10BASE-T/100BASE-TX)が実装されています。LAN コントローラデバイスドライバ、各種プ

ロトコルが最初から用意されているので、簡単にネットワークに接続できます。 
 
 

 
 
TIPS  MicroBlaze 

 
MicroBlaze は Xilinx が提供する 32 ビット RISC コアです。MicroBlaze のブロック図を以下に示します。 

BUS
I/F

フェッチ

命令バッファ

命令デコード

PC

プログラム
カウンタ

32 × 32bit
レジスタ

BUS
I/F

演算

インストラクション
バスインターフェース

データ
バスインターフェース

Add/Sub

Shift/Logical

Multiply

I-OPB

I-LMB

D-OPB

D-LMB

MFSL0..7

SFSL0..7

BRAM

SDRAM,
Flash

BRAM

SDRAM,
Flash.
etc

 
図 1-2 MicroBlaze ブロック図 

 
主な機能 
 

・32bitRISC プロセッサ 
・32bit 固定長命令 
・32 個の汎用 32bit レジスタ 
・MMU なし 
・命令キャッシュとデータキャッシュ 
・ハードウェア乗算器 
・ハードウェアデバッグロジック対応 
・ペリフェラルバス OPB(CoreConnect) 
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1.2. 仕様 

SUZAKU の主な仕様を以下に示します。 
 

表 1-1 SUZAKU の仕様 

  SUZAKU-S SUZAKU-V 
モデル SZ010 SZ030 SZ130 SZ310 SZ410 

FPGA デバイス Xilinx 
Spartan-3 

Xilinx 
Spartan-3 

Xilinx 
Spartan-3E 

Xilinx  
Virtex-II Pro 

Xilinx 
Virtex-4 FX 

  (XC3S400) (XC3S1000) (XC3S1200E) (XC2VP4) (XC4VFX12) 
CPU コア MicroBlaze PowerPC405 
CPU クロック 51.6096MHz 265.4208MHz 350MHz 
水晶発振器周波数 3.6864MHz  100MHz 
DRAM 16MB 16MB×2 32MB 32MB×2 
フラッシュメモリ  4MB 8MB 8MB (SPI) 8MB 8MB (SPI) 
Ethernet 10BASE-T/100BASE-TX 
拡張 I/O ピン 86 70 86 
シリアル 1ch(UART ： 115.2kbps) 
タイマ 2ch(OPB Timer ： 1ch は OS で使用） PowerPC 内蔵タイマ 

コンフィギュレーション TE7720 SPI 
フラッシュメモリ TE7720 SPI 

フラッシュメモリ

基板サイズ 72×47mm 
電源 電圧：＋3.3V±3% 
リセット機能 ソフトウェアリセット 
標準 OS μCｌinux Linux 
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1.3. 全体ブロック図 

SUZAKU の全体ブロック図について説明をします。IP コアについてはここでは説明しません。"10.2.5 IP コア"
をご参照ください。 
1.3.1. SZ010、SZ030 

SZ010 および SZ030 の全体ブロック図を以下に示します。 
 

SDRAM 
16MByte

FLASH
4MByte or 
8MByte

LAN
コントローラ

TE7720

FPGA
Spartan-3
40万ゲート

or
100万ゲート

RS232C
トランシーバ

RESET

POWER

+1.2V
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3.6864MHzDCM

アドレス／データバス

Reset

ユーザ
I/O

86ピン
RJ-45
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10ピン

+3.3Vin

JTAG
4 PIN

SUZAKU Board

起動モードジャンパ
LED

ソフトウェアリセット

MicroBlazeBRAM

D-LMB

I-LMB

OPB SDRAM
Controller

OPB Timer

OPB UART 
lite

OPB Interrupt
Controller

OPB GPIO

OPB EMC

OPB

I-OPB

D-OPB

SDRAM
フラッシュメモリ
LANコントローラ

RS232Cトランシーバ

起動モードジャンパ
ソフトウェアリセット

BUS
I/F

ユーザ
ロジック

ユーザ
I/O

FPGA

+2.5V

色部はXilinx EDKで提供さ
れるIPコアです

OPB GPIO ユーザコントロールLED

 
図 1-3 SZ010, SZ030 の全体ブロック図 
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1.3.1.1. プロセッサ 

FPGA 内部で MicroBlaze を使用しています。 
 
1.3.1.2. バス 

3 種類のバスで構成しています。 
・FPGA 内部 LMB(Local Memory Bus) 

 MicroBlaze と BRAM(FPGA 内部メモリ)を接続する専用バス 
・FPGA 内部 OPB(On-Chip Peripheral Bus) 

 複数のペリフェラル IP コアを接続するバス 
・FPGA 外部バス 

OPB EMC 及び OPB SDRAM Controller を介し、外部メモリデバイスなどを接続するバス 
 

 
図 1-4 SZ010, SZ030 のバス 

 
1.3.1.3. メモリ 

3 種類のメモリで構成しています。 
・FPGA 内部 BRAM (デフォルト 8kByte) 
 ブートプログラム用として使用しています。 

起動完了後は、先頭の 32Byte(割り込みベクタ領域)以外であれば、ユーザプログラムで使用することもで

きます。 
・FPGA 外部フラッシュメモリ  

SZ010 は 4MByte、SZ030 は 8MByte を実装しています。 
ブートローダ Hermit や Linux、FPGA コンフィギュレーションデータなどの保存に使用しています。 

 OPB-EMC を使用し、OPB と接続しています。 
・FPGA 外部 SDRAM 16MByte 

 Linux のメインメモリとして使用しています。 
 OPB SDRAMController を使用し、OPB と接続しています。 
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1.3.1.4. シリアルコンソール 

OS 用シリアルコンソールに OPB UART lite を使用しています。OPB UART lite は RS-232C トランシーバを

介し SUZAKU CON1 に接続しています。RS-232C トランシーバは、4 チャンネルタイプのものを実装しています。 
 

1.3.1.5. LAN 
LAN コントローラに、LAN91C111(メーカ：SMSC)を実装しています。LAN91C111 は OPB EMC を使用し

OPB と接続しています。 
 

1.3.1.6. FPGA コンフィギュレーション 
FPGA コンフィギュレーション IC に TE7720(メーカ：東京エレクトロンデバイス)を実装しています。TE7720 の詳

細については"6.2.2 LBPlayer2 で書き換える"をご参照ください。 
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yte
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図 1-5 SZ010, SZ030 の主要部品配置図 
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1.3.2. SZ130 

SZ130 の全体のブロック図は以下のとおりです。 
 

 
 

図 1-6 SZ130 の全体ブロック図 
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1.3.2.1. バス 

3 種類のバスで構成しています。 
・FPGA 内部 LMB(Local Memory Bus) 

 MicroBlaze と BRAM(FPGA 内部メモリ)を接続する専用バス 
・FPGA 内部 OPB(On-Chip Peripheral Bus) 

 複数のペリフェラル IP コアを接続するバス 
・FPGA 外部バス 

OPB EMC 及び OPB SDRAM Controller を介し、外部メモリデバイスなどを接続するバス 

MicroBlazeBRAM

D-LMB
I-LMB

OPB SDRAM
Controller

OPB EMC

I-OPB
D-OPB

FPGA内部

その他
ペリフェラル

コア

SDRAM 
16MByte

LAN
コントローラ

ユーザ追加
ペリフェラルコア

や
その他ユーザで作成
したさまざまなロジック

外部I/O
合計86ピン

SDRAM 
16MByte

 
図 1-7 SZ130 のバス 

1.3.2.2. プロセッサ 
FPGA 内部で MicroBlaze を使用しています。 
 

1.3.2.3. メモリ 
3 種類のメモリで構成しています。 
・FPGA 内部 BRAM (デフォルト 8kByte) 
 ブートプログラム用として使用しています。 

起動完了後は、先頭の 32Byte(割り込みベクタ領域)以外であれば、ユーザプログラムで使用することもで

きます。 
・FPGA 外部 SPI フラッシュメモリ 

8MByte を実装しています。 
ブートローダ Hermit や Linux、FPGA コンフィグデータなどの保存に使用しています。 

 OPB SPI を使用し、OPB と接続しています。 
・FPGA 外部 SDRAM 16MByte×2 

 Linux のメインメモリとして使用しています。 
 OPB SDRAM Controller を使用し、OPB と接続しています。 
 2 枚の SDRAM の信号線は、完全に 2 つに分離して、FPGA と接続されています。 
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1.3.2.4. シリアルコンソール 

OS 用シリアルコンソールに OPB UART lite を使用しています。OPB UART lite は RS-232C トランシーバを

介し、SUZAKU CON1 に接続しています。RS-232C トランシーバは、4 チャンネルタイプのものを実装しています。 
 
1.3.2.5. LAN 

LAN コントローラは LAN9115(メーカ：SMSC)を実装しています。LAN9115 は OPB EMC を使用し OPB と接

続しています。 
 

1.3.2.6. FPGA コンフィギュレーション 
SPI コンフィギュレーションを採用しています。SPI フラッシュメモリは M25P64(メーカ：ST マイクロエレクトロニク

ス)を実装しています。SPI フラッシュメモリの詳細については"6.2.3 SPI Writer で書き換える"をご参照ください。 
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図 1-8 SZ130 の主要部品配置図 
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1.3.3. SZ310 

SZ310 の全体のブロック図を以下に示します。 
 

 
 

図 1-9 SZ310 の全体ブロック図 
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1.3.3.1. プロセッサ 

FPGA 内部で PowerPC405 を使用しています。 
 

1.3.3.2. バス 
3 種類のバスで構成しています。 
・FPGA 内部 PLB(Processor Local Bus) 

 PowerPC405 と BRAM、PLB SDRAM Controller などのペリフェラル IP コアを接続するバス 
・FPGA 内部 OPB(On-Chip Peripheral Bus) 

 OPB UART lite、OPB INTC などのペリフェラル IP コアを接続するバス 
・FPGA 外部バス 

PLB EMC 及び、PLB SDRAM Controller を介し、外部メモリデバイスなどを接続するバス 
 

 
図 1-10 SZ310 のバス 

1.3.3.3. メモリ 
3 種類のメモリで構成しています。 
・FPGA 内部 BRAM (デフォルト 16kByte) 
 ブートプログラム用として使用しています。 

ブート完了後は、ユーザプログラムで使用することもできます。 
・FPGA 外部フラッシュメモリ  

8MByte を実装しています。 
ブートローダ Hermit や Linux システム、FPGA コンフィグデータなどの保存に使用しています。 

 PLB EMC と接続しています。 
・FPGA 外部 SDRAM 32MByte 

 Linux のメインメモリとして使用しています。 
 PLB SDRAM を使用し、PLB と接続しています。 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

       SUZAKU について 
 

12

 
1.3.3.4. シリアルコンソール 

OS 用シリアルコンソールに OPB UART lite を使用しています。OPB UART lite は RS-232C トランシーバを

介し、SUZAKU CON1 に接続しています。RS-232C トランシーバは、4 チャンネルタイプのものを使用しています。 
 
1.3.3.5. LAN 

LAN コントローラに、FPGA 外部に LAN91C111(メーカ：SMSC)を実装しています。 
LAN91C111 は、PLB EMC を使用し、PLB と接続しています。 
 

1.3.3.6. FPGA コンフィギュレーション 
FPGA コンフィギュレーション IC に TE7720(メーカ：東京エレクトロンデバイス)を実装しています。TE7720 の詳

細については"6.2.2 LBPlayer2 で書き換える"をご参照ください。 
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図 1-11 SZ310 の主要部品配置図 
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1.3.4. SZ410 

SZ410 の全体のブロック図を以下に示します。 
 

 
 

図 1-12 SZ410 の全体ブロック図 
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1.3.4.1. プロセッサ 

FPGA 内部で PowerPC405 を使用しています。 
 

1.3.4.2. バス 
3 種類のバスで構成しています。 
・FPGA 内部 PLB(Processor Local Bus) 

 PowerPC405 と BRAM、PLB DDR2 Controller などのペリフェラル IP コアを接続するバス 
・FPGA 内部 OPB(On-Chip Peripheral Bus) 

 OPB UART lite、OPB INTC などのペリフェラル IP コアを接続するバス 
・FPGA 外部バス 

PLB DDR2 Controller 等を介し、外部メモリデバイスなどを接続するバス 
 

PPC405

BRAM

PLB 
TEMAC

PLB DDR2
Controller

I-PLB
D-PLB

PLB2
OPB その他

ペリフェラル
コア

DDR2 SDRAM 
32MByte

Ether PHY

その他
ペリフェラル

コア

ユーザ追加
ペリフェラルコアや

その他ユーザで作成
したさまざまなロジック

ユーザ追加
ペリフェラルコアや

その他ユーザで作成
したさまざまなロジック

外部I/O
合計86ピン

FPGA内部

DDR2 SDRAM 
32MByte

HARD
TEMAC

 
図 1-13 SZ410 のバス 

1.3.4.3. メモリ 
3 種類のメモリで構成しています。 
・FPGA 内部 BRAM (デフォルト 16kByte) 
 ブートプログラム用として使用しています。 

ブート完了後は、ユーザプログラムで使用することもできます。 
・FPGA 外部 SPI フラッシュメモリ  

8MByte を実装しています。 
ブートローダ Hermit や Linux システム、FPGA コンフィグデータなどの保存に使用しています。 

 OPB SPI S を使用し、OPB と接続しています。 
・FPGA 外部 DDR2 SDRAM 32MByte×2 

 Linux のメインメモリとして使用しています。 
 PLB DDR2 Controller と接続しています。 
 2 枚の DDR2 SDRAM の信号線は完全に 2 つに分離して、FPGA と接続されています。 
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1.3.4.4. シリアルコンソール 

OS 用シリアルコンソールに OPB UART lite を使用しています。OPB UART lite は RS-232C トランシーバを

介し、SUZAKU CON1 に接続しています。RS-232C トランシーバは、4 チャンネルタイプのものを使用しています。 
 
1.3.4.5. LAN 

Virtex-4 FX 内蔵の TEMAC（Tri-Mode Ether MAC）と 10BASE-T/100BASE-TX の Ethrer PHY（メーカ：

SMSC）を使用しています 
 

1.3.4.6. FPGA コンフィギュレーション 
CPLD を使用した SPI コンフィギュレーションを採用しています。SPI フラッシュメモリは M25P64(メーカ：ST マイ

クロエレクトロニクス)を実装しています。SPI フラッシュメモリの詳細については"6.2.3 SPI Writer で書き換える"を
ご参照ください。 

 
 
 

D
D

R
2
 S

D
R

A
M

3
2
M

B
yte

 
図 1-14 SZ410 の主要部品配置図 
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TIPS  SZ410 の JTAG（CON7）コネクタの横のスルーホールは？ 

 
SZ410 の JTAG（CON7）コネクタの横のスルーホールは CPLD 書き込み用のスルーホールです。FPGA と

CPLD の JTAG ピンは以下の図のように TCK、TMS を共用する形で配線されています。CPLD を書き換えること

はもちろん出来ますが、書き換えに失敗してしまうと SUZAKU が動くようになるまでの復旧が大変なので、どうしても

ということがないかぎりは、CPLD を書き換えないようにしてください。 
 

 
 
 

 
 
 

 
 
TIPS  SZ410 CPLD と SPI フラッシュの採用理由 

 
CPLD と SPI フラッシュメモリを採用したのは、シリアルビットストリームである SPI はそのままマスターシリアルに

置き換えることが容易であり、また 8mm×6ｍｍの SPI フラッシュメモリと 5mm×5mm の CPLD(XC2C32QFP32
ピン)を使用すると、基板上の設置面積が小さくてすむからです。 
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1.4. メモリマップ 
1.4.1. SZ010、SZ030 

SZ010 および SZ030 のメモリマップは以下のとおりです。 

表 1-2 SZ010、SZ030 のメモリマップ 

Start Address End Address ペリフェラル デバイス 
0x0000 0000 0x0000 1FFF  BRAM  
0x0000 2000 0x7FFF FFFF  Reserved  
0x8000 0000 0x80FF FFFF  OPB-SDRAM Controller  SDRAM 16MByte 
0x8100 0000 0xFEFF FFFF  Free  
0xFF00 0000 0xFF7F FFFF  OPB-EMC  Flash 4MByte or 8MByte 
0xFF80 0000 0xFFDF FFFF  Free  
0xFFE0 0000 0xFFEF FFFF  OPB-EMC  LAN コントローラ 
0xFFF0 0000 0xFFFF 0FFF  Free  
0xFFFF 1000 0xFFFF 10FF  OPB-Timer  
0xFFFF 1100 0xFFFF 1FFF  Free  
0xFFFF 2000 0xFFFF 20FF  OPB-UART lite  RS-232C 
0xFFFF 2100 0xFFFF 2FFF  Free  
0xFFFF 3000 0xFFFF 30FF  OPB-Interrupt Controller  
0xFFFF 3100 0xFFFF 9FFF  Free  
0xFFFF A000 0xFFFF A1FF  OPB-GPIO  ブートモードジャンパ 

 ソフトウェアリセット 
0xFFFF A200 0xFFFF A3FF  OPB-LED  LED 
0xFFFF A400 0xFFFF FFFF  Free  

 
1.4.2. SZ130 

SZ130 のメモリマップは以下のとおりです。 

表 1-3 SZ130 のメモリマップ 

Start Address End Address ペリフェラル デバイス 
0x0000 0000 0x0000 1FFF  BRAM  
0x0000 2000 0x7FFF FFFF  Reserved  
0x8000 0000 0x81FF FFFF  OPB-SDRAM Controller  SDRAM 32MByte 
0x8200 0000 0xFEFF FFFF  Free  
0xFF00 0000 0xFF00 01FF  OPB-SPI  SPI Flash 8MByte 
0xFF00 0200 0xFFDF FFFF  Free  
0xFFE0 0000 0xFFE0 FFFF  OPB-EMC  LAN コントローラ 
0xFFE1 0000 0xFFFF 0FFF  Free  
0xFFFF 1000 0xFFFF 10FF  OPB-Timer  
0xFFFF 1100 0xFFFF 1FFF  Free  
0xFFFF 2000 0xFFFF 20FF  OPB-UART lite  RS-232C 
0xFFFF 2100 0xFFFF 2FFF  Free  
0xFFFF 3000 0xFFFF 30FF  OPB-Interrupt Controller  
0xFFFF 3100 0xFFFF 9FFF  Free  
0xFFFF A000 0xFFFF A1FF  OPB-GPIO  ブートモードジャンパ 

 ソフトウェアリセット 
0xFFFF A200 0xFFFF A3FF  OPB-LED  LED 
0xFFFF A400 0xFFFF FFFF  Free  
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1.4.3. SZ310 

SZ310 のメモリマップは以下のとおりです。 

表 1-4 SZ310 のメモリマップ 

Start Address End Address ペリフェラル デバイス 
0x0000 0000 0x01FF FFFF  PLB-SDRAM Controller  SDRAM 32MByte 
0x0200 0000 0xEFFF FFFF  Free  
0xF000 0000 0xF07F FFFF  PLB-EMC  Flash 8MByte 
0xF080 0000 0xF0DF FFFF  Free  
0xF0E0 0000 0xF0EF FFFF  PLB-EMC  LAN コントローラ 
0xF0F0 0000 0xF0FF 1FFF  Free  
0xF0FF 2000 0xF0FF 20FF  OPB-UART lite  RS-232C 
0xF0FF 2100 0xF0FF 2FFF  Free  
0xF0FF 3000 0xF0FF 30FF  OPB-Interrupt Controller  
0xF0FF 3100 0xF0FF 9FFF  Free  
0xF0FF A000 0xF0FF A1FF  OPB-GPIO  ブートモードジャンパ 

 ソフトウェアリセット 
0xF0FF A200 0xF0FF A3FF  OPB-LED  LED 
0xF0FF A400 0xFFFF BFFF  Free  
0xFFFF C000 0xFFFF FFFF  BRAM  

 
1.4.4. SZ410 

SZ410 のメモリマップは以下のとおりです。 

表 1-5 SZ410 のメモリマップ 

Start Address End Address ペリフェラル デバイス 
0x0000 0000 0x03FF FFFF  PLB-DDR2 Controller  DDR2 SDRAM 64MByte 
0x0400 0000 0xF0DF FFFF  Free  
0xF0E0 0000 0xF0E0 FFFF  PLB-TEMAC  Ether PHY 
0xF0E1 0000 0xF0FE FFFF  Free  
0xF0FF 0000 0xF0FF 01FF  OPB-SPI S  SPI Flash 8MByte 
0xF0FF 0200 0xF0FF 1FFF  Free  
0xF0FF 2000 0xF0FF 20FF  OPB-UART lite  RS-232C 
0xF0FF 2100 0xF0FF 2FFF  Free  
0xF0FF 3000 0xF0FF 30FF  OPB-Interrupt Controller  
0xF0FF 3100 0xF0FF 9FFF  Free  
0xF0FF A000 0xF0FF A1FF  OPB-GPIO  ブートモードジャンパ 

 ソフトウェアリセット 
0xF0FF A200 0xF0FF A3FF  OPB-LED  LED 
0xF0FF A400 0xFFFF BFFF  Free  
0xFFFF C000 0xFFFF FFFF  BRAM  
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2. LED/SW ボードについて 
 

 
 

SUZAKU スターターキットは"SUZAKU+LED/SW ボード"で構成されます。LED/SW ボードは SUZAKU の学

習用ボードとして生み出されました。LED/SW ボードについて回路図をみながら簡単に説明します。詳細について

は"7 ISE の使い方"で実際に LED/SW ボードに触りながら説明します。 
 
2.1. 回路説明 

以下の回路図が LED/SW ボードの回路図です。回路図及び部品表は付属 CD-ROM の 
"¥suzaku-starter-kit¥doc"に収録されているので詳細はそちらをご参照ください。 
LED/SW ボードには単色 LED が 4 つ（D1、D2、D3、D4）、押しボタンスイッチが 3 つ（SW1、SW2、SW3）、ロ

ータリコードスイッチが 1 つ（SW4）、7 セグメント LED が 3 つ（LED1、LED2、LED3）、シリアルポートが 1 つ実装

されており、それぞれ CON2 から SUZAKU と接続するようになっています。安定した＋3.3V を得るため AC アダ

プタ 5V から 3 端子レギュレータで＋3.3V を作っています。この＋3.3V は CON2、CON３から SUZAKU 側へ供

給されます。 
 

 
図 2-1 LED/SW 回路図（縮小版） 

 
 
 
 

LED×4 

押しボタンスイッチ 
×3 

ロータリコードスイッチ 
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シリアルポート 

3 端子レギュレータ 

SUZAKU 

CON2 の 
ピンアサイン 
については 
次ページに記載 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                              LED/SW ボードについて 
 

20

 
2.2. ピンアサイン 

LED/SW ボードを使用する際に必要となるピンアサインを以下に示します。 
その他の SUZAKU＋LED/SW ボードのピンアサインについては"13 SUZAKU＋LED/SW ボードのピンアサ

イン"をご参照ください。 

表 2-1 クロック、リセット信号 ピンアサイン 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 
SZ130 SZ310 SZ410 

 SYS_CLK I クロック信号 T9 U10 C8 Y6 
 SYS_RST I リセット信号 F5 D3 A8 U3 

 
表 2-2 機能用ピンアサイン(CON2) 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 
SZ130 
 

SZ310 
 

SZ410 
 

8 UART3 I RTS A7  N4 E14 D15 
9 UART2 O TXD A3 M6 E13 E15 

10 UART1 O CTS D5 M5 F12 F15 
11 UART0 I RXD B4 M3 F13 P4 
13 SEG7 O セグメント DP C5 L5 F15 P1 
14 SEG6 O セグメント G B5 L6 F16 P2 
15 SEG5 O セグメント F E6 L4 G13 L2 
16 SEG4 O セグメント E D6 L3 G14 M2 
17 SEG3 O セグメント D C6 L2 G15 N2 
18 SEG2 O セグメント C B6 L1 G16 N3 
20 SEG1 O セグメント B A8 C9 N9 Y7 
22 SEG0 O セグメント A B8 D9 P9 W7 
24 nSEL2 O 7 セグメント LED3 選択 D7 K6 H13 N5 
25 nSEL1 O 7 セグメント LED2 選択 C7 K4 H14 M3 
26 nSEL0 O 7 セグメント LED１選択 B7 K3 H15 M4 
28 nCODE3 I ロータリコードスイッチ 23 C8 J1 J16 H5 
29 nCODE2 I ロータリコードスイッチ 22 A9 F9 J15 E2 
30 nCODE1 I ロータリコードスイッチ 21 A12 E9 J14 D2 
31 nCODE0 I ロータリコードスイッチ 20 C10 A10 J13 U9 
33 nSW2 I 押しボタンスイッチ SW3 A14 D11 K16 L1 
34 nSW1 I 押しボタンスイッチ SW2 B14 C11 K15 M1 
35 nSW0 I 押しボタンスイッチ SW1 A13 F11 K14 G4 
37 nLE0 O 単色 LED(緑) D１  B12 E12 L16 G2 
38 nLE1 O 単色 LED(緑) D2 C12 F12 L15 F2 
39 nLE2 O 単色 LED(緑) D3 D11 B11 L14 F1 
40 nLE3 O 単色 LED(緑) D4 E11 A11 L13 E1 
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3. SUZAKU＋LED/SW ボードの構成 
 

 
 

SUZAKU+LED/SW ボードのコネクタの配置やジャンパの設定等について説明します。これらは実際に作業す

るために必要不可欠な情報です。誤挿入や誤配線等間違った使い方をすると、SUZAKU や LED/SW ボードが壊

れてしまう可能性があります。しっかりとご確認ください。 
 
3.1. 各種インターフェースの配置 

SUZAKU には FPGA やメモリ、Ethernet コントローラ等が実装され、Linux が動作します。LED/SW ボードに

は LED やスイッチ、RS-232C トランシーバが実装されています。電源は LED/SW ボード側から供給します。

（SUZAKU 側の電源コネクタは使用しません。）各種インターフェースの配置は下図のようになっています。 
 

 

 

 
図 3-1 各種インターフェースの配置 
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表 3-1 SUZAKU のコネクタ配置 

    部品番号 説明 
1 CON1 RS-232C コネクタ 
2 CON2 外部 I/O、フラッシュメモリ用コネクタ（LED/SW CON2 と接続） 
3 CON3 外部 I/O コネクタ（LED/SW CON3 と接続） 
4 CON4 外部 I/O コネクタ 
5 CON5 外部 I/O コネクタ 
6 CON6 電源入力＋3.3V（LED/SW 接続時は絶対に使用しないでください） 
7 CON7 FPGA JTAG 用コネクタ 
8 D1 ユーザーコントロール LED（赤） 
9 D3 パワーON LED（緑） 
10 JP1 起動モードジャンパ 
11 JP2 FPGA プログラム用ジャンパ 

SU
ZA

K
U

 

12 L2 Ethernet 10BASE-T/100BASE-TX コネクタ 

表 3-2 LED/SW のコネクタ配置 

    部品番号 説明 
13 CON1 テスト拡張用コネクタ（CON3 と同じピンアサインで配線接続されています） 
14 CON2 SUZAKU 接続コネクタ（SUZAKU CON2 と接続） 
15 CON3 SUZAKU 接続コネクタ（SUZAKU CON3 と接続） 
16 CON4 テスト拡張用コネクタ（CON2 と同じピンアサインで配線接続されています） 
17 CON6 ＋5V 入力コネクタ 
18 CON7 RS-232C コネクタ 
19 LED1～3 7 セグメント LED “High”レベルで点灯 
20 D1～4 単色 LED(緑） “Low”レベルで点灯 
21 SW1～3 押しボタンスイッチ 押下で”Low”レベル 

LE
D

/S
W

 

22 SW4 ロータリコードスイッチ 選択時”Low”レベル 
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4. 電源を入れる前に 
 

 
 
SUZAKU スターターキットに電源を入れる前に、開発をするために必要なものやインストールする必要のあるソフ

トウェア、開発環境についての説明をします。 
 
4.1. 必要なもの 

SUZAKU スターターキットの場合は、以下のものが収められています。ご確認ください。 
それ以外の場合は以下のものが必要となります。足りないものをそろえて下さい。 

 
① SUZAKU※ 
② LED/SW ボード※2 
③ CD-ROM 
④ AC アダプタ 5V 
⑤ D-sub9 ピン-10 ピン変換ケーブル 
⑥ D-sub9 ピンクロスケーブル 
⑦ スペーサ×4 
⑧ ネジ×4 
⑨ ジャンパプラグ×2 

 

 
図 4-1 SUZAKU スターターキット(SZ130) 

                                                  
※本書対応の SUZAKU は SUZAKU-S（SZ010、SZ030、SZ130）、SUZAKU-V（SZ310、SZ410）です。 
 
※2 SZ410 をお使いの場合は、SZ410 対応品の LED/SW ボード(SIL00-U01)をお使いください。 

① 

② 

③

④

⑤

⑥ 

⑦
⑧

⑨
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4.2. 開発環境 

SUZAKU スターターキットの開発環境として必要なソフトウェアおよびハードウェアは以下のとおりです。 
 

● 作業用 PC 
 Windows2000 または、WindowsXP が動作し、シリアルポート(1 ポート)、及びパラレルポート(1 ポート)を持

つ PC を準備してください。 
 
● Xilinx Parallel CableⅢ、Ⅳまたはそれ相当品※ 

 Parallel CableⅢ、Ⅳまたはそれ相当のものを準備してください。 
 
● シリアル通信用ソフト 

 Tera Term(Pro)等のシリアル通信用ソフトをインストールしてください。Tera Term(Pro)はフリーソフトウェアの

ターミナルエミュレータで、シリアル通信等を行うことができます。Tera Term(Pro)には UTF-8 に対応している

バージョンもあります。 
 
● Xilinx ISE※ 

 Xilinx の ISE8.1i,8.2i または 9.1i（Foundation（有償版）、WebPACK（無償版）どちらでも可）を準備し、イ

ンストールしてください。無償版の ISE WebPACK は、Xilinx のホームページ（http://www.xilinx.co.jp/）から

ダウンロードできます。どちらでも本書内の開発は可能です。お好きな方をインストールしてください。インストー

ル後ソフトウェアアップデートをしてください。本書は ISE8.1i を元にかかれています。 
 
● Xilinx EDK※ 

 Xilinx EDK8.1i,8.2i または 9.1i(Embedded Development Kit)を準備し、インストールしてください。インス

トール後ソフトウェアアップデートをしてください。本書は EDK8.1i を元にかかれています。 
 
● LBPlayer2 

 LBPlayer2 をインストールしてください。SZ010、SZ030、SZ310 のフラッシュメモリに書き込む際に使用しま

す。付属 CD-ROM の"¥suzku¥tools¥LBPlay2_Release108.zip¥Lbplayer2.lzh"に収録されています。ま

た、東京エレクトロンデバイスのホームページ(http://www.teldevice.co.jp/)から最新版をダウンロードすること

が出来ます。インストール方法については解凍したフォルダ内の readme.txt 等をご参照ください。 
 
● SPI Writer  

 SPI Writer をインストールしてください。SZ130、SZ410 のフラッシュメモリに書き込む際に使用します。 
付属 CD-ROM の"¥suzaku¥tools¥spi_writer-yyyymmdd.zip"に収録されています。また、SUZAKU 公

式サイトのダウンロードページ(http://suzaku.atmark-techno.com/downloads/all)から最新版をダウンロード

することが出来ます。インストール方法については解凍したフォルダ内の spi_writer_manual_ja-x.x.x.pdf を

ご参照ください。 
 
● ダウンローダ Hermit 

 ダウンローダ Hermit をインストールしてください。 
付属 CD-ROM の"¥suzaku¥bootloader¥hermit-at-win-x.x.x.zip"に収録されています。また、SUZAKU
公式サイトのダウンロードページ(http://suzaku.atmark-techno.com/downloads/all)から最新版をダウンロー

ドすることが出来ます。 
 
 

                                                  
※ Xilinx 製品の詳細については、Xilinx のホームページ（http://www.xilinx.co.jp/）をご覧になられるか、

Xilinx 代理店にお問い合わせください。 
 

SZ010 SZ030 SZ310

SZ130
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4.3. 付属 CD-ROM について 

付属 CD-ROM には、開発に必要となる FPGA プロジェクト、ソフトウェア、開発環境、イメージファイル、各種マニ

ュアルが収められています。これらは不具合解決や機能増強等のアップグレードを行うことがあります。下記サイトに

最新版がございますのでダウンロードしてお使いください。 
 
開発に関するファイル  http://suzaku.atmark-techno.com/downloads/all  
各種マニュアル   http://suzaku.atmark-techno.com/downloads/docs  
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4.4. 組み立て 

LED/SW ボードに SUZAKU を接続します。（SUZAKU スターターキットの場合は出荷時に接続されています）

接続する際、方向、位置に十分ご注意ください。間違った方向、位置に接続して電源を投入した場合、電源がショー

トして壊れる可能性があります。SUZAKU スターターキットでは CON2 の 19 番ピンに逆挿し防止対策が施されて

います。 

Xi
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3E

 
図 4-2 SUZAKU と LED/SW ボード接続 

もし、CON2、CON3 にコネクタが接続されていない場合、取り付け面と位置に注意し、コネクタを半田付けしてく

ださい。コネクタは 40 ピン～44 ピンのものをご用意ください。CON2 の 41～44 ピン、CON3 の 41～44 ピンにはコ

ネクタを接続しなくても動作いたしますので、コネクタが４４ピンに足りない場合は、１ピン側によせて半田付けしてくだ

さい。 
半田付けする際は、マスキングをし、周囲の部品に半田くず、半田ボール等付着しない様十分にご注意ください。 

 

43

44

44

43

 
図 4-3 コネクタの半田付け 
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足を取り付けます。４ヶ所にスペーサを取り付け、ネジ締めしてください。 
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図 4-4 スペーサ取り付け 

 
 

注意 
 SZ410 をお使いの場合、SZ410 対応品シールが貼ってある LED/SW ボードをお使いください。 
SZ410 は他の SUZAKU に比べ消費電流が多いため SZ410 対応品でない LED/SW ボードでは

正常動作しないことがあります。 
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5. SUZAKU＋LED/SW ボードを動かす 
 

 
 

電源を入れて出荷状態の SUZAKU スターターキット(SUZAKU＋LED/SW ボード)を動かします。出荷状態で

は、フラッシュメモリに Linux が OS として入り、FPGA に今回最終目標とするスロットマシンが入っています。

SUZAKU がどのような動きをするのか実際に体験してください。 
SUZAKU はジャンパによりブートローダモード、オートブートモード、FPGA コンフィギュレーション待ちの 3 つの

状態に設定できます。JP1 は起動モードジャンパ、JP2 は FPGA プログラム用ジャンパです。 
ここではブートローダモードとオートブートモードで SUZAKU スターターキットを動かします。 
 

表 5-1 ジャンパの設定と起動時の動作 

JP1 JP2 起動時の動作 起動モード 
ショート オープン ファーストブートローダ BBoot を起動 ブートローダモード 

オープン オープン Linux カーネルを起動 オートブートモード 
－ ショート 何も起動しません FPGA コンフィギュレーション待ち 

 
 

フラッシュメモリの中身が SUZAKU スターターキット出荷状態以外の場合、image リージョンおよび fpga リージョ

ン を 書 き 換 え る 必 要 が あ り ま す 。 Linux の イ メ ー ジ フ ァ イ ル は 付 属 CD-ROM の "¥suzaku-starter-
kit¥image¥image-sz***-sil.bin"に収録されています。FPGA ファイルは付属 CD-ROM の"¥suzaku-starter-
kit¥fpga¥x.x¥sz***¥sz***-add_slot-yyyymmdd.zip"の default_bit_file フォルダの中に収録されています。

また、SUZAKU 公式サイトよりダウンロードすることも出来ます。書き換える方法については、"6 SUZAKU を書き

換える"をご参照ください。 
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5.1. 接続方法 

D-Sub9 ピン-10 ピン変換ケーブルを SUZAKU CON1 に、LAN ケーブルを SUZAKU L2 に接続してください。 
SUZAKU CON1 に D-Sub9 ピン-10 ピン変換ケーブルを接続する際にはコネクタの白い三角マークと

SUZAKU 基板上の白い三角マークを合わせるように接続します。コネクタの向きを反対に接続すると、機器を破損

する恐れがありますので十分にご注意ください。 
 

 
 

図 5-1 SUZAKU＋LED/SW ボード配線 
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5.2. シリアル通信ソフトウェア 

SUZAKU はシリアルポートをコンソールとして使用します。SUZAKU のコンソールから出力される情報を読み取

ったり、SUZAKU のコンソールに情報を送ったりするには、シリアル通信ソフトウェアが必要です。ここでは Tera 
Term を使用した例を示します。 

シリアル通信ソフトウェアを立ち上げ、シリアル通信の設定を行ってください。 
 

・ Baud rate 115200 
・ Data 8bit 
・ Parity none 
・ Stop 1bit 
・ Flow control none 

 
 

 
図 5-2 シリアルポート(Tera Term)の設定 
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5.3. ブートローダモードでスロットマシンを動かす 

まず、ブートローダモードでスロットマシンを動かします。 
JP１にジャンパプラグをさしてショートさせてください。 

CONFIGUART7SEGR-SWLED SW

-
 
 
 
+

 
図 5-3 ブートローダモード ジャンパの設定 

 
5.3.1. 電源について 

LED/SW CON6 から AC アダプタ 5V で電源を供給します。 
SUZAKU CON6 からは絶対に電源を供給しないでください。電源がショートし、機器を破損する可能性がありま

す。また、改造等により電源を外部から供給等行わないでください。SUZAKU と LED/SW ボードは、電源シーケン

スの関係から、お互いに電源を供給し合うような形になっているので、機器を破損する可能性があります。 
 

SUZAKU

LED/SWボード

+5V

+3.3V
To Device

+3.3Vin +3.3V

LDO
+3.3V

 
図 5-4 電源系統 

JP1 ショート 
JP2 オープン 
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CONFIGUART7SEGR-SWLED SW

絶対に入力しない

電源入力はここから

電源の改造禁止

 
図 5-5 電源ケーブル接続の諸注意 

 
5.3.2. スロットマシン起動 

電源が供給されるとシリアル通信用ソフトウェアの画面に以下のメッセージが表示され、スロットマシンを動かすこと

ができるようになります。 
 

 
図 5-6 スロットマシンの起動 
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図 5-7 スロットマシンを動かしてみよう 

 
5.4. オートブートモードで Linux を動かす 

次にオートブートモードで Linux を動かします。 
JP1、JP2 がオープンになっていることを確認してください。 

CONFIGUART7SEGR-SWLED SW

-
 
 
 
+

 
図 5-8 オートブートモード ジャンパの設定 

JP1、JP2 
オープン 
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5.4.1. Linux の起動 

シリアル通信用ソフトウェアが起動されていることを確認してから AC アダプタ 5V を接続し、電源を供給してくださ

い。シリアル通信用ソフトウェアの画面に Linux の起動ログが表示されます。 

例 5-1 SUZAKU の起動ログ(SZ130 の場合) 

Linux version 2.4.32-uc0 (atmark@atde) (gcc version 3.4.1 ( Xilinx EDK 8.1 Build EDK_I.17 
090206 )) #2 2007年 2月 28日 水曜日 16:31:36 JST 
On node 0 totalpages: 8192 
zone(0): 8192 pages. 
zone(1): 0 pages. 
zone(2): 0 pages. 
CPU: MICROBLAZE 
Kernel command line: 
Console: xmbserial on UARTLite 
Calibrating delay loop... 25.39 BogoMIPS 
Memory: 32MB = 32MB total 
Memory: 29432KB available (988K code, 1984K data, 44K init) 
Dentry cache hash table entries: 4096 (order: 3, 32768 bytes) 
Inode cache hash table entries: 2048 (order: 2, 16384 bytes) 
Mount cache hash table entries: 512 (order: 0, 4096 bytes) 
Buffer cache hash table entries: 1024 (order: 0, 4096 bytes) 
Page-cache hash table entries: 8192 (order: 3, 32768 bytes) 
POSIX conformance testing by UNIFIX 
Linux NET4.0 for Linux 2.4 
Based upon Swansea University Computer Society NET3.039 
Initializing RT netlink socket 
Microblaze UARTlite serial driver version 1.00 
ttyS0 at 0xffff2000 (irq = 1) is a Microblaze UARTlite 
Starting kswapd 
xgpio #0 at 0xFFFFA000 mapped to 0xFFFFA000 
Xilinx GPIO registered 
sil7segc (1.0.1): 7seg-LED Driver of SUZAKU I/O Board -LED/SW- for CGI demo. 
RAMDISK driver initialized: 16 RAM disks of 4096K size 1024 blocksize 
eth0: LAN9115 (rev 1150001) at ffe00000 IRQ 2 
Suzaku MTD mappings: 
  Flash 0x800000 at 0xff000000 
flash: Found an alies 0x800000 for the chip at 0x0, ST M25P64 device detect. 
Creating 7 MTD partitions on "flash": 
0x00000000-0x00800000 : "Flash/All" 
0x00000000-0x00100000 : "Flash/FPGA" 
0x00100000-0x00120000 : "Flash/Bootloader" 
0x007f0000-0x00800000 : "Flash/Config" 
0x00120000-0x007f0000 : "Flash/Image" 
0x00120000-0x00420000 : "Flash/Kernel" 
0x00420000-0x007f0000 : "Flash/User" 
FLASH partition type: spi 
uclinux[mtd]: RAM probe address=0x8012da4c size=0x1ba000 
uclinux[mtd]: root filesystem index=7 
NET4: Linux TCP/IP 1.0 for NET4.0 
IP Protocols: ICMP, UDP, TCP 
IP: routing cache hash table of 512 buckets, 4Kbytes 
TCP: Hash tables configured (established 2048 bind 4096) 
VFS: Mounted root (romfs filesystem) readonly. 
Freeing init memory: 44K 
Mounting proc: 
Mounting var: 
Populating /var: 
Running local start scripts. 
Mounting /etc/config: 
Populating /etc/config: 
flatfsd: Created 4 configuration files (149 bytes) 
Setting hostname: 
Setting up interface lo: 
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Starting DHCP client: 
Starting inetd: 
Starting thttpd: 
 
SUZAKU-S.SZ130-SIL login: 
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5.4.2. ログイン 

表示されている SUZAKU のログインプロンプトから root ユーザでログインします。パスワードの初期設定は

"root"です。 

表 5-2 SUZAKU 初期設定時のユーザとパスワード 

ユーザ名 パスワード 権限 
ｒoot root 特権ユーザ 

 
5.4.3. ネットワークの設定 

出荷状態の SUZAKU は DHCP で IP を取得するように設定されています。お使いの環境に DHCP サーバが

ない場合は固定 IP を割り当てる必要があります。以下のコマンドを入力し、固定 IP を割り当ててください。以下の

例の 192.168.11.234 の部分には適当な IP アドレスを入力してください。固定 IP を割り当てる時は SUZAKU 上

の特権ユーザで実行してください。 

例 5-2 固定 IP アドレスの割り当て 

# ifconfig eth0 down 
# ifconfig eth0 192.168.11.234 

 
ネットワークの設定は以下のコマンドで表示されます。 

例 5-3 ネットワークの設定の表示 

#ifconfig eth0 
eth0      Link encap:Ethernet  HWaddr 00:11:0C:12:34:56 
          inet addr:192.168.11.234  Bcast:192.168.10.255  Mask:255.255.255.0 
          UP BROADCAST NOTRAILERS RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:114 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:16 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:1000 
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5.4.4. ウェブ 

出荷状態の SUZAKU では、thttpd という小さな HTTP サーバが起動しています。先ほど確認した IP アドレス

（例では 192.168.11.234）にお使いのウェブブラウザでアクセスすることで、動作確認ができます。"http://IP アドレ

ス"にアクセスしてください。 
 

 
図 5-9 SUZAKU Web Page
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さらに 7 セグメント LED を制御できる CGI が入っています。”http://IP アドレス/7seg-led-control.cgi”にアクセス

してください。 
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図 5-10 CGI を動かしてみる 

 
5.4.5. 終了方法 

SUZAKU スターターキットには電源ボタンがありません。終了するには、電源を切断する必要があります。AC ア

ダプタをコンセントから抜いて終了してください。 

1~F(16 進数)の数字を

設定して[OK]をクリック

すると、７セグメント LED
に設定した数字が表示さ

れる。 
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5.5. SUZAKU のブートシーケンス 

SUZAKU スターターキットを動かしてみましたがいかがだったでしょうか。SUZAKU のブートシーケンスについて

説明をします。 
 

① SUZAKU に 電 源 を 投 入 す る と 、 ま ず

FPGA にフラッシュメモリの中の FPGA リ

ージョン(BRAM 内 BBoot を含む)をコンフ

ィギュレーションします。(フラッシュメモリのリ

ージョンについては"6 SUZAKU を書き換

える"で説明をします。) 
 
② プログラムをスタートさせるリセットベクタのア

ドレス (MicroBlaze：0x00000000 番地、

PowerPC ： 0xFFFFFFFC 番 地 ) に

SUZAKU では FPGA の BRAM を割り当

てているので、コンフィギュレーション終了

後、FPGA の BRAM 内の BBoot が動作

します。 
 
③ BBoot はフラッシュメモリの中のブートロー

ダリージョン(Hermit)を SDRAM にコピー

します。コピー終了後ブートローダ Hermit
の先頭アドレスにジャンプするようになって

おり、Hermit が起動します。 
 
④ Hermit はフラッシュメモリの中のイメージリ

ージョン(Linux)を SDRAM にコピーします。

コピー終了後 Linux の先頭アドレスにジャ

ンプするようになっており、Linux が起動し

ま す 。 Linux が 起 動 後 は Linux が

SDRAM の全領域を使用し、Hermit は必

要ないので上書きしてしまいます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                          図 5-11 2 段階ブート 
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SUZAKU スターターキットの BBoot は以下のようなフローで動作します。先ほどの動きを思い出して確認してみ

てください。 
 

起動モードジャンパ
オープン？

セカンドブートローダ
Hermit起動

LED D3(赤)点灯

電源投入

モトローラS形式
ダウンロードモード

起動モード選択画面
表示

LED D3(赤)消灯

キー入力待ち

スロットマシンの
割り込み許可

割り込み禁止

スロットマシン
ビジーループ実行

割り込み禁止

Yes

‘S’

No

‘T’

割り込み禁止

スロットマシン
割り込み実行

 
図 5-12 スターターキットの BBoot のフロー 

 

 
 
TIPS  2 段階ブート 

SUZAKU のブートローダには以下の 2 つがあり、2 段階でブートします。 
• ファーストブートローダ BBoot 
  (FPGA の BRAM 内) 
• セカンドブートローダ Hermit 

2 段階のブートを使用しないことも可能ですが、SUZAKU ではあえて 2 段階でブートをしています。これには何らか

の原因でフラッシュメモリの内容が書き換えられても、最低限のブートローダまでは動作させておきたかったという事と、

ブートローダにより使用される BRAM のメモリ容量を最低限に抑えたかったという事の 2 つの理由があります。何ら

かの原因でフラッシュメモリの内容が書き換えられても、FPGA であれば JTAG からコンフィギュレーションデータを

プログラムできるので、BBoot を復旧させることができ、フラッシュメモリの書き直しをおこなうことが出来ます。また、ブ

ートローダは圧縮されたプログラムイメージを展開させたりするので、多くのメモリが必要となります。FPGA の

BRAM は貴重なリソースなので、起動時にしか実行されないブートローダのために多くの容量を消費することを避け、

セカンドブートローダ Hermit にこれらの機能を持たせることにしました。 
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6. SUZAKU を書き換える 
 

 
 

SUZAKU で開発するためには SUZAKU を書き換える作業が必須となります。ここでは SUZAKU の書き換え

かたを説明します。SUZAKU を書き換える = フラッシュメモリを書き換えることになります。フラッシュメモリには

SUZAKU の基礎となる様々なデータが書き込まれています。 
フラッシュメモリは大きく、FPGA リージョン、ブートローダリージョン、イメージリージョン、コンフィグリージョンという

領域に分割し、データを書き込んでいます。 
 
• FPGA リージョン   ： SUZAKU の FPGA コンフィギュレーションデータが書き込まれています。 
• ブートローダリージョン ： ブートローダ Hermit のデータが書き込まれています。 
• イメージリージョン  ： Linux のカーネルやユーザランドが書き込まれています。 
• コンフィグリージョン  ： ネットワークの設定やパスワードが書き込まれています。 
 

これらの領域はそれぞれ個別に書き換えることが出来ます。 
 

通常 FPGA のコンフィギュレーションデータは FPGA メーカから出されているシリアル ROM に記憶し、FPGA
に書き込みますが、SUZAKU は TE7720（"6.2.2 LBPlayer2 で書き換える"参照）や、Spartan3E の機能やＣＰＬ

Ｄを使って市販のフラッシュメモリの FPGA リージョンに記憶して書き込んでいます。これとは別に、一時的に JTAG
から FPGA にコンフィギュレーションデータを書き込む方法もあります。この場合、電源を落とすとコンフィギュレーシ

ョンデータは消えてしまうのですが、フラッシュメモリを書き換えるよりも速いので、デバッグ時には大変有効です。 
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6.1. フラッシュメモリマップ 

フラッシュメモリのリージョンの区分は、製品毎に異なります。 
 

6.1.1. SZ130 
SZ130 のフラッシュメモリマップは以下のとおりです。 

表 6-1 フラッシュメモリマップ（SZ130 Flash:8MB） 

アドレス リージョン サイズ 説明 
0x00000000 

 
0x000FFFFF 

FPGA 1MB  

0x00100000 
 

0x0011FFFF 
ブートローダ 128KB ブートローダ Hermit 

0x00120000 
 

0x007EFFFF 
イメージ 約 6.81MB Linux カーネル・ユーザーランド 

0x007F0000 
 

0x007FFFFF 
コンフィグ 64KB コンフィグ 

 
6.1.2. SZ010 

SZ010 のフラッシュメモリマップは以下のとおりです。 

表 6-2 フラッシュメモリマップ（SZ010 : 4MB） 

アドレス リージョン サイズ 説明 
0x00000000 

 
0x0007FFFF 

FPGA 512KB  

0x00080000 
 

0x0009FFFF 
ブートローダ 128KB ブートローダ Hermit 

0x000A0000 
 

0x003EFFFF  
イメージ 約 3.31MB Linux カーネル・ユーザーランド 

0x003F0000 
 

0x003FFFFF 
コンフィグ 64KB コンフィグ 
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6.1.3. SZ030, SZ310 

SZ030、SZ310 のフラッシュメモリマップは以下のとおりです。 

表 6-3 フラッシュメモリマップ（SZ030, SZ310 : 8MB） 

アドレス リージョン サイズ 説明 
0x00000000 

 
0x0000FFFF 

フリー1 64KB  

0x00010000 
 

0x0007FFFF 
フリー2 448KB  

0x00080000 
 

0x000FFFFF 
FPGA 512KB  

0x00100000 
 

0x0011FFFF 
ブートローダ 128KB ブートローダ Hermit 

0x00120000 
 

0x007EFFFF 
イメージ 約 6.81MB Linux カーネル・ユーザーランド 

0x007F0000 
 

0x007FFFFF 
コンフィグ 64KB コンフィグ 

 
 
6.1.4. SZ410 

SZ410 のフラッシュメモリマップは以下のとおりです。 

表 6-4 フラッシュメモリマップ（SZ410 : 8MB） 

アドレス リージョン サイズ 説明 
0x00000000 

 
0x000FFFFF 

FPGA 1MB  

0x00100000 
 

0x0011FFFF 
ブートローダ 128KB ブートローダ Hermit 

0x00120000 
 

0x007EFFFF 
イメージ 約 6.81MB Linux カーネル・ユーザーランド 

0x007F0000 
 

0x007FFFFF 
コンフィグ 64KB コンフィグ 
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以下に SUZAKU のそれぞれのリージョンの書き換えかたと使用ファイル、書き換えるときのフラッシュメモリの状

態を示します。 
 

表 6-5 SUZAKU の書き換えかた※ 

  書き込み方法 使用ファイル フラッシュメモリの状態 
FPGA iMPACT bit ファイル 何も書き込まれていなくて良い 

LBPlayer2 mcs ファイル 何も書き込まれていなくて良い 
SPI Writer bit ファイル 何も書き込まれていなくて良い 
ダウンローダ Hermit bin ファイル FPGA、ブートローダリージョンに正常に書き込まれている 

FPGA 
リージョン 

NetFlash bin ファイル FPGA、ブートローダ、イメージリージョンに正常に書き込まれている 
ダウンローダ Hermit bin ファイル FPGA、ブートローダリージョンに正常に書き込まれている ブートローダ 

リージョン BBoot モトローラ S 形式 srec ファイル FPGA リージョンに正常に書き込まれている 
ダウンローダ Hermit bin ファイル FPGA、ブートローダリージョンに正常に書き込まれている イメージ 

リージョン NetFlash bin ファイル FPGA、ブートローダ、イメージリージョンに正常に書き込まれている 
ダウンローダ Hermit bin ファイル FPGA、ブートローダリージョンに正常に書き込まれている 

フラッシュ 
メモリ 

コンフィグ 
リージョン NetFlash bin ファイル FPGA、ブートローダ、イメージリージョンに正常に書き込まれている 

 
 
 

                                                  
※ 灰色になっているところは本書では説明しません。SUZAKU Software Manual をご参照ください。 
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6.2. FPGA の書き換えかた 

SUZAKU の FPGA にコンフィギュレーションデータを書き込むには、iMPACT を使って JTAG で FPGA に直

接書き込む方法、LBPlayer２もしくは SPI Writer を使ってフラッシュメモリの FPGA リージョンに記憶させて書き込

む方法、ダウンローダ Hermit でフラッシュメモリの FPGA リージョンに記憶させて書き込む方法、NetFlash でフラ

ッシュメモリの FPGA リージョンに記憶させて書き込む方法があります。ここでは iMPACT と LBPlayer2、SPI 
Writer での書き換えかたについて説明いたします。ダウンローダ Hermit の使い方については"6.4.1 ダウンロー

ダ Hermit で書き換える"を参考にして下さい。NetFlash の使い方については SUZAKU Software Manual をご

参照ください。 
 
 
 

FPGA
SPI
Flash

JTAGで
書き込み

フラッシュメモリで
書き込み  

図 6-1 FPGA の書き込み 

 
6.2.1. iMPACT で書き換える 

iMPACT を使ってコンフィギュレーションデータを書き込む方法を説明します。iMPACT は ISE 付属のツールで

す。iMPACT で書き込むと、Xilinx の FPGA が SRAM ベースのためコンフィギュレーションは速いですが、電源

を切るたびにコンフィギュレーションし直さなければなりません。 
 
6.2.1.1. 書き込み準備 

まず、SUZAKU JP2 にジャンパプラグをさし、ショートさせてください。JP2 をショートさせると、電源投入時

FPGA に対し、フラッシュメモリからのコンフィギュレーションデータの書き込みを停止させることができます。 
SUZAKU CON７に JTAG のダウンロードケーブル（Xiｌinx Parallel CableⅢまたはⅣ）を接続し、LED/SW 

CON6 に AC アダプタ 5V を接続し、電源を投入してください。SUZAKU D3 のパワーON LED(緑)が点灯してい

るか確認してください。 
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X
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S
pa
r
t
a
n
3
E

LED/SW CON6に
ACアダプタ5V

パワーON LED(緑）

SUZAKU CON7

JP2をショート

Xilinx
Parallel Cable
Ⅲ or Ⅳ

2. VCC 4. TDI 6. TMS

1. GND 3. TCK 5. TDO

 
図 6-2 iMPACT 書き込み準備 

6.2.1.2. iMPACT 立ち上げから書き込み 
iMPACT を起動してください。iMPACT は"¥ISE のインストールフォルダ¥bin¥nt¥_impact.exe" 
から起動できます。もしくは、[スタートメニュー]→[すべてのプログラム]→[Xilinx ISE x.xi]→[アクセサリ]→

[iMPACT]から起動できます。 
 

[create a new project (ipf)]にチェックを入れ、[OK]をクリックしてください。 
 

 
図 6-3 iMPACT 起動 
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[Configure devices using Boundary-Scan (JTAG)]にチェックを入れ、[Finish]をクリックしてください。 

 

 

図 6-4 iMPACT 設定画面 

 
接続ミスがなく、SUZAKU の電源が入っていれば FPGA デバイスが発見されます。発見されなかった場合は接

続を見直し、[File]→[New]をクリックし、[create a new project(ipf)]にチェックを入れてやり直してください。

(ISE9.1i の場合は Identify Succeeded は表示されません。) 
 

 

図 6-5 FPGA デバイス発見(SZ130 の場合) 
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書き込むデータを選択し、[Open]をクリックしてください。今回書き込むのは bit ファイルです。 
 
SUZAKU のデフォルトの bit ファイルは付属 CD-ROM の 
"¥suzaku¥fpga¥x.x¥sz***¥sz***-yyyymmdd.zip"を展開したフォルダの中の"default_bit_file"に収録され

ています。また、スロットマシンの bit ファイル（スターターキット出荷時の bit ファイル）は付属 CD-ROM の 
"¥suzaku-starter-kit¥fpga¥x.x¥sz***¥sz***-add_slot-yyyymmdd.zip"を展開したフォルダの中の

"default_bit_file"に収録されています。 
 

 
図 6-6 bit ファイル選択 

 
 

この時、Warning がでることがありますが[OK]をクリックして下さい。SZ310、SZ410 の場合はこの前に Add 
Virtex-・・・というウィンドウが立ち上がりますが、何も変更せず[OK]をクリックして下さい。 
 

 
図 6-7 WARNING:iMPACT:2257 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                                SUZAKU を書き換える 
 

49

 
デバイスをクリックし、緑色になったことを確認し、Program をダブルクリックしてください。 

 

 
図 6-8 デバイス選択 

 
Verify のチェックボタンをはずし、[OK]をクリックしてください。書き込みが始まります。 

 

 

図 6-9 Program 設定 

Program をダブルクリック 

チェックをはずす 

クリックすると緑色になる 
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Program Succeeded と表示されれば、書き込み成功です。接続状態によっては書き込みに失敗することもありま

すので、失敗した場合は接続状態を確認し、再度書き込んでください。 
 

 
図 6-10 コンフィギュレーションデータ書き込み成功 

 
 

6.2.1.3. iMPACT で書き換える 手順まとめ 

１． SUZAKU JP2 にジャンパプラグをさしてショートさせる 
２． SUZAKU CON7 に JTAG ダウンロードケーブルを接続する 
３． LED/SW CON6 に AC アダプタ 5V を接続し、電源投入 
４． SUZAKU D3 のパワーON LED(緑)が点灯していることを確認 
５． iMPACT を立ち上げ、コンフィギュレーションデータ書き込み 
６． 動作確認 
※電源を切ると、書き込んだ内容は失われます。 
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SZ010 SZ030 SZ310
 
6.2.2. LBPlayer2 で書き換える  

LBPlayer2 を使って書き換える方法を説明します。SZ010、SZ030、SZ310 は FPGA にコンフィギュレーション

データを書き込むデバイスとして TE7720(メーカ：東京エレクトロンデバイス)を実装しています。TE7720 は、JTAG
から送られてくるデータをフラッシュメモリに記憶させ、再起動時にそのデータを読み込み、FPGA に書き込む IC で

す。TE7720 については東京エレクトロンデバイスのホームページから詳細資料をダウンロードできます。 

 
図 6-11 TE7720 の書き込み 
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6.2.2.1. 書き込み準備 

SUZAKU JP2 にジャンパプラグをさし、ショートさせてください。JP2 をショートさせると、電源投入時 FPGA に対

し、フラッシュメモリからの書き込みを停止させることができます。停止させないと書き込み不良等を起こしてしまいま

す。 
LED/SW CON4 に JTAG のダウンロードケーブル（Xilinx Parallel CableⅢまたはⅣ）を接続し、LED/SW 

CON6 に AC アダプタ５V を接続し、電源を投入してください。SUZAKU D3 のパワーON LED(緑)が点灯してい

るか確認してください。 

Xi
l
in
x

Sp
a
rt
a
n3
E

Xilinx
Parallel Cable
Ⅲ or Ⅳ

 
図 6-12 LBplayer2 書き込み準備 

6.2.2.2. bit ファイルから mcs ファイルを作る 
LBplayer2 で書き込めるファイルは mcs ファイルです。mcs ファイルは iMPACT で bit ファイルから変換して作

成することが出来ます。 
 

SUZAKU のデフォルトの mcs ファイルは付属 CD-ROM の 
"¥suzaku¥fpga¥x.x¥sz***¥sz***- yyyymmdd.zip"を展開したフォルダの中の"default_bit_file"に収録されて

います。また、スロットマシンの mcs ファイル（スターターキット出荷時の mcs ファイル） 
は付属 CD-ROM の"¥suzaku-starter-kit¥fpga¥x.x¥sz***¥sz***-add_slot-yyyymmdd.zip"を展開したフォ

ルダの中の"default_bit_file"に収録されています。 
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iMPACT を起動してください。iMPACT は"¥ISE のインストールフォルダ¥bin¥nt¥_impact.exe"から起動でき

ます。もしくは、[スタートメニュー]→[すべてのプログラム]→[Xilinx ISE x.xi]→[アクセサリ]→[iMPACT]から起動

できます。 
 
[create a new project (ipf)]にチェックを入れ、[OK]をクリックしてください。 

 

 
図 6-13 TE7720 iMPACT 起動 

 
 
[Prepare a PROM File]を選択し、[Next]をクリックして下さい。 

 

 
図 6-14 TE7720 iMPACT 立ち上げ 

 
 
 
 
 
 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                                SUZAKU を書き換える 
 

54

 
[Xilinx PROM]、[MCS]をチェックし、[PROM File Name]に作成する mcs ファイルの名前を入力し、

[Location]に mcs ファイルの保存先を設定し、[Next]をクリックして下さい。ここではファイルの名前を top とします。 
 

 
図 6-15 TE7720 iMPACT 設定 

 
 
[Select a PROM]で[xc18v]→[xc18v04]を選択し、[Add]をクリックして下さい。 

 

 
図 6-16 PROM の選択 

 
 
 
 
 

top と入力 

保存先を入力 
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確認画面が表示されます。間違いがなければ[Finish]をクリックして下さい。 

 

 
図 6-17 TE7720 確認画面  

 
 

次の画面が表示されるので、[OK]をクリックして下さい。 
 

 
図 6-18 TE7720 デバイスファイル追加 
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mcs に変換する bit ファイルを選択し、[開く]をクリックして下さい。 

 

 
図 6-19 TE7720 bit ファイルを開く 

 
他のデバイスを追加するか聞かれるので、[No]をクリックして下さい。 

 

 
図 6-20 TE7720 デバイスファイルさらに追加 
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次の画面が表示されるので[OK]をクリックして下さい。 

 

 
図 6-21 TE7720 準備完了 

 
[Generate File...]をダブルクリックして下さい。PROM File Generation Succeeded と表示されたら、mcs ファイ

ル作成完了です。 

 
図 6-22 mcs ファイル出来上がり 
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TIPS  iMPACT のバッチモード 

mcs ファイルを作成するのに毎回 GUI で同じ作業を繰り返すのは面倒だと思ったことはないでしょうか。そんな人

にはバッチファイルを作ることをお勧めします。以下に bit ファイルから mcs ファイルを作成する iMPACT のバッチ

ファイルの一例を示します。以下の内容をテキストエディタ等で編集し、任意の名前をつけて保存してください。ここ

では mcs.cmd とします。 
 
setMode -pff 
setSubmode -pffserial 
addPromDevice -p 1 -name xc18V04  
addDesign -version 0 -name 0  
addDeviceChain -index 0  
addDevice -p 1 -file top.bit  
generate -format mcs -fillvalue FF -output top  
quit 

 
作成した mcs.cmd と同じフォルダに bit ファイル(top.bit)を置き、コマンドプロンプトを立ち上げてそのフォルダに

移動し、以下のコマンドを実行して下さい。mcs ファイル(top.mcs)が出来上がります。iMPACT のバッチモードのコ

マンド詳細については iMPACT のヘルプをご参照ください。 
 
impact -batch mcs.cmd 
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6.2.2.3. LBPlayer2 立ち上げから書き込み 

LBPlayer2 のフォルダを開いてください。”device.def”と”lbplay2.exe”の 2 つのファイルがあることを確認して、

mcs ファイルを LBPlayer2 のフォルダの下にコピーしてください。 

 
図 6-23 mcs ファイルコピー 

 
コマンドプロンプトを開き、LBPlayer2 のフォルダに移動し、以下のコマンドを実行してください。ドライバのエラー

が出た場合の対処方法については後述の Tips をご参照ください。 
 
＞ lbplay2 -deb top.mcs 

 

 
図 6-24 LBPlay2 実行 

 
エラーが出なければ、書き込み完了です。書き込めたと思っても、エラーが出ていることがあるので、CheckSum

等をよく確認してください。 
何らかの原因でエラーが発生した場合は、SUZAKU を動作させず、再び書き込みを行ってください。 
LED/SW CON6 から AC アダプタ 5V を抜いて電源を切り、JP2 のジャンパプラグと LED/SW CON4 のダウン

ロードケーブルをはずしてください。再び LED/SW CON6 に AC アダプタ 5V を接続し、電源を再投入してくださ

い。 

確認

mcs ファイルを同じフォルダにおく 
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6.2.2.4. LBPlayer2 で書き換える 手順まとめ 
 

１．  SUZAKU JP2 にジャンパプラグをさしてショートさせる 
２．  LED/SW CON4 にダウンロードケーブルを接続する 
３．  LED/SW CON6 に AC アダプタ 5V を接続し、電源投入 
４．  SUZAKU D3 のパワーON LED(緑)が点灯していることを確認 
５．  iMPACT を立ち上げ、mcs ファイルを作成 
６．  コマンドプロンプトを立ち上げ、LBPlayer2 でコンフィギュレーションデータを書き込む 
７．  LED/SW CON6 の AC アダプタ 5V をはずし、電源を切る 
８．  LED/SW CON4 のダウンロードケーブルをはずす 
９．  SUZAKU JP2 のジャンパプラグをはずす 
１０． LED/SW CON6 に AC アダプタ 5V を接続し、電源再投入 
１１． 動作確認 
※電源を切っても、コンフィギュレーション内容は失われません。 

 
 
 
 

 
 
TIPS  書き込めたけど動かない？！ 

 
SZ310 のプロジェクトを ISE 8.1i で作っている場合、bit ファイルがうまく生成されません。コマンドプロンプト等を

立ち上げ、プロジェクトフォルダに移動し、以下のコマンドで新たに bit ファイルを生成してください。（ここではプロジ

ェクトフォルダを"sz310"、bit ファイルを"top.bit"、新しく生成する bit ファイルを"top_new.bit"としています） 
 

data2mem -bm sz310¥implementation¥xps_proj_bd.bmm 
 -bt top.bit  
 -bd sz310¥ppc405_i¥code¥executable.elf 
 tag bram -o b top_new.bit 
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TIPS  LBPlayer2 ERROR 

 
LBPlbay2 で書き込む際、 
 
ERROR: Please check %windir%¥system32¥drivers¥windrvr6.sys. 

 
というエラーが発生する場合があります。 

付属 CD-ROM の”¥suzku¥tools¥LBPlay2_Release108.zip”を展開してください。展開後のフォルダの中

に”Release205.zip”が入っているので、これをさらに展開してください。 
展開後のフォルダの中にある”windrvr6.inf”、”windrvr6.sys を同じ名前のファイルがないことを確認し、

Administrator 権限ユーザで以下のフォルダにコピーしてください。もし同じ名前のファイルがあった場合はバージ

ョンを確認し、新しければコピーしてください。 
 

・ WindowsNT/2000 の場合  C:¥WINNT¥system32¥drivers 
・ WindowsXP の場合  C:¥WINDOWS¥system32¥drivers 

 
コマンドプロンプトを立ち上げ、wdreg.exe のあるフォルダに移動し、以下のコマンドを実行してください。 

 
＞ wdreg -inf [Windows インストールディレクトリ]¥system32¥drivers¥windrvr6.inf install 

 
 
install: completed successfully 

 
と表示されます。これでドライバがインストールされ、エラーが出なくなります。 
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SZ130

 
6.2.3. SPI Writer で書き換える  

SPI Writer を使って書き換える方法を説明します。 
 

6.2.3.1. SZ130 
SZ130 の場合、コンフィギュレーションデータを M25P64(メーカ：ST マイクロエレクトロニクス)という SPI フラッシ

ュメモリに記憶させ、再起動時に Spartan3E の SPI モードで FPGA にデータを書き込みます。SPI フラッシュメモ

リは SZ130 の裏面に実装されています。 
 

SPI フラッシュメモリ

裏

 
図 6-25 SZ130 の SPI フラッシュメモリの所在 
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図 6-26 SPI モードの書き込み（SZ130） 
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6.2.3.2. SZ410 

SZ410 の場合、コンフィギュレーションデータを CPLD で M25P64(メーカ：ST マイクロエレクトロニクス)という

SPI フラッシュメモリに記憶させ、再起動時に CPLD で SPI フラッシュメモリにコンフィギュレーションデータを書き込

んでいます。CPLD および SPI フラッシュメモリは下図の位置に配置されています。 
 
 

 
図 6-27 SZ410 の CPLD および SPI フラッシュメモリの所在 

 
 
 
コンフィギュレーション時の CPLD の動作は以下の通りとなります。 
 

１． JP2 をショートしてコンフィギュレーションデータを書き込むと、パラレルケーブルからのコンフィギュレーシ

ョンデータを SPI フラッシュメモリにスルーで書き込む。 
２． JP2 を開放して電源を投入すると、SPI のビットストリームをマスターシリアルに変換してコンフィギュレー

ションする。 
３． コンフィギュレーション後は SPI フラッシュメモリのデータ線を開放し、SPI フラッシュメモリに FPGA の制

御を渡す。 
 
SUZAKU に実装している CPLD で使用している VHDL コードは、Xilinx の XAPP800 というドキュメントを元

に作成しています。 
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図 6-28 CPLD による書き込み（SZ410） 
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6.2.3.3. 書き込み準備 

まず、SUZAKU JP2 にジャンパプラグをさし、ショートさせてください。JP2 をショートさせると、電源投入時

FPGA に対し、フラッシュメモリからのコンフィギュレーションを停止させることができます。コンフィギュレーションを停

止させないと書き込み不良等を起こしてしまいます。 
LED/SW CON4 に JTAG のダウンロードケーブル（Xilinx Parallel CableⅢまたはⅣ）を接続し、LED/SW 

CON6 に AC アダプタ５V を接続し、電源を投入してください。SUZAKU D3 のパワーON LED(緑)が点灯してい

るか確認してください。 
Xi
l
in
x

Sp
a
rt
a
n3
E

Xilinx
Parallel Cable
Ⅲ or Ⅳ

 
図 6-29 SPI Writer 書き込み準備 
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6.2.3.4. SPI Writer 立ち上げから書き込み 

SPI Writer を立ち上げ、[...]をクリックして下さい。ファイル選択画面が立ち上がります。 
 

 
図 6-30 SPI_Writer 

書き込む bit ファイルを選択し、[開く]をクリックしてください。SPI Writer で書き込めるファイルは bit ファイルで

す。 
SUZAKU のデフォルトの bit ファイルは付属 CD-ROM の 
"¥suzaku¥fpga¥x.x¥sz***¥sz***-yyyymmdd.zip"を展開したフォルダの中の"default_bit_file"に収録され

ています。また、スロットマシンの bit ファイル（スターターキット出荷時の bit ファイル）は付属 CD-ROM の 
"¥suzaku-starter-kit¥fpga¥x.x¥sz***¥sz***-add_slot-yyyymmdd.zip"を展開したフォルダの中の

"default_bit_file"に収録されています。 
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図 6-31 bit ファイル選択 

 
SPI Writer は書き込みたい bit ファイルをドラッグ＆ドロップで選択することもできます。 

 

 
図 6-32 ドラッグ＆ドロップ 

 
これで書き込み準備完了です。ダウンロードをクリックしてください。Verify を必要としない場合は、チェックボタン

をはずしてください。 
 

 
図 6-33 書き込み準備完了 
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書き込みを開始してもいいか確認画面が表示されるので[OK]をクリックしてください。 

 

 
図 6-34 書き込み確認画面 

 
コンフィギュレーションデータが SPI フラッシュメモリに書き込まれます。ここで”Please check windrvr.sys”という

エラーが発生した場合は後述の Tips を参照してください。 
 

 
図 6-35 書き込み中 

 
 
 

以下の画面のように”Download has been completed!”と表示されたら書き込み終了です。 
何らかの原因でエラーを起こした場合は、SUZAKU を動作させず、再び書き込みを行ってください。 
 

 

 
図 6-36 書き込み終了 

 
LED/SW CON6 から AC アダプタ 5V を抜いて電源を切り、JP2 のジャンパプラグと LED/SW CON4 のダウン

ロードケーブルをはずしてください。再び LED/SW CON6 に AC アダプタ 5V を接続し、電源を再投入してくださ

い。 
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6.2.3.5. SPI Writer で書き換える 手順まとめ 

１．  SUZAKU JP2 にジャンパプラグをさしてショートさせる 
２．  LED/SW CON4 にダウンロードケーブルを接続する 
３．  LED/SW CON6 に AC アダプタ 5V を接続し、電源投入 
４．  SUZAKU D3 のパワーON LED(緑)が点灯していることを確認 
５．  SPI_Writer を立ち上げ、SPI フラッシュメモリにコンフィギュレーションデータを書き込む 
６．  LED/SW CON6 の AC アダプタ 5V をはずし、電源を切る 
７．  LED/SW CON4 のダウンロードケーブルをはずす 
８．  SUZAKU JP2 のジャンパプラグをはずす 
９．  LED/SW CON6 に AC アダプタ 5V を接続し、電源再投入 
１０． 動作確認 
※電源を切っても、コンフィギュレーション内容は失われません。 

 
 

 
 
TIPS  SPI Writer とは 

 
SPI Writer は SPI フラッシュメモリの先頭から 1MByte まで消去し、コンフィギュレーションデータを書き込む

SUZAKU の SPI フラッシュメモリ専用の書き込みツールです。 
SUZAKU は SPI フラッシュメモリにソフトウェアのデータやその他データを保存しており、これらのデータを壊さな

いために専用ツールで書き込みます。 
 
SPI フラッシュメモリの書き込みツールとしては iMPACT の DirectSPI もあります。ただし、DirectSPI は SPI フ

ラッシュメモリのデータを全消去して、コンフィギュレーションデータを書き込むツールであるため、SUZAKU の SPI
フラッシュメモリ書き込み用として使うには注意が必要となります。 
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TIPS  SPI Writer ERROR 

 
SPI Writer で書き込む際、以下のエラーが出ることがあります。この場合ドライバのインストールが必要となります。 

 

 
図 6-37 エラー表示 

SPI Writer のフォルダの中に wdreg.exe、difxapi.dll、wd811.cat、windrvr6.inf、windrvr6.sys の 5 つのフ

ァイルがあることを確認してください。 
コマンドプロンプトを立ち上げ、SPI Writer のフォルダに移動し、Administrator 権限ユーザで以下のコマンドを

実行してください。 
 
> wdreg -inf windrvr6.inf install 

 
以下のようなログが表示されます。これでドライバがインストールされ、エラーが出なくなります。 

 
Installing a signed driver package 
LOG Event: 1, ENTER:  DriverPackageInstallA 
LOG Event: 1, ENTER:  DriverPackageInstallW 
LOG Event: 1, Looking for Model Section [DeviceList]... 
LOG Event: 1, windrvr6.inf: checking signature with catalog 'C:¥spi_writer-200701 
19¥wd811.cat' ... 
LOG Event: 1, Driver package 'windrvr6.inf' is Authenticode signed. 
LOG Event: 1, Copied 'windrvr6.inf' to driver store... 
LOG Event: 1, Copied 'wd811.cat' to driver store... 
LOG Event: 1, Commiting queue... 
LOG Event: 1, Copied file: 'C:¥spi_writer-20070119¥.¥windrvr6.sys' -> 'C:¥WINDOWS 
¥system32¥DRVSTORE¥windrvr6_45AF516B2C99AB8FE1C0F3A3CBE523C199AE6F2B¥.¥windrvr6. 
sys'. 
LOG Event: 1, Installing INF file "C:¥WINDOWS¥system32¥DRVSTORE¥windrvr6_45AF516 
B2C99AB8FE1C0F3A3CBE523C199AE6F2B¥windrvr6.inf" of Type 6. 
LOG Event: 1, Looking for Model Section [DeviceList]... 
LOG Event: 1, Installing devices with Id "*WINDRVR6" using INF "C:¥WINDOWS¥syste 
m32¥DRVSTORE¥windrvr6_45AF516B2C99AB8FE1C0F3A3CBE523C199AE6F2B¥windrvrinstall: c 
ompleted successfully 
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6.3. ブートローダ Hermit の書き換えかた 

ブートローダ Hermit を書き換えるには BBoot で書き換える方法と、ダウンローダ Hermit で書き換える方法の

2 通りがあります。ここでは BBoot で書き換える方法を説明します。ダウンローダ Hermit の使い方については

"6.4.1 ダウンローダ Hermit で書き換える"を参考にして下さい。 
 
6.3.1. BBoot で書き換える 

BBoot でブートローダ Hermit を書き換える方法を説明します。この際、Hermit のイメージデータはモトローラ S
形式のものを使用します。 
 
6.3.1.1. 準備から書き込み 

まず、JP1 にジャンパプラグをさし、ショートさせてください。JP1 をショートさせるとブートローダモードになります。 
SUZAKU CON1 に方向に気をつけてシリアルケーブルを接続し、シリアル通信ソフトウェアを起動してください。

("5.2 シリアル通信ソフトウェア"参照)。LED/SW CON6 に AC アダプタ 5V を接続し、電源を投入してください。

SUZAKU D3 のパワーON LED(緑)が点灯しているか確認してください。 
シリアル通信ソフトウェアの画面に以下のようなメッセージが表示されます。 
SUZAKU スターターキット以外の場合は、電源投入直後に"z"キーを長押しすると、以下のようなメッセージが表

示されます。何も立ち上がらない場合は、"6.2 FPGA の書き換えかた"を参照して FPGA を書き込んでください。 
 
Please choose one of the following and hit enter. 
a: active second stage bootloader (default) 
s: download a s-record file 
t: busy loop type slot-machine 
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図 6-38 モトローラ S 形式書き換え準備 

 
"s"キーを押してください。モトローラ S 形式ダウンロードモードになります。以下のようなメッセージが表示されます。 

 
Start sending S-Record!! 
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書き込むモトローラ S 形式のファイルを選択してください。書き込むファイルは srec ファイルです。 
ブートローダ Hermit のファイルは付属 CD-ROM の"¥suzaku¥bootloader¥s-record"に収録されています。 
• loader-suzaku-microblaze-vx.x.x-4M.srec ： SZ010 用 
• loader-suzaku-microblaze-vx.x.x-8M.srec ： SZ030、SZ130 用 
• loader-suzaku-powerpc-vx.x.x-8M.srec ： SZ310、SZ410 用 
 

 
図 6-39 srec ファイルを送る 

 
書き込みが始まると以下のような画面になります。 
 

 
図 6-40 srec ファイル書き込み中 
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以下のように表示されたら書き込み完了です。電源を再投入してください。今書き込んだブートローダ Hermit が

起動します。 
 
Erasing SPI... 
Programming SPI... 
done. 
Reboot. 
 
Please choose one of the following and hit enter. 
a: active second stage bootloader (default) 
s: download a s-record file 
t: busy loop type slot-machine 

 
6.3.1.2. BBoot で書き換える 手順まとめ 
 

１． SUZAKU JP1 にジャンパプラグをさしてショートさせる 
２． LED/SW CON1 にシリアルケーブルを接続する 
３． シリアル通信ソフトウェアを立ち上げる 
４． LED/SW CON6 に AC アダプタ 5V を接続し、電源投入 
５． SUZAKU D3 のパワーON LED(緑)が点灯していることを確認 
６． シリアル通信ソフトウェアの画面を確認し、"s"と入力し、モトローラ S 形式ダウンロードモードにする 
７． srec ファイルを選択し、書き込む 
８． 動作確認 
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6.4. Linux の書き換えかた 

Linux のイメージを書き換えるにはダウンローダ Hermit で書き換える方法、NetFlash で書き換える方法の 2
通りがあります。ここではダウンローダ Hermit で書き換える方法について説明します。NetFlash の使い方につい

ては SUZAKU Software Manual をご参照ください。 
 
6.4.1. ダウンローダ Hermit で書き換える 

ダウンローダ Hermit で Linux のイメージを書き換える方法を説明します。 
 

6.4.1.1. 書き込み準備 
まず、JP1 にジャンパプラグをさし、ショートさせてください。JP1 をショートさせるとブートローダモードになります。 
SUZAKU CON1 に方向に気をつけてシリアルケーブルを接続し、シリアル通信ソフトウェアを起動してください。

("5.2 シリアル通信ソフトウェア"参照)。LED/SW CON6 に AC アダプタ 5V を接続し、電源を投入してください。

SUZAKU D3 のパワーON LED(緑)が点灯しているか確認してください。 
シリアル通信ソフトウェアの画面に以下のようなメッセージが表示されます。 

 
Please choose one of the following and hit enter. 
a: active second stage bootloader (default) 
s: download a s-record file 
t: busy loop type slot-machine 

 

Xi
li
nx

Sp
ar
t
an
3E

 
図 6-41 Linux 書き換え準備 

 
"a"もしくは”Enter"キーを押してください。ブートローダ Hermit が立ち上がります。 
以下のようなメッセージが表示されます。もし立ち上がらない場合は"6.3 ブートローダ Hermit の書き換えかた"

を参照してブートローダ Hermit を書き込んでください。 
 

Hermit-At v1.1.3(suzaku/microblaze) compiled at 13:49:17, Aug 15 2006 
hermit>  
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ブートローダ Hermit が立ち上がったのを確認したら、シリアルポートをシリアル通信ソフトから切断します。 
[File]→[Disconnect]を選択してください。 
 

 
図 6-42 シリアルポートを切断 

 
 

6.4.1.2. ダウンローダ Hermit 立ち上げから書き込み 
ダウンローダ Hermit を起動してください。[Download]ボタンをクリックすると Download 画面が表示されます。

[Serial Port] に、SUZAKU と接続しているシリアルポートを設定し、[Image]に書き込むイメージファイルを指定し

てください。ダウンローダ Hermit では bin ファイルを書き込みます。 
SUZAKU のデフォルトの bin ファイルは付属 CD-ROM の"¥suzaku¥image¥image-sz***.bin"に収録されて

います。また、スロットマシンの bin ファイル（スターターキット出荷時の bin ファイル）は付属 CD-ROM の 
"¥suzaku-starter-kit¥image¥image-sz***-sil.bin"に収録されています。 
[Region]には、書き込むリージョンまたは、アドレスを指定します。Linux はイメージリージョンに書き込みます。

[image]を選択してください。 

 
図 6-43 Download 画面 
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[実行]をクリックしてください。フラッシュメモリへの書き込みが始まります。書き込み中は、進捗状況が表示されま

す。 
 

 
図 6-44 書き込み進捗ダイアログ 

 
書き込みが終了すると、書き込み終了画面が表示されます。"Download COMPLETE"と表示されたら書き込み

成功です。 

 
図 6-45 書き込み終了 

 
6.4.1.3. FPGA とブートローダ Hermit を書き換える 

ダウンローダ Hermit では FPGA およびブートローダ Hermit も書き換えることが出来ます。これらの bin ファイ

ルは Linux の bin ファイルと同じフォルダに収録されています。 
 

FPGA 
• fpga-sz***-x.x- yyyymmdd.bin  ： デフォルト 
• fpga-sz***-sil-x.x- yyyymmdd.bin  ： スロットマシン 
 
ブートローダ Hermit 
• loader-suzaku-microblaze-vx.x.x.bin ： SZ010、SZ030、SZ130 用  
• loader-suzaku-powerpc-vx.x.x.bin  ： SZ310、SZ410 用 
 

これらを書き換える場合は[Region]に[fpga]、[bootloader]をそれぞれ選択してください。また、書き込む際は、

[ForceLocked]をチェックする必要があるのでご注意ください。チェックしないと、警告が表示され書き込みが始まりま

せん。 
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6.4.1.4. ダウンローダ Hermit で書き換える 手順まとめ 
 

１． SUZAKU JP1 にジャンパプラグをさしてショートさせる 
２． LED/SW CON1 にシリアルケーブルを接続する 
３． シリアル通信ソフトウェアを立ち上げる 
４． LED/SW CON6 に AC アダプタ 5V を接続し、電源投入 
５． SUZAKU D3 のパワーON LED(緑)が点灯していることを確認 
６． シリアル通信ソフトウェアの画面を確認し、"a"もしくは”Enter"キーを入力 
７． ブートローダ Hermit モードになったのを確認し、シリアルポートを切断 
８． ダウンローダ Hermit を起動し、イメージファイルを書き込む 
９． 動作確認 

 
 

 
 
TIPS  FPGA の bin ファイルの作り方 

 
FPGA の bit ファイルはヘッダ部にデバイス情報や日付情報が入っただけのバイナリデータファイルです。bin フ

ァイルとの違いはヘッダ部だけなので、この部分を削除すれば bin ファイルを作ることが出来ます。バイナリエディタ

で bit ファイルを開き、ヘッダ部のデータ FFFFFFFFh の手前までを削除し、拡張子を bin に変更して保存してく

ださい。ダウンローダ Hermit で FPGA リージョンに書き込める FPGA の bin ファイルの出来上がりです。 
 
 
 

 
 
TIPS  パラレルポートがなくても・・・ 

 
お使いの PC にパラレルポートがないという方もたくさんおられると思いますが、実はパラレルポートがなくても、 
• シリアルポート 
• USB ポート 
• Platform Cable USB 

があれば、問題なく SUZAKU を書き換えることができます。BBoot とブートローダ Hermit さえ動けば、シリアルポ

ートから FPGA リージョン、ブートローダリージョン、イメージリージョンの全てを書き換えることが出来るからです。

BBoot、ブートローダ Hermit が壊れてしまった時のみ、シリアルポートからでは直せないので、USB ポートと

Platform Cable USB（もしくはパラレルポートと Parallel Cable ＩＩＩ/IV）が必要となります。BBoot とブートローダ

Hermit は以下の手順で修復できます。 
 
1. JP2 をショートし、Platform Cable USB と iMPACT で FPGA に BBoot(bit ファイル)をコンフィギュレーショ

ン 
2. BBoot が起動するので、"s"キーを押し、モトローラ S 形式でブートローダ Hermit(srec ファイル)をフラッシュメ

モリのブートローダリージョンに書き込む(スターターキット以外の場合は、"s"キーの前に"z"キー長押しが必要) 
3. 再度 Platform Cable USB と iMPACT で FPGA に BBoot(bit ファイル)をコンフィギュレーション 
4. BBoot が起動するので、"a"キーを押し、ダウンローダ Hermit でフラッシュメモリの FPGA リージョンに

BBoot(bin ファイル)を書き込む 
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7. ISE の使い方 
 

 
 

FPGA 側から SUZAKU の開発をするためには、ISE(Integrated Software Environment)の使い方を知るこ

とが必要不可欠です。ISE は Xilinx が提供する FPGA の統合型設計環境です。GUI 統合ツール Project 
Navigator で、FPGA に必要な論理合成、配置配線、bit ファイルの書き込みのツールなど、トータルな開発環境を

提供しています。 
ここでは LED/SW ボードの単色 LED(D1)を点灯させると共に ISE の使い方を説明します※。ISE の使い方の

詳細は ISE のヘルプ、マニュアル等を参照してください。ISE には日本語のヘルプ、マニュアル等も用意されてい

ます。 
 

なお、本書では ISE において以下の手順で作業を行います。 

プロジェクトの
新規作成

ソースファイルの
作成および

ソースファイルの
追加

論理合成（XST)

変換

マップ

配置配線

インプリメンテーション

デバイスの選択

コンフィギュレーション
(IMPACT)

プログラムファイル
作成(BitGen)

シミュレーション

ISEで作業を行う時は、左図で現在
どの作業を行っているのかを示しま
す。
左図の場合、論理合成のための作
業を行っているところです。

N

X

I

G

P

S

 
図 7-1 本書での ISE 開発フロー 

 

                                                  
※本書では ISE8.1i を使用しています。 
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7.1. 単色 LED を点灯させる 

ISE を使って、LED/SW ボードに実装されている単色 LED(D1)を点灯させてみます。 
 

7.1.1. 単色 LED 周辺回路 
単色 LED 周辺回路は下図のようになっています。それぞれ 180Ωの抵抗で 3.3V にプルアップされています。

FPGA から”Low”を出力すると、単色 LED が点灯し、”High”を出力すると、単色 LED が消灯します。 
 

+3.3V

180Ω

FPGA

D1D2D3D4

nLE0nLE1nLE2nLE3

 
図 7-2 単色 LED 周辺回路 

 
 
 

 

 
 
TIPS  FPGA の入出力について 

 
SUZAKU の FPGA の I/O ピンは CMOS＋3.3V に設定されています。FPGA からは”Low”で 0.4V 以

下、”High”で 2.9V 以上が出力されます。FPGA へは 0.8V 以下で”Low”、2.0V 以上で”High”が入力されます。

ただし、ディジタル入力定格は‐0.3V～3.6V なので、それを超えて入力しないでください。 
 

表 7-1 FPGA 入力、出力 

 Low(V) High(V) 
出力        OUT ＜= 0.4 2.9 ＜= OUT 
入力 －0.3 ＜ IN ＜= 0.8 2.0 ＜=  IN  ＜=3.6 
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7.2. プロジェクトの新規作成 
7.2.1. プロジェクト作成 

Project Navigator を起動してください。Project Navigator は、 
"¥ISE のインストールフォルダ¥bin¥nt¥_impact.exe"から起動できます。 
もしくは、[スタートメニュー]→[すべてのプログラム]→[Xilinx ISE x.x]→[Project Navigator]から 
起動できます。 
[File]→[New Project]をクリックしてください。 

 
図 7-3 Project Navigator 起動 

 
New Project Wizard が表示されます。[Project Location]の[…]をクリックし、プロジェクトのディレクトリパスを指

定します。ここでは C¥suzaku とします。[Project Name]に プロジェクト名を入力します。 slot_le と入力し、

[Top-Level Source Type]が[HDL]となっていることを確認し、[Next]をクリックしてください。 
 

 
 

図 7-4 プロジェクトの新規作成 

[File]→[New Project]をクリック

ディレクトリパスを指定 
C:¥suzaku と入力 

確認 

ｓlot_le と入力 
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7.2.2. デバイスの選択 

SUZAKU に実装されている FPGA デバイスを選択します。お使いの SUZAKU の型式の設定にし、[Next]をク

リックしてください。 
 

型式 SZ010 SZ030 SZ130 SZ310 SZ410 
Product Category All 
Family Spartan3 Spartan3E Virtex2P Virtex４ 
Device XC3S400 XC3S1000 XC3S1200E XC2VP4 XC4VFX12
Package FT256 FG320 FG256 SF363 
Speed －4 －5 －10 
Synthesis Tool XST(VHDL/Verilog) 
Simulator ISE Simulator(VHDL/Verilog) 

 

 
図 7-5 デバイスの選択(SZ130 の場合) 

 

デバイスの選択 

デザインフローの選択 
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7.2.3. ソースファイル作成 

[New Source]をクリックしてください。 
 

 
図 7-6 New Source 作成 

[VHDL Module]を選択し、[File name]に top と入力し、[Next]をクリックしてください。VHDL ソースファイルが

作成されます。 
 

 
図 7-7 VHDL ソースファイル作成 

top と入力 

VHDL Module をクリック 
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[Architecture Name]を入力してください。何でも良いのですが、SUZAKU では IMP(implement の意味)とし

ています。変更したら [Next]をクリックしてください。 
 

 
図 7-8 アーキテクチャ名定義 

 
今作った VHDL ソースファイルの設定が表示されます。設定に間違いがないか確認をし、[Finish]をクリックして

ください。 
 

 
図 7-9 ソースファイル作成確認画面 

IMP に変更 
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以下の画面が出るまで[Next]をクリックして下さい。内容を確認し、[Finish]をクリックしてください。 

 

 
図 7-10 最終確認画面(SZ130 の場合) 
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以上で新規プロジェクトおよび VHDL ソースファイルが出来上がります。 
top‐IMP(top.vhd)をダブルクリックしてください。top.vhd が開きます。 

 

 
図 7-11 新規プロジェクト、ソースファイルのテンプレート作成完了 

 
 

top(top.vhd)をダブルクリック 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                                        ISE の使い方 
 

87

 
7.3. ソースファイル作成 

テンプレートが自動生成されています。以下のように単色 LED への出力信号の定義と単色 LED を点灯させる

文を追加してください。 

 
 
library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
---- Uncomment the following library declaration if instantiating 
---- any Xilinx primitives in this code. 
--library UNISIM; 
--use UNISIM.VComponents.all; 
entity top is 
 
  port ( 
    nLE0 : out  STD_LOGIC 
  ); 
 
end top; 
 
architecture IMP of top is 
begin 
 
  nLE0 <= '0';  
 
end IMP; 

図 7-12 ソースコード入力 

追加できたら、[File]→[Save]をクリックして保存してください。 

出力信号の定義 

単色 LED を点灯させる 
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7.4. 論理合成 

トップモジュール top – IMP(top.vhd)を選択し、Synthesize をダブルクリックしてください。

Synthesize をダブルクリックすると文法チェックが始まります。ソースコードに間違いがなければ

Synthesize の横にチェックマーク もしくは警告マーク が付きます。もしエラーマーク になった場

合はログをチェックし、ソースコードを見直してください。ソースコードを修正して保存するとマークが疑問

符 に変わるので、再び Synthesize をダブルクリックし、エラーマークがなくなるまで繰り返してくださ

い。 
 

 
図 7-13 文法チェック 

 

Synthesize をダブルクリック 

トップモジュールを選択 

ログが表示される 
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7.5. インプリメンテーション 

Implement Design の横の 、Translate の横の をクリックして開き、 
Assign Package Pins Post-Translate をダブルクリックしてください。 

 

 
図 7-14 PACE を立ち上げる 

ucf ファイルを追加してもいいかという質問をされるので[Yes]をクリックしてください。 
 

 

図 7-15 ucf ファイル作成確認 

Assign Package Pins Post-Translate をダブルクリック 
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PACE というピンアサインを設定できるソフトが立ち上がります。”表 2-2 機能用ピンアサイン”を参照し、D1 の単

色 LED とつながっている FPGA のピンを割り当てます。LOC にピンアサインを入力し、I/O Std.を LVCMOS33 と

してください。 

表 7-2 ｎLE0 ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nLE0 B12 E12 L16 G2 
 

 [File]→[Save]をクリックして保存し、PACE を閉じてください。 

 
図 7-16 PACE によるピンアサイン(SZ130 の場合) 

Loc にピンアサインを入力し、 
I/O Std.を LVCMOS33 に設定 
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TIPS  I/O ピンのカスタマイズ 

 
最近の FPGA は I/O のカスタマイズも自由に行うことが出来ます。PACE の Design Object List -I/O Pins ウィ

ンドウで、数 10kΩの Pull Up、Pull Down をつけたり、電流制限をつけたり(オーバーシュートやアンダーシュート

の設定)、スルーレートの High、Low の設定、I/O の属性の変更(SUZAKU では I/O 電圧が 3.3V のため、属性は

C-MOS のみ)等が出来ます。 
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Project Navigator に戻って top-IMP(top.vhd)の横の をクリックして開いてください。ピンアサインのファイ

ル”top.ucf”が出来上がっています。今回は PACE でピンアサインをしましたが、Text で編集することもできます。

top.ucf をクリックすると、Processes のウィンドウに top.ucf のプロセスが表示されるので Edit Constraints(Text)を
ダブルクリックしてください。ピンアサインが Text で表示されます。 
 

 
図 7-17 ピンアサインのソースコード(SZ130 の場合) 

 

Edit Constraints(Text)をダブルクリック 

自動生成されたソースコード 

top_ucf(top.ucf)をクリック 
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top_IMP(top.vhd)をクリックし、Implement Design をダブルクリックしてください。残りのインプリメントが始まり

ます。 
 

 
図 7-18 インプリメント 

Implement Design をダブルクリック 

top_IMP(top.vhd)をクリック 
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7.6. プログラムファイル作成 

Generate Programming File をダブルクリックします。エラーがなければ、top.bit という FPGA
コンフィギュレーション用の bit ファイルが生成されます。 
 

 
図 7-19 bit ファイル作成 

Generate Programming File をダブルクリック 
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7.7. コンフィギュレーション 
FPGA に作成した top.bit を書き込みます。 

 
7.7.1. JTAG でコンフィギュレーション 

iMPACT で top.bit を書き込みます。iMPACT での FPGA の書き換え方については"6.2.1 

iMPACT で書き換える"を参照してください。iMPACT は Project Navigator の Configure 
Device (iMPACT)をダブルクリックすることでも起動することが出来ます。 
 

 
図 7-20 iMPACT 立ち上げ 

Configure Device (iMPACT)をダブルクリック 
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単色 LED(D1)が光ったでしょうか？ 
 
 

Xi
li
n
x

S
pa
rt

an
3
E

 
図 7-28 単色 LED(D1)点灯 

 
7.7.2. フラッシュメモリに保存してコンフィギュレーション 

一回電源を切ってもう一度電源を入れてみてください。フラッシュメモリに保存されているデータがコンフィギュレー

ションされるので、スロットマシンの状態に戻ったと思います。これは Xilinx の FPGA が SRAM ベースのためです。

内部の回路内容を保持させるにはフラッシュメモリにコンフィギュレーションデータを書き込む必要があります。フラッ

シュメモリへの書き込み方法については SZ010, SZ030, SZ130 の場合は"6.2.2 LBPlayer2 で書き換える"を、

SZ130、SZ410 の場合は"6.2.3 SPI Writer で書き換える"を参照してください。フラッシュメモリに書き込むと、電

源を切ってもコンフィギュレーションデータが失われません。 
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7.8. 空きピン処理 

D1 を点灯させたとき、D2、D3、D4 が少し光っているのに気がついたでしょうか？（SZ310、SZ410 だとほとんど

光りません。） 
これは空きピンの処理の仕方によります。 
Generate Programming File を右クリックしてメニューを出し、Properties を選択してください。 

 

 
図 7-21 空きピン処理の設定画面の出し方 

右クリックして、メニューを出し、Properties を選択 
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[Configuration Options]を選ぶと次の画面が出てきます。ここで空きピンの終端処理を設定できます。この中に

[Unused IOB Pins]というのがありますが、これが空きピン処理の設定になります。初期設定で、[Pull Down]にな

っています。このため"図 7-23 少し光る理由"のように D2、D3、D4 に電流が少し流れて LED が光ってしまいます。 

 
図 7-22 空きピン処理設定 

電流が
少し流れる

+3.3V

FPGA
+3.3V

ウィーク
プルダウン

ウィーク
プルアップ

 

図 7-23 少し光る理由 

設定を[Pull Up]にすると、D2、D3、D4 は光らなくなりますが、ここの設定では空きピンの終端処理を個別に設定

することが出来ないため、SUZAKU が動かなくなってしまう可能性があります。SUZAKU には RESET 回路があり、

RESET 回路につながっているピンは外部で Pull Down されています。このピンの終端処理は Low かハイインピ

ーダンスにしておかなければならず、High や Pull Up、Float に変更した場合、リセットがかかってしまうことがありま

す。また、空きピンから電圧が出力されているのはあまり良い状態ではありません。よって今回は D2、D3、D4 に信

号を定義することで、この問題に対処します。top.vhd、top.ucf に D2、D3、D4 の信号の記述を加えてください。 
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例 7-1 信号の記述を追記（top.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
---- Uncomment the following library declaration if instantiating 
---- any Xilinx primitives in this code. 
--library UNISIM; 
--use UNISIM.VComponents.all; 
entity top is 
 
  port ( 
    nLE0 : out  STD_LOGIC; 
 
    nLE1 : out  STD_LOGIC; 
    nLE2 : out  STD_LOGIC; 
    nLE3 : out  STD_LOGIC 
 
  ); 
 
end top; 
 
architecture IMP of top is 
begin 
 
  nLE0 <= '0';  
 
  nLE1 <= '1';  
  nLE2 <= '1';  
  nLE3 <= '1';  
 
end IMP; 

 
表 7-3 ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nLE1 C12 F12 L15 F2 
nLE2 D11 B11 L14 F1 
nLE3 E11 A11 L13 E1 
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8. VHDL によるロジック設計 
 

 
 

本書を読むために必要となる最低限の VHDL の記述方法とロジック設計について説明します。VHDL の詳細や

ロジック設計については、世の中に詳しい書物が多数ありますのでそちらをご参照ください。 
 
8.1. VHDL の基本構造 

まず VHDL の記述方法を説明します。 
VHDL の基本構造は 

 
● ライブラリ宣言とパッケージ呼び出し 
● エンティティ(entity) 
● アーキテクチャ（architecture） 
 

からなります。 
 

ライブラリ宣言とパッケージ呼び出しで、各種演算子や関数などを定義したパッケージを呼び出し、エンティティに

外部とのインターフェースを記述し、アーキテクチャに内部回路の構造や動作を記述します。 
VHDL では予約語も含めて大文字と小文字を区別しません。例えば Port は port とかいても PORT とかいても

同じに扱われます。予約語については後述の Tips を参照してください。もし、ISE 付属のテキストエディタを使って

いる場合、予約語は青に色が変わって表示されます。また、--で始めるとその行末までがコメントになります。 
 

例 8-1 VHDL 基本構造 

--ライブラリ宣言とパッケージ呼び出し 
library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
--エンティティ（入出力の宣言） 
entity slot is 
  Port ( 
    --ここに入出力ピンの宣言を書く 
); 
end slot; 
 
--アーキテクチャ（回路本体） 
architecture IMP of slot is 
 
  --内部信号等の各種宣言を記述する 
 
begin 
  --ここに回路を記述する 
end IMP; 

 

コメント文 

Port も port も PORT も同じ 
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8.2. ライブラリ宣言とパッケージ呼び出し 

ISE で VHDL ソースコードを自動生成すると、パッケージが 3 つ呼び出されます。それぞれの用途は下表の通り

です。他にも様々なパッケージがあるので、必要に応じて呼び出してください。ライブラリは自分で作成することも出

来ます。 

表 8-1 ライブラリとパッケージ 

ライブラリ パッケージ 用途 
IEEE std_logic_1164 基本関数 
  std_logic_arith 算術演算 
  std_logic_unsigned 符号なし演算 

 
 

8.3. エンティティ(entity) 
エンティティ内ではポートの宣言を行います。外部とのインターフェースについて定義する部分がエンティティにな

ります。ISE で VHDL ソースコードを自動生成すると、エンティティ名はファイル名と同じ名前になります。 

例 8-2 entity 記述 

entity slot is –-entity エンティティ名 is 
  Port ( 
    SYS_CLK : in std_logic; 
    nLE : out std_logic_vector(0 to 2); 
    nSW : in  std_logic_vector(0 to 2) –-最後に ; は不要 
  ); 
end slot; –-end エンティティ名; 

 
8.3.1.1. 信号の定義 

信号は以下の形式で宣言します。 

例 8-3 信号の定義 

ポート信号名：入出力方向 データタイプ名; 

 
8.3.1.2. 入出力方向 

入出力方向には in、out、inout 等を記述します。 

表 8-2 入出力方向 

in 入力であることを指定 
out 出力であることを指定（内部で再利用できない） 
inout 入出力であることを指定 

 
VHDL では、出力ポート信号を内部に参照できません。内部で参照したいときは、内部参照用に内部信号を用い

ます。内部信号の宣言については"8.4 アーキテクチャ(architecture)"の内部信号の定義の項を参照してください。 
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8.3.1.3. データタイプ 

データタイプには色々ありますが、よく使うのは std_logic と std_logic_vector です。std_logic で

１ビットの信号を定義し、std_logic_vector（0 to n） で n＋1 ビット幅の信号を定義します。 
nLE : out std_logic_vector(0 to 2) とすると 3 ビットの幅を持った出力信号を定義することができま

す。nLE(0)、nLE(1)、nLE(2)とすることで、それぞれのビットを切り出すことができます。 
to を使って定義すると、MSB 側がビット 0 になります。（downto とすると LSB 側がビット 0 になります。本書で

は IBM の CoreConnect にあわせてバスを定義するため("9.1.7 バスのビットラベルについて"参照)、to を使いま

す。） 

表 8-3 データタイプ 

std_logic IEEE ライブラリで定義 
std_logic_vector std_logic のベクタ・タイプ 
integer 整数型(32 ビット) 

 
ビットラベル 0 1 2 3 

 MSB   LSB

図 8-1 to を使って定義 

8.4. アーキテクチャ(architecture) 
回路の構造や動作などをここに記述をします。アーキテクチャ名は任意ですが、SUZAKU では IMP としていま

す。 

例 8-4 architecture 記述 

architecture IMP of slot is –-architecture アーキテクチャ名 of エンティティ名 is 
--内部信号の定義 
  signal count : STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1);  
  signal count_led : STD_LOGIC; 
 
begin 
--ここに同時処理文を記述する 
  nLE <= not le; --信号代入文 
  process(SYS_CLK) –-プロセス文 
  begin 
    if SYS_CLK'event and SYS_CLK = '1' then 
      if SYS_RST = '1' then 
        count <= (others => '0');  
      else 
        count <= count + 1; 
      end if; 
    end if; 
  end process; 
end IMP; --end アーキテクチャ名; 

 
8.4.1.1. 内部信号の定義 

内部で使用する信号は architecture と begin の間に記述します。信号の宣言には signal を用い、以下

の形式で宣言します。データタイプ名はエンティティの信号宣言と同じですので、"8.3 エンティティ(entity)"のデー

タタイプの項をご参照ください。 

例 8-5 内部信号定義 

signal 信号名 : データタイプ名； 

 

同時に処理される 
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8.4.1.2. 同時処理文 
begin～end の間に直接記述された回路を同時処理文といいます。同時処理文ではそれぞれが他の同時処理

文と関係なく動作し、並列に処理されます。信号代入文、プロセス文などの回路を記述します。 
 
8.4.1.3. 信号代入文 
A<=B;とすると、A に B が代入されます。 

 
8.4.1.4. プロセス文 

プロセス文は以下の形で記述します。 

例 8-6 プロセス文 

process(センシティビティリスト) 
begin 
・ 
・ 
・ 
end process; 

 
センシティビティリストに記述した値のどれかが変化すると、中に記述した文が上から実行されていきます。最終行

まで実行すると上に戻り、次にこれらの信号が変化するまで動作を停止します。 
 
 
 
 
 
 

 
 
TIPS  VHDL 予約語 

 
abs, access, after, alias, all, and ,architecture, array, assert, attribute, begin, block, body, buffer, bus, 
case, component, configuration, constant, disconnect, downto, else, elsif, end, entity, exit, file, for, 
function, generate, generic, guarded, if, impure, in, inertial, inout, is, label, library, linkage, literal, 
loop, map, mod, nand, new, next, nor, not, null, of, on, open, or, others, out, package, port, postponed, 
process, pure, range, record, register, reject, rem, report, return, rol, ror, select, severity, shared, signal, 
sla, sll, sra, srl, subtype, then, to, transport, type, unaffected, units, until, use, variable, wait, when, 
while, with, xnor, xor 
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8.5. 組み合わせ回路(not、and、or) 

ここからは少しロジック設計について説明します。 
”not”、”and”、”or”などの基本論理ゲートを組み合わせて作られるものを組み合わせ回路といい、クロックを必要と

せずに現在の入力だけで出力が決まります。押しボタンスイッチと単色 LED を使って基本論理ゲートの動作を確認

します。 
 
8.5.1. 押しボタンスイッチ周辺回路 

組み合わせロジックの入力として、押しボタンスイッチを利用します。押しボタンスイッチは下記のような回路になっ

ています。単色 LED の周辺回路は"図 7-2 単色 LED 周辺回路"を参照してください。 
ボタンを押していないと”High”が FPGA に入力され、ボタンを押していると”Low”が FPGA に入力されます。 

+3.3V

FPGA

SW1SW2SW3

1kΩ

nSW0

nSW1

nSW2

 

図 8-2 押しボタンスイッチ周辺回路 

 
8.5.2. not、and、or を使う 

信号には正論理、負論理の 2 種類の表現があります。例えば、単色 LED を LE という信号名で定義

し、”High”(”1”)で点灯した場合は正論理、nLE という信号名で定義し、”Low”(“0”)で点灯した場合は、負論理とな

ります。（nLE の n は負論理だということを明言するために使います） 
LED/SW ボードには正論理、負論理の信号が混在しているので、分かりやすくするために負論理の信号は

FPGA 内部で反転させて正論理として扱うようにします。 
 
8.5.2.1. not 

負論理から正論理（正論理から負論理）は次の一文で記述できます。 

例 8-7 not 記述 

nLE0 <= not le0; 

 

 

図 8-3 not 回路と真理値表 
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8.5.2.2. and 
SW1(信号名：sw0)と SW2（信号名：sw1）を両方押したら D1（信号名：le0）が点灯するというのは以下の一文で

記述できます。 

例 8-8 and 記述 

le0 <= sw0 and sw1; 

 

 
図 8-4 and 回路と真理値表 

 
8.5.2.3. or 

SW１(信号名：sw0)か SW2(信号名：sw1)のどちらか一方でも押されたら D1(信号名：le0)が点灯するというのは

以下の一文で記述できます。 

例 8-9 or 記述 

le0 <= sw0 or sw1; 

 

 
図 8-5 or 回路と真理値表 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                             VHDL によるロジック設計 
 

106

 
8.5.2.4. not, and, or の top.vhd 

先ほど単色 LED（D1）を光らせたプロジェクトを変更して試してみてください。 

例 8-10 not、and、or（top.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
--エンティティ（入出力の宣言） 
entity top is 
  Port ( 
    nLE0 : out STD_LOGIC; --単色 LED（D1）への出力信号（負論理） 
    nSW0 : in STD_LOGIC; --スイッチ（SW1）からの入力信号(負論理) 
    nSW1 : in STD_LOGIC --スイッチ（SW2）からの入力信号(負論理) 
  ); 
end top; 
 
--アーキテクチャ（回路本体） 
architecture IMP of top is 
 
  signal le0 : STD_LOGIC; --単色 LED内部信号（正論理） 
  signal sw0 : STD_LOGIC; --スイッチ（SW1）内部信号（正論理） 
  signal sw1 : STD_LOGIC; --スイッチ（SW2）内部信号（正論理） 
 
begin 
 
  sw0 <= not nSW0; --not回路で入力前に正論理にする 
  sw1 <= not nSW1; --not回路で入力前に正論理にする 
 
  le0 <= sw0 and sw1; --and 回路（両方押したら LEDが光る） 
  --le0 <= sw0 or sw1; --or 回路（どちらか一方でも押したら LEDが光る） 
 
  nLE0 <= not le0; --not回路で出力前に負論理にする 
   
end IMP; 

 
8.5.2.5. not, and, or のピンアサイン 

ピンアサインは以下になります。 

表 8-4 not、and、or のピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nLE0 B12 E12 L16 G2 
nSW0 A13 F11 K14 G4 
nSW1 B14 C11 K15 M1 
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8.6. 順序回路 

その時点の入力だけでなく、過去の入力信号にも依存する回路を順序回路といいます。値を保持する、そのまま

出力する、といったことができます。 
順序回路は基本的に同期設計により成り立ちます。非同期設計は現在の状況に応じて物事が動き、次に何が起

こるか分からなくなるので、順序回路には向きません。もし非同期信号を使いたい場合は、通常 1 回クロックに同期さ

せてから使います。 
 

順序回路入力 出力

出力は過去の入力にも依存  
図 8-6 順序回路の概念図 

8.6.1. D-FF(D 型フリップフロップ) 
順序回路で重要なのは D‐FF です。 
クロックの立ち上がりでデータを保持し、次のクロックで保持したデータを出力します。クロックの立ち上がり以外で

データが変化しても出力は変化しません。 

CLK

D

Q

RST

D

CLK
クロック

Q

RST
リセット

入力

D-FF

出力

R

 
図 8-7 D-FF の動作 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                             VHDL によるロジック設計 
 

108

 
8.6.2. 同期設計 

回路は入力信号の時間差によって動作が決まります。非同期設計では ns 単位で時間差を作ってしまうことがあり、

タイミング設計が非常に困難です。論理合成、配置配線による信号の遅延はツールの種類やバージョンに依存しま

す。また、温度やデバイスの個体差によっても信号が遅延します。これらのすべての遅延を非同期設計で押さえ込

むのは至難の業です。押さえ込むのに失敗すると、タイミング不良を起こし、次に何が起こるのか分からなくなってし

まいます。 
それにひきかえ同期設計はタイミング設計が簡単になります。同期設計では、同期用クロックの周期時間よりもゲ

ートや配線による遅延やセットアップなどの積算時間ほうが短ければ、回路が設計通りに動作することが保障されて

います。FPGA は内部にクロック専用線を複数もっていて、これらのクロック専用線は他の線に比べて Delay が少な

く、信号が速く到達することが保障されています。 
よって、一般的に FPGA ではこのクロック専用線を用い、同期設計を行います。 

 
同期回路は組み合わせ回路と D-FF とで成り立っています。組み合わせ回路の規模を小さくすることで、遅延は

少なくなり速い回路を作ることができます。どこに D-FF を入れ、組み合わせ回路の規模どう小さくするかで、全体の

最高動作周波数が決まってきます。 
 
8.6.3. カウンタ 

順序回路の基本的な例としてカウンタを上げます。カウンタはクロックにあわせて数値をインクリメント（デクリメント）

します。カウンタの回路は以下のように記述できます。 

例 8-11 カウンタ記述 

process(SYS_CLK) --クロック信号に変化があると実行 
begin 
  if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
    if SYS_RST = '1' then –-リセットされたら（同期リセット） 
      count <= (others => ‘0’); --カウンタ初期化 
    else --その他は 
      count <= count + 1; --カウント値をインクリメント 
    end if; 
  end if; 
end process; 

 
8.6.3.1. クロックの記述 

クロックの立ち上がりエッジに同期させたい場合以下のように記述します。 SYS_CLK = ‘0’とすると立下りエッジに

同期させることができます。 

例 8-12 クロックの立ち上がりエッジに同期 

if SYS_CLK’event and SYS_CLK=’1’ then  

 
8.6.3.2. リセットの記述 

クロックの記述の下にリセットを記述すると同期リセット、上に記述すると非同期リセットになります。 
SUZAKU には電源監視 IC が実装されており、電源投入時にリセットがかかるようになっています。このリセット信

号を用いて、信号の初期化を行います。VHDL ではこの様に外部からのリセットで初期化する方法の他に内部信号

定義の時に初期化する方法もあります。 

例 8-13 同期リセット 

if SYS_CLK'event and SYS_CLK = '1' then 
  if SYS_RST = '1' then  
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8.6.3.3. if 文 

if 文は以下の形式で記述します。 

例 8-14 if 文 

if 条件 then 
  順次処理文 
elsif 条件 then 
  順次処理文 
else 
  順次処理文 
end if; 

 
 
8.6.3.4. other で初期化 
others は残りすべてという意味で、others=>’0’とすると、残っているビットすべてに 0 が代入されます。 

例 8-15 other で初期化 

count <= (others => ‘0’); 
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8.7. ISE Simulator の使い方 

HDL でコーディングをおこなったら、PC 上でシミュレーションを行います。シミュレーションはロジック設計で重要

な作業です。実際にデバイスに書き込んでからでは、各信号の挙動をとても検証しづらいですが、PC 上のシミュレ

ーションでは、信号の挙動が明快にわかります。シミュレーションで自分の考えていた通りに動作しているか確認して

から、実際のデバイスに書き込みます。 
最も基本の順序回路であるカウンタの動きを確認すると共に、ISE に含まれているシミュレータ ISE Simulator

の使い方を説明します。 
 
8.7.1. プロジェクトの新規作成 

プロジェクトを新規作成してください。プロジェクト名は slot_counter とし、[New Source]で
slot_counter.vhd とし、新規ソースコードを作ってください。 
 
8.7.1.1. slot_counter.vhd 

カウンタ回路を記述してください。今回は、4 ビットカウンタのシミュレーションを行います。4 ビットカウ

ンタでは 0 から 15 まで数えることができます。 
記述できたら Synthesize をダブルクリックして文法に間違いがないかチェックしてください。 

例 8-16 カウンタ（slot_counter.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity slot_counter is 
  generic ( 
    C_CNT_WIDTH : integer := 4 --カウンタのビット幅 
  );  
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号  
    SYS_RST : in STD_LOGIC; --リセット信号 
    count : out STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1) --カウンタ値 
  ); 
end slot_counter; 
 
architecture IMP of slot_counter is 
--内部信号の定義 
  signal count_w : STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1); --カウンタ値内部用 
begin 
 
  process(SYS_CLK) --クロック信号に変化があると実行 
  begin 
 if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
      if SYS_RST = '1' then --リセットされたら（同期リセット） 
        count_w <= (others => '0'); --カウンタ初期化 
      else  --その他は 
        count_w <= count_w + 1; --カウント値をインクリメント 
      end if; 
    end if; 
  end process; 
 
  count <= count_w; --カウンタ値を外部に出力 
 
end IMP; 
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8.7.1.2. generic 文について 

バスの幅などのパラメータを渡す時などに使います。記述形式はポート文とほぼ同じですが、情報を渡すだけなの

で、”in”や”out”などの方向の指定はありません。 

例 8-17 generic 文 

generic ( 
  信号名 : データタイプ名 := 初期値 
); 

 
 
8.7.2. テストベンチの新規作成 

カウンタの動作をシミュレーションで確認します。 
[Project]→[New Source]をクリックしてください。 
[Test Bench WaveForm]を選択し、[File name]にファイル名を入力し、[Next]をクリックしてくださ

い。ここではファイル名を slot_counter_tb とします。 
 

 
図 8-8 テストベンチ作成 

slot_counter_tb と入力 

Test Bench WaveForm を選択 
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次の画面が出るまで[Next]および[Finish]をクリックしてください。クロック波形を作成します。[Initial Length of 
Test Bench] を 10000 に変更して[Finish]をクリックしてください。[Initial Length of Test Bench]を変更すると、

シミュレーション時間を変更することができます。他にも色々設定を変えることができますが、今回はカウンタの動きを

見たいだけなので変更しません。 
 

 
図 8-9 クロック波形作成 
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次の画面が表示されます。 
Source ウィンドウの Source for:を[Behavioral Simulation]に変更してください。 
リセット信号を入力しないと信号が初期化されないので、リセット信号を入力します。クロックが細かくて見にくいの

で キーを押して適当な大きさに拡大してください。水色のセルをクリックすると信号の”High”、”Low”を切り替える

ことができます。図のように SYS_RST の信号を生成してください。100ns で信号を立ち上げ、500ns で信号を立ち

下げています。 
[File]→[Save]をクリックし保存してください。 
 
 
 

 
図 8-10 リセット波形生成 

リセット信号生成 

Behavioral Simulation に変更 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                             VHDL によるロジック設計 
 

114

 
シミュレーションの設定をします。[Simulate Behavioral Model]の上で右クリックをし、メニューで[Properties…]

を選択してください。Process Properties が表示されるので、Simulation Run Time を 10000ns に変更し、[OK]
をクリックしてください。 
 

 
図 8-11 シミュレーション設定 

 

10000ns に変更 
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8.7.3. シミュレーション実行 

Processes タブをクリックしてください。View Generated Test Bench As HDL をダブルクリックすると、自動生成

されたテストベンチを見ることができます。Xilinx ISE Simulator の をクリックして開き、Simulate Behavioral 
Model をダブルクリックしてください。シミュレーション結果が表示されます。 
 

 
図 8-12 シミュレーション結果 

● クロックについて 
sys_clk の波形を見てください。クロックは”1”、”0”を繰り返します。 

● リセットについて 
count の波形の一番初めは赤い線で u と書かれています。これは値が不定という意味です。sys_rst が”High”に

なると、初期化されて値が決定します。 
● カウンタの波形チェック 

sys_clk の立ち上がりのタイミングごとにカウントアップしているのが分かります。 
count[3]の波形の周期は sys_clk の倍、count[2]の波形の周期は count[3]の倍、count[1]の波形の周期は

count[2]の倍・・・となっています。これを分周といいます。 
 
 
 

VHDL による回路設計について、この後は必要に応じて説明していきます。 
 

0～15 のカウントを

繰り返す 

Simulate Behavioral Model をダブルクリック 

‘1’、’0’を繰り返す 

初めは値が不定 

View Generated Test Bench As HDL をダブルクリック 
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9. FPGA 入門 スロットマシン製作 
 

 
 
ここからは、本格的にロジック設計を行います。 
“5.3 ブートローダモードでスロットマシンを動かす”で動かしたスロットマシンは下図の構成で作られています。こ

れと同じスロットマシンを製作していきます。スロットマシンの機能を実現するには色々な方法が考えられるのですが、

SUZAKU のデフォルトにスロットマシンの IP コアを接続し、ソフトウェアで制御することによりスロットマシンを製作し

ています。 
本章ではまず、下図の右側の IP コアの中身を製作します。左側のソフトウェアについては後の章で説明します。 

CONFIGUART7SEGR-SWLED SW

FPGA

ソフトウェア（BRAMの中）

・7セグメントLEDに数字をデコードし
て出力する
(9.2 7セグメントLEDデコーダ)

・7セグメントLEDをダイナミック点灯さ
せる
(9.3 ダイナミック点灯)

・トリガー信号により単色LEDを順次
点灯させる
(9.1 単色LEDの順次点灯)

・押しボタンスイッチ、ロータリコードス
イッチの入力を受け取る

IPコア(opb_sil00u)

・スタート検出（押しボタンスイッチ（チャタリング除去）を2つ
以上押した時、7セグメントLEDの数字を回転させる）

・ストップ検出（押しボタンスイッチ（チャタリング除去）を1つ
押した時、それぞれ対応する7セグメントLEDの数字の回
転を停止させる）

・3つの数字一致検出（7セグメントLEDの数字が3つそろっ
たら、単色LEDを順次点灯させるトリガー信号を出力す
る）

・回転速度制御（ロータリコードスイッチの入力により、７セ
グメントLEDの数字の回転速度を変更する）

 
図 9-1 スロットマシンの構成 
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9.1. 単色 LED の順次点灯 

まず、"トリガー信号により単色 LED を順次点灯させる"の単色 LED の順次点灯の部分を製作します。 
スロットが当たった時に、当たった！という感じを出すために、単色 LED を順次点灯（D1→D2→D3→D4→D1

→・・・・）させます。 
SZ010,SZ030,SZ130,SZ310 のクロックは 3.6864MHz、SZ410 のクロックは 100MHz となっています。このクロ

ックをタイミング信号として単色 LED を順次点灯させると速すぎるので、目に見えるくらいの速さのタイミング信号を

カウンタで作ります。カウンタは先ほどシミュレーションの時に作った回路をそのまま使います。シミュレーションはビッ

ト幅 4 ビットで行います。シミュレーション後はカウンタのビット幅を SZ010、SZ030、SZ130、SZ310 の場合は 19 ビ

ットに、SZ410 の場合は 23 ビットとします。カウンタの最上位ビット count(0)の値は SZ010、SZ030、SZ130、

SZ310 の場合は 219=524288 カウントごとに(約 7Hz)、SZ410 の場合は 223=8388608 カウントごとに(約
12Hz)”0”、”1”を繰り返します。 

単色 LED を順次点灯させるのに、シフトレジスタを用います。シフトレジスタをシフトさせる一番簡単な条件は、タ

イミング信号が”0”または”1”の時、常にシフトすることです。カウンタの最上位ビットから出力される”0”、”1”はデュー

ティー比 50:50 になっていて、このままだと、一番簡単な条件でシフトレジスタを作った場合、同じレベルの間は常に

シフトし続けてしまうので使えません。このため count(0)の値が”0”から”1”になる時のエッジを検出し、1 クロックだ

け”1”を出力するタイミング信号を作ります。 
 
9.1.1. 単色 LED 周辺回路 

単色 LED 周辺回路は”図 7-2 単色 LED 周辺回路”をご参照ください。 
 

9.1.2. プロジェクト新規作成、論理合成 
プロジェクトを新規作成してください。 
プロジェクト名は le_seq_blink とし、new Source で top.vhd を作ってください。 
top – IMP(top.vhd)を右クリックしてメニューを出し、[New Source...]を選択してください。 

 

 
図 9-2 New Source の追加 
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New Source Wizard が立ち上がるので、[VHDL Module]を選択し、[File name]に le_seq_blink と入力し、新

しいソースファイルを作ってください。 
 

 
図 9-3 New Source 名前入力 

 
top – IMP(top.vhd)を右クリックしてメニューを出し、[Add Copy of Source...]を選択してください。 

 

 
図 9-4 既存のソースファイル追加 

 

le_seq_blink と入力 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                         FPGA 入門 スロットマシン製作 
 

119

 
先ほどシミュレーションで作った slot_counter.vhd を選択してください。 
下図が表示されるので、[OK]をクリックしてください。プロジェクトに slot_counter.vhd が追加されます。 

 

 
図 9-5 既存のソースファイル追加時の確認 
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9.1.2.1. le_seq_blink.vhd 

単色 LED を順次点灯させる回路を記述します。記述できたら保存して、le_seq_blink-IMP(le_seq_blink.vhd)
を選択し、Check Syntax をダブルクリックして、文法チェックをしてください。 

例 9-1 単色 LED 順次点灯（le_seq_blink.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity le_seq_blink is 
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号  
    SYS_RST : in STD_LOGIC; --リセット信号 
    le_timing : in  STD_LOGIC; --単色 LED順次点灯のタイミング信号 
    le : out  STD_LOGIC_VECTOR(0 to 3) --単色 LED出力信号 
  ); 
end le_seq_blink; 
 
architecture IMP of le_seq_blink is 
--内部信号の定義 
  signal le_w : STD_LOGIC_VECTOR(0 to 3); --単色 LED内部信号 
  signal le_tim : STD_LOGIC; --単色 LED順次点灯のタイミング内部信号 
  signal le_tim_reg : STD_LOGIC; --単色 LED順次点灯タイミング信号の 1クロック前の値 
begin 
 
  process(SYS_CLK) --クロック信号に変化があると実行 
  begin 
    if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
      if SYS_RST = '1' then --リセットされたら（同期リセット） 
        le_tim_reg <= '0'; --初期化 
      else 
        le_tim_reg <= le_timing; --1クロック前の値を保持 
      end if; 
    end if; 
  end process; 
 
  le_tim <= le_timing and (not le_tim_reg); --エッジ検出 
 
  process(SYS_CLK) --クロック信号に変化があると実行 
  begin 
    if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
      if SYS_RST = '1' then --リセットされたら（同期リセット） 
        le_w <= "0001"; --はじめに D1を光らせる 
      else 
        if le_tim = '1' then --タイミング信号の値が’1’になったら 
          le_w <= le_w(1 to 3) & le_w(0); --1bit左にシフト 
        end if; 
      end if; 
    end if; 
  end process; 
 
  le <= le_w; --外部に出力 
 
end IMP; 
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9.1.2.2. top.vhd 
top.vhd を上位階層として slot_counter と led_seq_blink の回路を呼び出します。 
カウンタのビット幅をシミュレーション用に一旦 4 ビットに設定します。実際のビット数でシミュレーションを行っても

いいのですが、LED が順次点灯する様子を見るのに、非常に長い時間かかります。今回はエッジ検出の様子とシフ

トレジスタの様子を確認したいだけなので 4 ビットにします。 
記述できたら top-IMP(top.vhd)を選択し、Synthesize をダブルクリックして、文法チェックをしてください。 
文法チェックが終わったら、top-IMP(top.vhd)の上で右クリックしメニューを出し、[Set as Top Module]を選択し

てください。 のマークがついているのが上位階層になります。 
 

 
図 9-6 上位階層に設定 

 
例 9-2 単色 LED 順次点灯（top.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity top is 
  generic (  
    C_CNT_WIDTH : integer := 4 --カウンタのビット幅(シミュレーション用) 
--    C_CNT_WIDTH : integer := 19 --カウンタのビット幅(SZ410の時は 23) 
  ); 
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号  
    SYS_RST : in STD_LOGIC; --リセット信号 
    nLE : out  STD_LOGIC_VECTOR(0 to 3) --単色 LED出力信号（負論理） 
  ); 
end top; 
 
architecture IMP of top is 
  signal count : STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1);  
  signal le : STD_LOGIC_VECTOR(0 to 3); --単色 LED内部信号 
 
  component slot_counter 
    generic (  
      C_CNT_WIDTH : integer := C_CNT_WIDTH --カウンタのビット幅  
    ); 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号  
      SYS_RST : in STD_LOGIC; --リセット信号 
      count : out STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1) --カウンタ値 
    ); 
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  end component; 
 
  component le_seq_blink 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号  
      SYS_RST : in STD_LOGIC; --リセット信号 
      le_timing : in  STD_LOGIC; --単色 LED順次点灯のタイミング信号 
      le : out  STD_LOGIC_VECTOR(0 to 3) --単色 LED出力信号 
    ); 
  end component; 
 
begin 
 
  slot_counter_0 : slot_counter    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      count => count 
    ); 
 
  le_seq_blink_0 : le_seq_blink    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      le_timing => count(0), --カウンタの最上位ビットを接続 
      le => le 
    ); 
 
  nLE <= not le; --外部に出力 
 
end IMP; 

 
 
9.1.2.3. コンポーネント文について 

上位のメイン回路から下位回路を呼び出すためには、エンティティ文の中でコンポーネントとして定義します。 

例 9-3 component 文 

  component コンポーネント名 
    Port (  
      信号名 : 入出力方向 データタイプ  
    ); 
  end component; 

 
コンポーネントの定義が終わったら、アーキテクチャ文の begin の下で呼び出します。 
下位回路のポートと信号は port map で結合します。ラベル名は、このコンポーネントにつけられる名前で、その

アーキテクチャ内でユニークな名前でなければいけません。 

例 9-4 port map 文 

  ラベル名 ： コンポーネント名 
  Port map ( 
    ポート名=>信号名 
  ); 
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9.1.3. シミュレーション 

 
単色 LED の順次点灯のシミュレーションを行います。シミュレーションの詳細は"8.7 ISE 

Simulator の使い方"を参照してください。 
[Project]→[New Source]でテストベンチ(Test Bench WaveForm)を新規作成してください。ここ

ではファイル名を le_seq_blink_tb とします。上位階層のファイルを聞かれるで、"top"を選択してくだ

さい。また、[Initial Length of Test Bench]は今回も 10000ns に変更してください。 
 
 
 
 

 
図 9-7 上位階層選択 
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SYS_ＲＳＴの信号を前回と同様（100ns で立ち上げ、500ns 立ち下げ）に生成して保存してください。 
Sources ウィンドウの[Sources for:]を[Befavioral Simulation]に変更し、le_seq_blink_tb を選択し、Process

タブをクリックし、[Simulate Behavioral Model]をダブルクリックしてください。シミュレーションが実行されます。 
このままでは確認したい波形を全てみれていないので、le_tim や le_tim_reg、le_timing、le を追加してくださ

い。追加できたらシミュレーション時間を 10000ns に変更し、[Simulation]→[Restart]、[Simulation]→[Run for 
Specified Time]をクリックしてください。 

エッジ検出やシフトの様子、LED の順次点灯の様子を確認してください。 
 

 
図 9-8 見たい信号を追加 

見たい信号をドラッグ&ドロップで追加 

10000ns に変更 
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9.1.3.1. タイミング信号生成（エッジ検出）について 

カウンタの最上位ビットの前回の値を保持し、その値と今回の最上位ビットの値が違ったならば信号を出力します。 

例 9-5 エッジ検出 

process(SYS_CLK) 
begin 
  if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
    if SYS_RST = '1' then --リセットされたら（同期リセット） 
      le_tim_reg <= '0'; --初期化 
    else 
      le_tim_reg <= le_timing; --1クロック前の値を保持 
    end if; 
  end if; 
end process; 
 
le_tim <= le_timing and (not le_tim_reg); --エッジ検出 

 

D

CLK
クロック

Q

RST
リセット

入力
D-FF

今回のデータ

R

前回のデータ

出力

 
図 9-9 エッジ検出回路 

 

 
図 9-10 エッジ検出の波形 

 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                         FPGA 入門 スロットマシン製作 
 

126

 
count(0) count(1) count(2) count(3)

0 0 0 0 

0 0 0 1 

0 0 1 0 

0 0 1 1 

0 1 0 0 

0 1 0 1 

0 1 1 0 

0 1 1 1 

1 0 0 0 

1 0 0 1 

1 0 1 0 

1 0 1 1 

1 1 0 0 

1 1 0 1 

1 1 1 0 

1 1 1 1 

 
 

図 9-11 最上位ビットの動作 

 
 

最上位ビットに注目 

最大値までカウント

したら 0 にもどって

カウントし続ける 
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9.1.3.2. シフトレジスタについて 

シフトレジスタは、記憶しているデータの桁を左右にシフトさせることができるレジスタです。左にシフトするには以

下の記述をします。 

例 9-6 シフトレジスタ 

process(SYS_CLK) --クロック信号に変化があると実行 
begin 
  if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
    if SYS_RST = '1' then --リセットされたら（同期リセット） 
      le <= "0001";  
    else 
      if le_tim = '1' then --タイミング信号の値が’1’になったら 
        le <= le(1 to 3) & le(0); --1bit左にシフト 
      end if; 
    end if; 
  end if; 
end process; 

 
9.1.3.3. &について 
&を使うと bit を連結することができます。 

例 9-7 bit 連結 

le <= le(1 to 3) & le(0); 

 

 (1 to 3) で、１ビット目から 3 ビット目までを切り出すことができます。（to で幅を設定している場合は to、

downto で幅を設定している場合は downto で切り出す）イベントが発生するたびに最上位ビットを最下位に連結

させることにより、”1”の値を順に左にシフトさせます。 

 

 
図 9-12 bit 連結 
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図 9-13 シフトレジスタの波形 

9.1.4. 再度論理合成 
シミュレーション用に 4 ビットにしていた"top.vhd"のカウンタのビット幅を 19 ビットにし、

Synthesize をダブルクリックして文法チェックしてください。 
 
9.1.5. インプリメンテーション 

単色 LED への出力信号を STD_LOGIC_VECTOR(0 to n)で定義しました。to で定義すると

MSB 側が 0 になります。この場合信号を入出力する前に、信号の MSB と LSB をひっくり返さなけ

ればいけません。VHDL のソースでひっくり返してもいいのですが、最後にピンアサインでひっくり返

します。例えば nLE0 は nLE<3>、nLE1 は nLE<2>、nLE2 は nLE<1>、nLE3 は nLE<0>にピン

アサインします。 
ピンアサインができたら、Implement Design をダブルクリックしてください。 

 
 

回路図上の信号名 nLE3 nLE2 nLE1 nLE0 
ピンアサイン nLE<0> nLE<1> nLE<2> nLE<3> 

 MSB   LSB 
 

図 9-14 ピンアサインでひっくり返す 

表 9-1 単色 LED 順次点灯ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

SYS_CLK T9 U10 C8 Y6 
SYS_RST F5 D3 A8 U3 
nLE<0> E11 A11 L13 E1 
nLE<1> D11 B11 L14 F1 
nLE<2> C12 F12 L15 F2 
nLE<3> B12 E12 L16 G2 

 

ピンアサインで 
ひっくり返す 

バスの定義は 
MSB 側がビット 0 

N

X

I

G

P

S
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9.1.6. プログラムファイル作成、コンフィギュレーション 

Generate Programming File をダブルクリックし、bit ファイルを作ってください。 
Configure Device(iMPACT)をダブルクリックし、iMPACT を立ち上げ、コンフィギュレーションして

ください。 
単色 LED が D1→D2→D3→D4→D1→・・・・と順次点灯するのを確認してください。 

 

Xi
l
in
x

S
pa
rt
a
n3
E

 
図 9-15 単色 LED 順次点灯 

 
9.1.7. バスのビットラベルについて 

MicroBlaze、PowerPCはバスアーキテクチャとしてIBMのCoreConnectを採用しています。CoreConnectのバ

スおよびレジスタビットの命名規則でMSB側がビット0に定義されています。このため、LSB側がビット0に定義されて

いる外部デバイスと比べビットラベルが逆になります。LED/SWボードも一般の外部デバイスと同じく、LSB側をビット

0に定義しています。 
本書内のVHDLソースコード内でバスの定義を行う場合、IBMのCoreConnectに合わせてMSB側をビット0にし

ています。これを外部デバイスと接続するために、FPGAのピンアサインの設定でMSBとLSBをひっくり返していま

す。 

 
図 9-16 CoreConnect のビットラベルと信号 
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9.2. 7 セグメント LED デコーダ 

7 セグメント LED に数字を表示させて回転させます。まずは数字を表示するために 7 セグメント LED のデコーダ

を作ります。デコーダを作っただけでは数字が表示できているかどうか分からないので、ここではロータリコードスイッ

チからの入力を 7 セグメント LED に表示する回路を作ります。 
 
9.2.1. ロータリコードスイッチ周辺回路 

LED/SW ボードに実装されているロータリコードスイッチは 4 ビットで 0～F までの数字を表現できます。それぞれ

1kΩの抵抗で 3.3V にプルアップされています。負論理なので内部で正論理にして使います。正論理にした場合の

それぞれの”High”（”１”）、”Low”(“0”)は”表 10-1 ロータリコードスイッチ（正論理）”のようになります。 
 

+3.3V

FPGA

F9

E9

A10

nCODE2
nCODE1

1kΩ

J1

nCODE3
nCODE0

nCODE(0)

nCODE(1)

nCODE(2)

nCODE(3)

ロータリコードSW

 
図 9-17 ロータリコードスイッチ周辺回路とピンアサイン 

表 9-2 ロータリコードスイッチ(正論理) 

数字 CODE3 CODE2 CODE1 CODE0
0 0 0 0 0 
1 0 0 0 1 
2 0 0 1 0 
3 0 0 1 1 
4 0 1 0 0 
5 0 1 0 1 
6 0 1 1 0 
7 0 1 1 1 
8 1 0 0 0 
9 1 0 0 1 
A 1 0 1 0 
b 1 0 1 1 
C 1 1 0 0 
d 1 1 0 1 
E 1 1 1 0 
F 1 1 1 1 
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9.2.2. 7 セグメント LED 周辺回路 
7 セグメント LED のセグメントは下図のように配置されていて、A~G までの各発光ダイオードの適当なものだけを

光らすと数字を表示することができます。"表 9-3 7 セグメント LED デコーダ(正論理)”と照らし合わせてどう光らせ

れば数字になるか確認してみてください。 

 
図 9-18 セグメントの配置 

表 9-3 7 セグメント LED デコーダ(正論理) 

数字 DP(SEG7) G(SEG6) F(SEG5) E(SEG4) D(SEG3) C(SEG2) B(SEG1) A(SEG0) 
0 0 0 1 1 1 1 1 1 
1 0 0 0 0 0 1 1 0 
2 0 1 0 1 1 0 1 1 
3 0 1 0 0 1 1 1 1 
4 0 1 1 0 0 1 1 0 
5 0 1 1 0 1 1 0 1 
6 0 1 1 1 1 1 0 1 
7 0 0 1 0 0 1 1 1 
8 0 1 1 1 1 1 1 1 
9 0 1 1 0 1 1 1 1 
A 0 1 1 1 0 1 1 1 
B 0 1 1 1 1 1 0 0 
C 0 0 1 1 1 0 0 1 
D 0 1 0 1 1 1 1 0 
E 0 1 1 1 1 0 0 1 
F 0 1 1 1 0 0 0 1 

 
LED/SW ボードには 7 セグメント LED が 3 つ実装されていて、Q1 に”Low”を入力すると LED１、Q2 に“Low”

を入力すると LED2、Q3 に”Low”を入力すると LED3 を扱うことができます。Q1、Q2、Q3 を同時に”Low”にするこ

とで、全部を光らすこともできますが、同じ数字しか表示することはできません。異なる数字を表示したいときはダイナ

ミック点灯という手法を用います。（"9.3 ダイナミック点灯” 参照） 
Q1～Q3 のセレクト信号は負論理、7 セグメント LED は正論理です。7 セグメント LED が正論理なのは電流を増

やすために、バッファとしてインバータが 7 セグメント LED の前に実装されているためです。 
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図 9-19 7 セグメント LED 周辺回路 
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9.2.3. プロジェクト新規作成、論理合成 

プロジェクトを新規作成してください。 
プロジェクト名は seg7_decoder とし、new Source で top.vhd を作ってください。 
top – IMP(top.vhd)を右クリックしてメニューを出し、[New Source...]を選択し、seg7_decoder.vhd

を新規作成してください。 
 

9.2.3.1. seg7_decoder.vhd 
7 セグメント LED のデコーダ回路を記述してください。記述できたら、seg7_decoder-

IMP(seg7_decoder.vhd)を選択し、Check Syntax をダブルクリックして、文法チェックをしてください。 

例 9-8 7 セグメント LED デコーダ(seg7_decoder.vhd) 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
entity seg7_decoder is 
  Port (  
    SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号 
    seg_data : in STD_LOGIC_VECTOR(0 to 3) --4bitバイナリコード 
  ); 
end seg7_decoder; 
 
architecture IMP of seg7_decoder is 
begin 
  --デコーダ記述 
  process(seg_data) 
  begin 
    case seg_data is 
      when "0000" => SEG <= "00111111"; --0 
      when "0001" => SEG <= "00000110"; --1 
      when "0010" => SEG <= "01011011"; --2 
      when "0011" => SEG <= "01001111"; --3 
      when "0100" => SEG <= "01100110"; --4 
      when "0101" => SEG <= "01101101"; --5 
      when "0110" => SEG <= "01111101"; --6 
      when "0111" => SEG <= "00100111"; --7 
      when "1000" => SEG <= "01111111"; --8 
      when "1001" => SEG <= "01101111"; --9 
      when "1010" => SEG <= "01110111"; --A 
      when "1011" => SEG <= "01111100"; --b 
      when "1100" => SEG <= "00111001"; --C 
      when "1101" => SEG <= "01011110"; --d 
      when "1110" => SEG <= "01111001"; --E 
      when "1111" => SEG <= "01110001"; --F 
      when others => SEG <= "XXXXXXXX"; --0,1以外（X,Z,U等）の場合 
    end case; 
  end process; 
end IMP; 
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9.2.3.2. case 文について 

case 文は次の書式で記述します。"例 9-8 7 セグメント LED デコーダ(seg7_decoder.vhd)"をみると 
when others => SEG <= "XXXXXXXX"という記述があります。std_logic_vector は'0'、'1'の他に'X'や'Y'、'U'

などの値を持っているため、残り全てを記述するために"XXXXXXXX"(出力不定)としています。 

例 9-9 case 文 

case 式 is 
  when 値 => 順次処理文 
  when others => 順次処理文 
end case; 

 
9.2.3.3. top.vhd 

top.vhd を上位階層として seg7_decoder の回路を呼び出します。記述できたら top-IMP(top.vhd)を選択し、

Synthesize をダブルクリックして、文法チェックをしてください。 
文法チェックが終わったら、top-IMP(top.vhd)の上で右クリックしメニューを出し、[Set as Top Module]を選択し、

top.vhd を上位階層としてください。 
 

例 9-10 7 セグメント LED デコーダ（top.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity top is 
  Port (  
    nCODE : in STD_LOGIC_VECTOR(0 to 3); --ロータリコードスイッチからの入力信号（負論理） 
    SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号（正論理） 
    nSEL : out STD_LOGIC_VECTOR(0 to 2) --7セグメント LEDセレクト信号（負論理） 
    ); 
  end top; 
 
architecture IMP of top is 
  signal code : STD_LOGIC_VECTOR(0 to 3); --ロータリコードスイッチ内部信号（正論理） 
  signal sel : STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト内部信号（正論理） 
 
  component seg7_decoder 
    Port (  
      SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号 
      seg_data : in STD_LOGIC_VECTOR(0 to 3) --4bitバイナリコード 
    ); 
  end component; 
 
begin 
  seg7_decoder_0 : seg7_decoder    
    Port map( 
      SEG => SEG, 
      seg_data => code  
    ); 
  sel <= "001"; --7セグメント LED1を点灯させる 
  nSEL <= not sel; --負論理にして出力 
  code <= not nCODE; --正論理にして入力 
 
end IMP; 
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9.2.4. シミュレーション 

デコーダのシミュレーションを行います。シミュレーションの詳細は"8.7 ISE Simulator の使い方"
を参照してください。 

[Project]→[New Source]でテストベンチ(Test Bench WaveForm)を新規作成してください。ここで

はファイル名を seg7_decoder_tb とします。上位階層のファイルを聞かれるで、"top"を選択してくださ

い。、[Initial Length of Test Bench]は 2000ns に変更してください。 
ロータリコードスイッチの値を設定します。nCODE の波形の上で左クリックすると Set Value というウ

ィンドウが出てきます。[Pattern Wizard]をクリックして下さい。Pattern Wizard が立ち上がります。 
Pattern Type を[Count Down]、Number of Cycle を[16]、Initial Value を[15]、Terminal Value
を[0]、Decrement By を[1]、Count Every を[1]にして[OK]をクリックして下さい。15 から 0 までの波形が自動で

生成されます。うまく生成されたら保存をして下さい。 
 

 
図 9-20 波形生成 

 

 
図 9-21 Pattern Wizard 

 

 
図 9-22 Pattern Wizard 
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Sources ウィンドウのの[Sources for:]を[Befavioral Simulation]に変更し、seg7_decoder_tb を選択し、

Process タブをクリックし、[Simulate Behavioral Model]をダブルクリックしてください。シミュレーションが実行され

ます。 
ロータリコードスイッチ nCODE は負論理の信号で top.vhd で正論理の信号 code にしています。負論理のまま

では何がデコードされているのか分かりにくいので、正論理の信号 code を追加します。追加できたら[Simulation]
→[Restart]、[Simulation]→[Run All]をクリックしてください。 

ロータリコードスイッチの値がきちんとデコードされて 7 セグメント LED に渡されているのか確認します。それぞれ

値が Decimal で表示されています。このままではデコードされた結果が何か分からないので、波形の上で右クリック

し、表示を Hexadecimal に変更してください。 
"表 9-2  ロータリコードスイッチ(正論理)"、"表 9-3 7 セグメント LED デコーダ(正論理)"を参照してデコードさ

れた結果が正しいか確認してください。 

 

 
 

図 9-23 デコーダシミュレーション結果 

code[0:3]を追加 

右クリックして Hexadecimal に変更 

code が 0 の時 seg は 00111111 
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9.2.5. インプリメンテーション 

信号を STD_LOGIC_VECTOR(0 to n)で定義しているので、MSB 側がビット 0 になります。信

号は最後にピンアサインでひっくり返しています。例えば nCODE0 は nCODE<3>、nCODE1 は

nCODE<2>、nCODE2 は nCODE<1>、nCODE3 は nCODE<0>にピンアサインします。ピンアサインが

できたら、Implement Design をダブルクリックしてください。 

表 9-4 ７セグメント LED デコーダ ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nCODE<0> C8 J1 J16 H5 
nCODE<1> A9 F9 J15 E2 
nCODE<2> A12 E9 J14 D2 
nCODE<3> C10 A10 J13 U9 

SEG<0> C5 L5 F15 P1 
SEG<1> B5 L6 F16 P2 
SEG<2> E6 L4 G13 L2 
SEG<3> D6 L3 G14 M2 
SEG<4> C6 L2 G15 N2 
SEG<5> B6 L1 G16 N3 
SEG<6> A8 C9 N9 Y7 
SEG<7> B8 D9 P9 W7 
nSEL<0> D7 K6 H13 N5 
nSEL<1> C7 K4 H14 M3 
nSEL<2> B7 K3 H15 M4 

 
9.2.6. プログラムファイル作成、コンフィギュレーション 

Generate Programming File をダブルクリックし、bit ファイルを作ってください。 
Configure Device(iMPACT)をダブルクリックし、iMPACT を立ち上げ、コンフィギュレーションしてください。 
ロータリコードスイッチをまわすと、対応する数字が 7 セグメント LED（LED1）に表示されます。 

X
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x
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n3
E

ロータリコードスイッチをまわすと
それがLED１に表示される  

図 9-24 ７セグメント LED デコーダ 
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9.3. ダイナミック点灯 
3 つの 7 セグメント LED をダイナミック点灯させます。 
ダイナミック点灯とは配線の本数を減らすための手法です。複数の 7 セグメント LED に同じデータ線を接続して

います。7 セグメント LED を順次点灯することにより、複数の 7 セグメント LED が同時に点灯しているように見せま

す。 

3
LED1LED2LED3

1

0

Q1 選択

Q2 選択

Q3 選択

繰り返す

 
図 9-25 7 セグメント LED ダイナミック点灯 

9.3.1. 7 セグメント LED 周辺回路 
ダイナミック点灯に必要となる 7 セグメント LED 周辺回路は”図 9-19 7 セグメント LED 周辺回路”を参照してく

ださい。 
 
9.3.2. プロジェクト新規作成、論理合成 

プロジェクトを新規作成してください。 
プロジェクト名は dynamic_ctrl とし、new Source で top.vhd を作ってください。 
top – IMP(top.vhd)を右クリックしてメニューを出し、[New Source...]を選択し、dynamic_ctrl.vhd

を新規作成してください。 
top-IMP(top.vhd)を右クリックしてメニューを出し、[Add Copy of Source...]を選択し、

slot_counter.vhd、seg7_decoder.vhd を追加してください。 
top-IMP(top.vhd)の上で右クリックしメニューを出し、[Set as Top Module]を選択し、top.vhd を

上位階層としてください。 
 
9.3.2.1. dynamic_ctrl.vhd 

ダイナミック点灯させる回路を記述してください。記述できたら、dynmic_ctrl-IMP(dynamic_ctrl.vhd)を選択し、

Check Syntax をダブルクリックして、文法チェックをしてください。 

例 9-11 ダイナミック点灯(dynamic_ctrl.vhd) 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity dynamic_ctrl is 
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号 
    SYS_RST : in STD_LOGIC; --リセット信号 
    nSEL : out STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号（負論理） 
    seg7_timing : in  STD_LOGIC; --ダイナミック点灯タイミング信号 
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    seg_in1 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED1の値 
    seg_in2 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED2の値 
    seg_in3 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED3の値 
    seg_data : out  STD_LOGIC_VECTOR(0 to 3) --4bitバイナリコード 
  ); 
end dynamic_ctrl; 
 
architecture IMP of dynamic_ctrl is 
 
  signal sel : STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号（正論理） 
  signal seg7_tim : STD_LOGIC; --ダイナミック点灯タイミング信号 
  signal seg7_tim_reg : STD_LOGIC; --1クロック前の値 
 
begin 
  process(SYS_CLK) 
  begin 
    if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
      if SYS_RST = '1' then --リセットされたら（同期リセット） 
        seg7_tim_reg <= '0'; --初期化 
      else 
        seg7_tim_reg <= seg7_timing; --値を保持 
      end if; 
    end if; 
  end process; 
 
  seg7_tim <= seg7_timing and (not seg7_tim_reg); --エッジ検出 
 
  process(SYS_CLK) --クロック信号に変化があると実行 
  begin 
    if SYS_CLK'event and SYS_CLK = '1' then --クロックの立ち上がりに同期 
      if SYS_RST = '1' then --リセットされたら（同期リセット） 
        sel <= "001"; --はじめに７セグメント LED１を光らせる 
      else 
        if seg7_tim = '1' then --7セグ用タイミング信号の値が’1’になったら 
          sel <= sel(1 to 2) & sel(0); --1bit左にシフト 
        end if; 
      end if; 
    end if; 
  end process; 
 
  --セレクト信号により代入する数字を変え,外部に出力 
  seg_data <= seg_in1 when sel = "001" else seg_in2 when sel = "010" else seg_in3; 
  nSEL <= not sel; --負論理に直して出力 
 
end IMP; 
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9.3.2.2. top.vhd 

今回は約 1kHz で表示する 7 セグメント LED を切り替えます。そのためにカウンタの 8 ビット目のエッジを取りま

す。top.vhd を上位階層として slot_counter、seg7_decoder、dynamic_ctrl の回路を呼び出します。記述できたら

top-IMP(top.vhd)を選択し、Synthesize をダブルクリックして、文法チェックをしてください。 

例 9-12 ダイナミック点灯（top.vhd） 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity top is 
  generic (  
    C_CNT_WIDTH : integer:= 19 --カウンタのビット幅 (SZ410の場合は 23) 
  ); 
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号 
    SYS_RST : in STD_LOGIC; --リセット信号 
    nSEL : out  STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号（負論理） 
    SEG : out  STD_LOGIC_VECTOR(0 to 7) --7セグメント LEDへの出力信号（正論理） 
  ); 
end top; 
 
architecture IMP of top is 
  signal seg_in1 : STD_LOGIC_VECTOR(0 to 3); --7セグメント LED1の値 
  signal seg_in2 : STD_LOGIC_VECTOR(0 to 3); --7セグメント LED2の値 
  signal seg_in3 : STD_LOGIC_VECTOR(0 to 3); --7セグメント LED3の値 
  signal seg_data : STD_LOGIC_VECTOR(0 to 3); --4bitバイナリコード 
  signal count : STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1); --カウンタ値 
 
  component slot_counter 
    generic (  
      C_CNT_WIDTH : integer := C_CNT_WIDTH --カウンタのビット幅  
    ); 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号 
      SYS_RST : in STD_LOGIC; --リセット信号 
      count : out STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1) --カウンタ値 
    ); 
  end component; 
 
  component dynamic_ctrl 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号 
      SYS_RST : in STD_LOGIC; --リセット信号 
      nSEL : out STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号（負論理） 
      seg7_timing : in  STD_LOGIC; --ダイナミック点灯タイミング信号 
      seg_in1 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED1の値 
      seg_in2 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED2の値 
      seg_in3 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED3の値 
      seg_data : out  STD_LOGIC_VECTOR(0 to 3) --4bitバイナリコード 
    ); 
  end component; 
 
  component seg7_decoder 
    Port (  
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      SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号 
      seg_data : in STD_LOGIC_VECTOR(0 to 3) --4bitバイナリコード 
    ); 
  end component; 
 
begin 
  slot_counter_0 : slot_counter    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      count => count 
    ); 
 
  dynamic_ctrl_0 : dynamic_ctrl    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      nSEL => nSEL, 
      seg7_timing => count(8), --8ビット目 
      seg_in1 => seg_in1, 
      seg_in2 => seg_in2, 
      seg_in3 => seg_in3, 
      seg_data => seg_data 
    ); 
 
  seg7_decoder_0 : seg7_decoder    
    Port map( 
      SEG => SEG, 
      seg_data => seg_data 
    ); 
 
  seg_in1 <= "0000"; --0を表示 
  seg_in2 <= "0001"; --1を表示 
  seg_in3 <= "0011"; --3を表示 
 
end IMP; 
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9.3.3. シミュレーション 

シミュレーションの説明はいたしませんので、各自シミュレーションしてみてください。シミュレーション

の詳細は"8.7 ISE Simulator の使い方"を参照してください。下図のシミュレーション結果は、カウン

タの値を 12 にしてシミュレーションを行った結果です。 
 

 
図 9-26 ダイナミック点灯シミュレーション結果 

9.3.4. インプリメンテーション 
 “表 2-1 クロック、リセット信号 ピンアサイン”、”表 2-2 機能用ピンアサイン”を参照しピンアサインしてください。 
今回ここにはピンアサインを載せないので、各自考えてください。どうしても分からない場合は付属 CD-ROM

の”¥suzaku-starter-kit¥fpga”の中の”dynamic_ctrl.zip”を展開し、その中にある”top.ucf”を参照してください。 
ピンアサインができたら、Implement Design をダブルクリックしてください。 

 
9.3.5. プログラムファイル作成、コンフィギュレーション 

Generate Programming File をダブルクリックし、bit ファイルを作ってください。 
Configure Device(iMPACT)をダブルクリックし、iMPACT を立ち上げ、コンフィギュレーションしてください。 
7 セグメント LED に”3”、”1”、”0”と表示されます。他の数字も表示してみてください。 
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図 9-27 ダイナミック点灯 
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10. EDK の使い方 
 

 
 
SUZAKU のデフォルトは EDK(Embedded Development Kit)で構築されており、SUZAKU を使いこなすに

は EDK を使えなければいけません。EDK は Xilinx が提供する組み込み機器開発環境で、プロセッサや周辺ペリ

フェラルのソースコードやライブラリが登録されており、それらを GUI 環境下で構築、設定できます。ユーザで作った

IP（Intellectual Property）コアも登録することができます。また、ソフトウェアのコンパイラやライブラリが登録されて

おり、C 言語による開発も行うことができます。ISE の機能を取り込んでいるので、論理合成、マッピングを行うことが

でき、生成されたバイナリファイルを任意の BRAM にいれて、コンフィギュレーションファイルの生成を行うこともでき

ます。 
ここでは一旦スロットマシンと離れ、EDK の使い方を説明します※。EDK の使い方の詳細は EDK のヘルプ等を

参照してください。EDK には日本語のマニュアルも用意されています。 
なお、本書では EDK において以下の手順で作業を行います。 

 
図 10-1 本書での EDK 開発フロー

                                                  
※本書では EDK8.1i を使用しています。 
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10.1. BSB ではじめての MicroBlaze & PowerPC 
まずは EDK に慣れるため、何もない状態からプロセッサが動くプロジェクトを作成します。EDK には BSB(Base 

System Builder)というウィザードが用意されています。BSB を用いることで、プロセッサが動くプロジェクトを簡単に

作ることができます。ここでは BSB を使ってシリアル通信用ソフトウェアの画面に Hello SUZAKU と表示するプロジ

ェクトを以下のような構成で作ります。 
 
 

 
図 10-2 Hello SUZAKU プロジェクト(MicroBlaze) 

 

 
図 10-3 Hello SUZAKU プロジェクト(PowerPC) 
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10.1.1. BSB 

 
Platform Studio を起動してください。Platform Studio は"EDK のインストールフォルダ

¥bin¥nt¥_xps.exe"から起動できます。もしくは、[スタートメニュー]→[全てのプログラム]→
[Xilinx Platform Studio x.xi]→[Xilinx Platform Studio]から起動できます。 

以下のような図が表示されるので、[Base System Builder wizard]を選択して[OK]をクリッ

クして下さい。もし表示されなかった場合は[File]→[New Project...]をクリックして下さい。 
 

 
図 10-4 BSB 選択 

プロジェクトファイルの保存場所を聞かれます。ここでは"C:¥suzaku¥sz***¥system.xmp"(***は型式)とします。

設定ができたら、[OK]をクリックして下さい。 
 

 
図 10-5 BSB ファイル保存 
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新しいデザインをはじめるので、[I would like to create a new design]を選択し、[Next]をクリックして下さい。 
 

 
図 10-6 新しいデザインをはじめる 
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ターゲットとなるボードの選択を行ないます。1 から全てカスタムで作るので、[I would like to create a system 

for a custom board]を選択し、[Next]をクリックして下さい。 
 

  
図 10-7 ターゲットボードの選択 
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FPGA とプロセッサの選択画面が表示されます。FPGA は、お使いの SUZAKU の型式の設定にしてください。

SZ010,SZ030,SZ130 の場合 CPU は MicroBlaze を選択してください。SZ310 の場合はどちらを選択してもかま

いません。選択できたら、[Next]をクリックしてください。 
 

型式 SZ010 SZ030 SZ130 SZ310 SZ410 
Architecture spartan3 spartan3e virtex2p virtex４ 
Device xc3s400 xc3s1000 xc3s1200e xc2vp4 xc4vfx12 
Package ft256 fg320 fg256 sf363 
Speed grade －4 －5 －10 

 
 

 
図 10-8 FPGA とプロセッサの設定 

SZ310, SZ410 の場合 
PowerPC でも可 
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MicroBlaze もしくは PowerPC の設定を行ないます。 

10.1.1.1. MicroBlaze の場合の設定 
SZ010、SZ030、SZ130、SZ310 のクロックは 3.6864MHz なので、Reference clock frequency を 3.6864MHz

に設定してください。Processor-Bus clock frequence は SUZAKU のデフォルトにならって、51.61MHz とします。

(この値は SZ010 でクロックに何も制約をかけなかった場合の最大値です。) 
SZ410 のクロックは 50MHz なので、Reference clock frequency を 50MHz とし、Processor-Bus clock 

frequence を 87.5MHz としてください。 
Reset polarity は Active High に設定してください。デバッガは今回使わないので No debug をチェックしてく

ださい。設定ができたら[Next]をクリックして下さい。 
 

 
図 10-9 MicroBlaze の設定 

SZ010, SZ030, SZ130,SZ310 の場合 
3.6864MHz 
SZ410 の場合 
100MHz 

SZ010, SZ030, SZ130,SZ310 の場合 
51.61MHz 
SZ410 の場合 
87.5MHz 
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10.1.1.2. PowerPC の場合の設定 

SZ310 の場合クロックは 3.6864MHz なので、Reference clock frequency を 3.6864MHz に設定してください。

Processor-Bus clock frequence は 29.49MHz とし、Bus clock frequency は 29.49MHz とします。 
SZ410 の場合クロックは 100MHz なので、Reference clock frequency を 100MHz に設定してください。

Processor-Bus clock frequence は 300MHz とし、Bus clock frequency は 100MHz とします。 
Reset polarity は Active High に設定してください。デバッガは今回使わないので No debug をチェックしてく

ださい。設定ができたら[Next]をクリックして下さい。 
 
 

 
図 10-10 PowerPC の設定 

SZ310 の場合 SZ410 の場合
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I/O デバイスのコアの追加画面が表示されます。シリアルを使うので、UART のコアを追加します。[Add Device]

をクリックして下さい。Add Device ウィンドウが出るので、IO Interface Type で[UART]を選択し、[OK]をクリックし

て下さい。 
 

 
図 10-11 I/O デバイスの選択 
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以下のように UART が追加されます。Baudrate を[115200]に変更し、Use Parity のチェックをはずし、[Next]

をクリックして下さい。 
 

 
図 10-12 I/O デバイスの選択追加 

115200 に変更 
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ここでは周辺回路を追加できますが、何も追加しません。そのまま[Next]をクリックして下さい。 

 

  
 

図 10-13 周辺回路の選択追加 

MicroBlaze の場合 PowerPC の場合 
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ソフトウェアの標準入出力とサンプルアプリケーションの選択画面が表示されます。今回は必要ないので、両方とも

チェックをはずし、[Next]をクリックして下さい。 
 

 
図 10-14 ソフトウェアに関する設定 
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これまでに設定した項目が下図のように表示されます。PowerPC の場合は BRAM の Base Addr が

0xFFFFC000 であることを確認し、[Generate]をクリックしてください。 
 

 
 

図 10-15 設定の確認(MicroBlaze) 
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図 10-16 設定の確認(PowerPC) 
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以下のように生成されたファイルが表示されます。生成されたファイルを確認し、[Finish]をクリックして下さい。 

 

 
図 10-17 システムの生成完了 
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[Start using Platform Studio]を選択して、[OK]をクリックして下さい。 
 

 
図 10-18 XPS に戻る 

 
以下のような構成で自動生成されます。 
 

 
図 10-19 XPS の表示 
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10.1.2. XPS ハードウェア設定 
10.1.2.1. DCM の設定 

デジタルクロックマネージャ(DCM)で SUZAKU の 3.6864MHz を 14 倍の 51.6096MHz
にしています(PowerPC の場合は 29.49MHz)。自動生成された接続だと、CLK0 から

CLKFB に信号がフィードバックするように接続されています。このフィードバックは CLKFX の

みを使用する場合は必要ないので、未接続に変更します。Ports を選択し、dcm_0 の をクリッ

クし開いてください。CLK0 と CLKFB の Net の部分をクリックし、 をクリックし、[No 
Connection]を選択し、欄外をクリックして確定させてください。これで未接続になります。 

No Connection にする詳細な理由は後述の Tips を参照してください。 
 

 
図 10-20 DCM の変更 

No Connection にする 
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TIPS  DCM について 

 
DCM は遅延ロックループ(DLL)、デジタル周波数合成(DFS)、位相シフト(Phase Shifter)、ステータスロジックの

4 つのユニットで構成されていて、これらは独立、または互いに関連して動作します。 
DLL   ： クロック出力信号の伝搬遅延がゼロになるようにスキュー調整を行う。 
     2 逓倍クロック、クロック分周、1/4 位相シフト出力を生成できる。 
DFS   ： 自分で設定した 2 つの整数により、逓倍、分周したクロックを生成できる。 
Phase Shifter  ： CLKIN 入力に対するクロック出力の移動関係を制御する。 
ステータスロジック ： DCM の現在の状態を出力する。 
 

DFS

OutputDelay

DLL

DCM

CLKIN

CLKFB

CLK0
CLK90
CLK180
CLK270
CLK2X
CLK2X180
CLKDV

CLKFX

CLKFX180
CLKIN

DLLの
機能

DFSの
機能

 
図 10-21 DCM の一部 

 
3.6864MHz を 14 倍して 51.6096MHz(PowerPC の場合は 29.49MHz)にするには DFS の機能を使います。

DLL、DFS の CLKIN へ入力できるクロック周波数はそれぞれ以下の表のとおりです。しかし、自動生成された接

続だと CLK0 を使用していて DLL の機能まで使ってしまっています。DLL の機能を使うと、3.6864MHz は範囲

外になり入力できなくなってしまいます。フィードバックは必要ないというのと、正常に動作しなくなるという理由で

CLK0 と CLKFB を No Connection に変更しています。 
 

表 10-1 入力できるクロック周波数 

型式 SZ010 SZ030 SZ130 SZ310 
DLL(MHz) 18~280 5~200 24~180 
DFS(MHz) 1~280 0.2~333 1~210 
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10.1.2.2. ピンの設定 

External Ports の をクリックして開いてください。fpga_0_RS232_req_to_send_pin は使わないので、右クリッ

クをしてメニューを出し、Delete External Port を選択して、削除してください。 
 

 
図 10-22 RS232 のピンを削除 

削除する 
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Project タブをクリックし、UCF File: data/system.ucf をダブルクリックして開いてください。ピンアサインを設定し

ます。sys_clk_pin、sys_rst_pin、fpga_0_RS232_RX_pin、fpga_0_RS232_TX_pin をそれぞれピンアサインし

てください。それぞれコメントアウトした記述があると思います。記述できたら[File]→[Save]をクリックし、保存してくだ

さい。 

表 10-2 ピンアサイン(system.ucf) 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

sys_clk_pin T9 U10 C8 Y6 
sys_rst_pin F5 D3 A8 U3 
fpga_0_RS232_RX_pin E2 C12 C10 Y4 
fpga_0_RS232_TX_pin E4 A13 C9 U4 

 

 
Net sys_clk_pin LOC=U10 | IOSTANDARD = LVCMOS33 ; 
Net sys_rst_pin LOC=D3 | IOSTANDARD = LVCMOS33 ; 
## System level constraints 
Net sys_clk_pin TNM_NET = sys_clk_pin; 
TIMESPEC TS_sys_clk_pin = PERIOD sys_clk_pin 271267 ps; 
Net sys_rst_pin TIG; 
 
## IO Devices constraints 
 
#### Module RS232 constraints 
 
# Net fpga_0_RS232_req_to_send_pin LOC=; 
Net fpga_0_RS232_RX_pin LOC=C12 | IOSTANDARD = LVCMOS33 ; 
Net fpga_0_RS232_TX_pin LOC=A13 | IOSTANDARD = LVCMOS33 ; 

 

図 10-23 SZ130 の場合のピンアサイン(system.ucf) 
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10.1.3. XPS アプリケーション作成 

Hello SUZAKU と表示するアプリケーションを作成します。 
Applications のタブをクリックしてください。 
Add Software Application Project を右クリックし、Add Software Application Project を

クリックして下さい。ウィンドウが立ち上がるので、Project Name に hello-suzaku と入力し、

[OK]をクリックして下さい。 
 

 
図 10-24 hello-suzaku 作成 
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右クリックして、Add Software Application Project を選択 

プロジェクトの名前入力 
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Project: hello-suzaku ができるので、Sources の上で右クリックし、Add New files を選択しください。その場に

直接プログラムを置いてもいいのですが、ファイルがたくさんになると分かりにくくなるので、フォルダを 1 つ作成しま

す。hello-suzaku というフォルダを作成し、その中に main.c というファイルを作ってください。 
 

 
図 10-25 main.c 作成 
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Sources の下に追加されるので main.c をダブルクリックして開き、Hello SUZAKU と表示するプログラムを記述

してください。記述できたら[File]→[Save]を選択し、保存してください。 
Project : hello-suzaku を右クリックして、Mark to Initialize BRAMs をクリックして下さい。 
チェックマークがつき、Project : hello-suzaku の横のアイコンが に変わります。これで hello-suzaku が

BRAM に初期値として書き込まれるようになります。 
microblaze_0_bootloop は書き込まないので、Default : microblaze_0_bootloop を右クリックして、Mark to 

Initialize BRAMs をクリックして下さい。チェックマークが消え、Project : BBoot の横のアイコンが に変わります。 
 
 

 

#include <stdio.h> 
int main(void) 
{ 
  print("Hello SUZAKU¥r¥n"); 
  return 0; 
｝ 

図 10-26 Hello SUZAKU のソースコード(main.c) 
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PowerPC の場合はリンカースクリプトの設定が必要となります。Project:hello-suzaku の部分をダブルクリックし

て下さい。Use Default Linker Script をチェックし、Program Start Address に 0xFFFFC000 と入力して[OK]
をクリックして下さい。0xFFFFC000 は BRAM の Base Address で、プログラムが BRAM から始まるように設定さ

れます。 
 

 

 
 

図 10-27 リンカースクリプトの設定(PowerPC) 

0xFFFFC000 と入力 

ダブルクリック 
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10.1.4. プログラムファイルを作成してコンフィギュレーション 

[Device Configuration]→[Update Bitstream] をクリックしてください。bit ファイルが

生成されます。 
 

 
 
 

図 10-28 bit ファイル作成 

 
 
 

シリアル通信用ソフトウェアを立ち上げ、シリアル通信の設定を行ってください。 
（"5.2 シリアル通信ソフトウェア" 参照） 
SUZAKU JP2 をショートし、SUZAKU CON7 にダウンロードケーブルを接続してください。 
LED/SW CON7 にシリアルケーブルを接続してください。 
最後に LED/SW CON6 に AC アダプタ 5V を接続し、電源を投入してください。 

 

 
図 10-29 ジャンパの設定等 

JP2 ショート 

電源投入 

ダウンロードケーブル接続 シリアルケーブル接続 
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[Device Configuration]→[Download Bitstream] をクリックしてください。バッチモード

の iMPACT を使用して FPGA に bit ファイルがコンフィギュレーションされます。 
シリアル通信ソフトウェアに下図のように表示されたら成功です。 

 

 
図 10-30 書き込み成功例 

 
かなり簡単に MicroBlaze を動かすことが出来ました。EDK の感触はつかめたでしょうか。今つくった Hello 

SUZAKU プロジェクトを踏まえて次の SUZAKU のデフォルトを見てみてください。 
 

 
 
TIPS  フラッシュメモリに書き込む bit ファイル 

 
このままの設定だと、フラッシュメモリに書き込める bit ファイルを生成することが出来ません。フラッシュメモリに書

き 込 む bit フ ァ イ ル を 作 る 場 合 は bitgen.ut フ ァ イ ル を 開 き 、 -g StartUpCLK:JTAGCLK を -g 
StartUpClk:CCLK に変更してください。 

 

 
図 10-31 bitgen.ut の変更 

#-g StartUpClk:JTAGCLK 
-g StartUpClk:CCLK 
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10.2. SUZAKU のデフォルト 

SUZAKU のデフォルトを説明します。 
付属 CD-ROM の”¥suzaku¥fpga_proj¥x.x¥sz***¥sz***-yyyymmdd.zip”をハードディスクに展開してくださ

い。ここでは展開後のフォルダを ”C:¥suzaku”の下にコピーします。 ”C:¥suzaku¥sz***-yyyymmdd”の中

の”xps_proj.xmp”をダブルクリックして開いてください。Platform Studio が起動し、SUZAKU のデフォルトが開き

ます。Platform Studio は"EDK のインストールフォルダ¥bin¥nt¥_xps.exe"もしくは[スタートメニュー]→[すべて

のプログラム]→[Xilinx Platform Studio x.x]→[Xilinx Platform Studio]から起動できます。 
 

 
図 10-32 XPS 起動 

IP コア 
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10.2.1. SZ010, SZ030 の構成 

 
図 10-33 SZ010、SZ030 のデフォルト（EDK） 
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図 10-34 SZ010、SZ030 デフォルトのブロック図 
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10.2.2. SZ130 の構成 

 
図 10-35 SZ130 のデフォルト（EDK） 
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図 10-36 SZ130 デフォルトのブロック図 
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10.2.3. SZ310 の構成 

 
図 10-37 SZ310 のデフォルト（EDK） 
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図 10-38 SZ310 デフォルトのブロック図 
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10.2.4. SZ410 の構成 

 

図 10-39 SZ410 のデフォルト（EDK） 

 
図 10-40 SZ410 デフォルトのブロック図 
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10.2.5. IP コア 

SUZAKU の FPGA で使用しているＩＰコアについて説明します。SUZAKU はプロセッサ、バス、FPGA 内部メ

モリ、外部メモリコントローラ、LAN コントローラ、割り込みコントローラ、タイマ、シリアル、GPIO、クロックの IP コアを

使用しています。 
 
10.2.5.1. プロセッサ (microblaze, PPC405) 

SZ010,SZ030,SZ130 ではソフトプロセッサの MicroBlaze を、SZ310,SZ410 ではハードプロセッサの

PowerPC を使用しています。 
 

MicroBlaze ・32bitRISC プロセッサ 
・32bit 固定長命令 
・32 個の汎用 32bit レジスタ 
・MMU なし 
・命令キャッシュとデータキャッシュ 
・ハードウェア乗算器 
・ハードウェアデバッグロジック対応 
・ペリフェラルバス OPB(CoreConnect) 

PowerPC ・32bitRISC プロセッサ 
・32bit 固定長命令 
・32 個の汎用 32bit レジスタ 
・MMU あり 
・命令キャッシュとデータキャッシュ 
・ハードウェア乗算器 
・ハードウェアデバッグロジック対応 
・ペリフェラルバス PLB(CoreConnect) 

 
10.2.5.2. バス (lmb_v10, opb_v20, plb_v34) 

SZ010,SZ030,SZ130 は LMB と OPB で構成しています。LMB は MicroBlaze と BRAM を接続する専用バ

スです。OPB はシリアルやタイマなどの IP コアを接続するのに使用しています。 
SZ310,SZ410 は OPB と PLB で構成しています。OPB はシリアルやタイマなどの IP コアを接続するのに使用

し て い ま す 。 PLB は PowerPC と BRAM の 接 続 お よ び SDRAM Controller(SZ310) 、 DDR2 
Controller(SZ410)、ＰＬＢ EMC（SZ310）、PLB TEMAC(SZ410)を接続するのに使用しています。なお、OPB と

PLB はブリッジにより接続しています。 
 
10.2.5.3. FPGA 内部メモリ BRAM (bram_block) 

FPGA は内部メモリに BRAM を持っています。SZ010,SZ030,SZ130 ではプロセッサのプログラムを置く容量を

8ｋByte に、SZ310,SZ410 では 16kByte に設定しています。これは設定できる最小の容量となっているので、適宜

増やしてお使いください。ただ、プロセッサのプログラムを置く容量を多く設定しすぎるとキャッシュやその他のユーザ

が設定できる RAM や FIFO の容量が減ってしまうため、分配の際には注意が必要となります。 
また、BRAM には FPGA のコンフィギュレーション時に初期値を書き込むことが出来ます。SUZAKU では

BRAM に初期値としてブートローダ BBoot("11.4.7 BBoot 編集"参照)を書き込んでいます。BBoot が終わり、次

のプログラム（ブートローダ Hermit や Linux）が起動した後は、SZ010,SZ030,SZ130 では、最初の 32Byte 以外、

SZ310,SZ410 では全領域をユーザプログラムが使用することも可能です。 
BRAM とバ スを接続するために SZ010,SZ030,SZ130 で は lmb_bram_if_cntlr 、SZ310,SZ410 では

plb_bram_if_cntlr というコントローラを使用しています。 
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10.2.5.4. 外部メモリコントローラ (opb_emc, opb_sdram, mch_opb_sdram, plb_emc, plb_sdram) 

 
外部メモリコントローラとして、SZ010,SZ030,SZ130 では OPB EMC と OPB SDRAM、SZ310 では PLB EMC

と PLB SDRAM を使用しています。OPB EMC、PLB EMC はフラッシュメモリと LAN コントローラとの接続に使

用し、OPB SDRAM、PLB SDRAM は SDRAM との接続に使用しています。 
 

10.2.5.5. LAN コントローラ (hard_temac) 
SZ410 ではハード的に内蔵されている LAN コントローラ、hard_temac を使用しています。 
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10.2.5.6. 割り込みコントローラ (opb_intc) 

割り込みコントローラに OPB Interrupt Controller を使用しています。最大 32 本の割り込み入力が可能で、そ

れぞれの入力に対し、属性（ハイレベル/ローレベル/立ち上がりエッジ/立下りエッジ）の指定が出来ます。ＥＤＫは割

り込みコントローラに接続されている IP コアの割り込み線の属性を見て、割り込みの受け付け回路を最適になるよう

に自動生成してくれます。SZ010、SZ030、SZ130 では割り込み入力に OPB TIMER、OPB UART lite、LAN コ

ントローラの 3 つ、SZ310,SZ410 では OPB TIMER を除いた残り 2 つの割り込み入力に接続しています。 
 
10.2.5.7. タイマ (opb_timer) 

SZ010,SZ030,SZ130 では OPB TIMER を、SZ310,SZ410 では PowerPC の内部タイマを使用しています。 
 
10.2.5.8. シリアル (opb_ uart_lite) 

シリアルには OPB UART lite を使用しています。OPB UART lite は送受信 16MByte ずつの FIFO を持って

おり、送信 FIFO が空になった時と、受信 FIFO にデータが入ってきた時に割り込みを発生します。OPB UART 
lite はハードウェアフロー制御信号やモデム制御信号を持っていません。 

CON1(RS232C 用 10 ピンヘッダ)には、TXD、RXD、RTS、CTS をピンアサインしています。そのうち OPB 
UART lite で使用している信号は TXD、RXD のみで、その他の信号は未使用となっています。これらの未使用の

信号は GPIO やユーザロジックを接続してフロー制御したり別の OPB UART lite を接続して、2 ポート目の

UART とすることも可能です。 
 
10.2.5.9. GPIO (opb_gpio) 

D1、D3 の LED を点灯するために GPIO を使用しています。 
 
10.2.5.10. クロック (dcm_module) 

SZ010,SZ030,SZ130 では SUZAKU のクロック 3.6864MHz を DCM で 14 逓倍し 51.6096MHｚにして、

SDRAM や内部バス、MicroBlaze に供給しています。SZ310 では SUZAKU のクロック 3.6864MHz を DCM で

18 逓倍し 66.3552MHz にして SDRAM や内部バスに供給し、さらにこれを 4 逓倍して 265.4208MHz にして

PowerPC に供給しています。 
 
10.2.5.11. SPI (opb_spi_s)  

SZ130,SZ410 では OPB SPI S を使用しています。SZ130 の FPGA (Spartan-3E)は SPI モードを使うことが

出来ます。SPI モードは市販の SPI フラッシュメモリからコンフィギュレーションするモードです。SZ410 では CPLD
による SPI コンフィギュレーションを採用しています。 
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10.2.5.12. ブリッジ (plb2opb_bridge) 

SZ310,SZ410 では OPB をブリッジを使用して PLB に接続しています。OPB に追加する IP コアはこのブリッジ

で設定された BaseAddress と HighAddress の間にアドレスを設定する必要があります。デフォルトでは

BaseAddress が 0xF0F00000 、 HighAddress が 0xF0FFFFFF に 設 定 さ れ て い ま す 。 こ の ア ド レ ス は

C_RNG0_BASEADDR と C_RNG0_HIGHADDR の値により変更することが出来ます。もし仮にこのアドレス内か

らはみ出したところに IP コアのアドレスを設定してコンフィギュレーションしても動かないだけでエラーは出ませんの

でご注意ください。 
 

 
図 10-41 ブリッジ 
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10.3. GPIO の追加 

ISE で単色 LED(D1)を点灯させましたが、EDK でも単色 LED を点灯させてみます。 
 
10.3.1. GPIO の接続 

SUZAKU のデフォルトに GPIO を追加して、単色 LED（D1）を点灯させ、アプリケーショ

ンを製作します。GPIO は OPB バスに接続し、GPIO の出力を単色 LED に接続します。 
先ほど”C:¥suzaku”の下にコピーしたフォルダの名前を”sz***-add_uart_gpio”に変更し

て作業を進めます。 
”C:¥suzaku¥sz***-add_uart_gpio¥xps_proj.xmp”をダブルクリックして開いてください。 

 
 
 
 
 

IPコア

IPコア

OPB

OPB GPIO

3.3V

 
SUZAKUの
デフォルト

 
図 10-42 GPIO を追加して LED を点灯 

S

I

G

P

IP ASW

NE

BI

D

N

AP

L



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                                       EDK の使い方 
 

179

 
10.3.2. ハードウェア設定 

まずはハードウェアの設定を行います。 
ここでの設定は Project タブの Project Files→MHS File: xps_proj.mhs に反映されます。 

 
10.3.2.1. IP コア追加 

IP コアを追加します。IP Catalog のタブをクリックしてください。IP Catalog には EDK に登録されている IP コア

やユーザが登録した IP コアの一覧が表示されます。ここから使いたい IP コアを選択し、追加することができます。 
General Purpose IO の中にある opb_gpio を右クリックしてメニューを出し、Add IP を選択してください。

opb_gpio が追加されます。 
 

 
図 10-43 opb_gpio の追加 

 

opb_gpio を 
右クリックしてメニューを出し 
Add IP を選択  

IP コア（opb_gpio_1）が追加される 
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10.3.2.2. OPB バスに接続 

OPB に GPIO を接続します。OPB は MicroBlaze やペリフェラルを接続するためのバスです。 
Bus Interface を選択し、opb_gpio_1 の横の丸をクリックしてください。  →   
これで OPB バスに GPIO が接続されます。 

 

 
図 10-44 OPB バスに接続 

10.3.2.3. IP コアの設定 
IP コアはさまざまな設定をすることができます。今回追加した GPIO では GPIO の本数、出力の属性、プロセッ

サから制御する際の BaseAddress などを設定することができます。 
opb_gpio_1 を右クリックしてメニューを出し、[Configure IP]を選択してください。 

 

 
図 10-45 Configure IP 

Bus Interface を選択 

白丸をクリック  → 

右クリックしてメニューを出し、 
Configure IP を選択 
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単色 LED を 1 つだけ光らすので、バスの幅は 1 ビットにします。 
 

 
図 10-46 バス幅の設定 

 
Channel1 を選択し、Bi-directional を[FALSE]にしてください。 

 

 
図 10-47 その他設定変更 

１ にする 

FALSE に変更 
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System タブをクリックし、[Base Address]、[High Address]にそれぞれメモリアドレスを入力して、[OK]をクリック

してください。メモリアドレスは SUZAKU のメモリマップで Free と書いてあるところに割り当てます（”1.4 メモリマッ

プ”参照）。メモリアドレスは同じバスにつながっている周辺回路を CPU が見分けるために使用する大事な値です。

この値が任意に決められていることで、CPU や他のコアが通信できるようになります。 

表 10-3 GPIO メモリアドレス 

 SZ010、SZ030
SZ130 SZ310、SZ410 

Base Address 0xFFFFA400 0xF0FFA400 
High Address 0xFFFFA5FF 0xF0FFA5FF 

 

 
図 10-48 メモリアドレス設定 

 
IP コアの詳細を知りたい時は、[Datasheet]をクリックしてください。データシートが表示されます。 

 

Base Address を入力 

High Address を入力 

System タブをクリック 
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図 10-49 データシートの出し方 

 
10.3.2.4. メモリマップ確認 

Addresses を選択し、opb_gpio_1 の BaseAddress と High Address と Size に間違いがないか確認してくださ

い。 

 
図 10-50 メモリマップ確認 

10.3.2.5. 信号の定義 
IP コアのバス以外への接続の指定をします。External Ports に登録すると、FPGA 外部信号を定義することが

でき、それ以外は内部信号になります。 
Ports を選択し、opb_gpio_1 の をクリックし開いてください。GPIO_d_out の Net の部分をクリックすると、Net

名を入力することが出来ます。Net 名は何でも良いのですが、ここではｎLE と入力してください。欄外をクリックする

と確定します。 

Addresses を選択 

メモリマップを確認 
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図 10-51 Net 名入力 

もう一度ｎLE の Net の部分をクリックし、今度は をクリックし、[Make External]を選択し、欄外をクリックして確

定させてください。 
 

 
図 10-52 外部信号にする 

クリックし、nLE とネット名を入力し、確定させる 

Ports を選択 

Make External を選択し、確定させる 
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External Ports の をクリックして開いてください。External Ports にはシステムの外部に出力する信号が定義さ

れています。この中に Name：nLE_pin という信号が生成されているのを確認してください。 
 

 
図 10-53 信号名変更 

 
 

nLE_pin が生成されているのを確認 
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ここまでに行った作業はすべて mhs ファイルに反映されます。mhs ファイルはハードウェアの構成や設定を記述

するファイルです。Project タブをクリックし、Project Files→MHS File: xps_proj.mhs をダブルクリックして開いて

ください。 

例 10-1 GPIO を追加した mhs ファイル 

PARAMETER VERSION = 2.1.0 
 
PORT clk_in = clk_in, DIR = I, SIGIS = CLK 
PORT SYS_Rst = SYS_Rst, DIR = I 
# 中略 
PORT nLE_pin = nLE, DIR = O, VEC = [0:0] #外部への出力信号定義 
 
# 中略 
 
BEGIN opb_gpio 
 PARAMETER INSTANCE = opb_gpio_1  #インスタンス名(Name のところ) 
 PARAMETER HW_VER = 3.01.b   #バージョン 
 PARAMETER C_GPIO_WIDTH = 1   #1 ビットに設定 
 PARAMETER C_IS_BIDIR = 0   #GPIO_IO を Input として使用しないので 0 
 PARAMETER C_BASEADDR = 0xFFFFA400  #メモリマップの設定(BASE ADDRESS) 
 PARAMETER C_HIGHADDR = 0xFFFFA5FF  #メモリマップの設定(HIGH ADDRESS) 
 BUS_INTERFACE SOPB = d_opb_v20  #OPB バスに接続 
 PORT GPIO_d_out = nLE   #External Port に接続 
END 
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10.3.2.6. ピンアサイン 

Project タブをクリックし、UCF File: data/xps_proj.ucf をダブルクリックして開いてください。ピンアサイン設定の

ファイルが開きます。単色 LED（D1）を点灯させるため、FPGA に信号を割り当てます。先ほど External Ports の

nLE_pin の定義の部分で、Range が[0:0]と設定されていました。Range を設定した場合は、バス幅が 1 ビットでも

nLE_pin<0>のように記述します。記述できたら[File]→[Save]をクリックし、保存してください。 

表 10-4 ｎLE_pin<0> ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nLE_pin<0> B12 E12 L16 G2 
 

 
図 10-54 GPIO(xps_proj.ucf) 

10.3.2.7. IP コア追加 作業まとめ 
 

1． IP コアを SUZAKU のデフォルトに追加 
2． OPB バスに接続 
3.  各種設定変更 
４． アドレスを設定 
５． 入出力信号の接続 

 
 

ピンアサインを追記 
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10.3.3. ネットリスト, プログラムファイル(Hard のみ) 作成 
[Hardware]→[Generate Netlist]  をクリックして下さい。ネットリストが生成されます。 
 

 
図 10-55 ネットリスト作成 

 
[Hardware]→[Generate Bitstream]  をクリックして下さい。ソフトウェアを含まない bit ファイルが生成され

ます。エラーが出た場合は、今までの工程を見直してみてください。 
 

 
図 10-56 bit ファイル（Hard）作成 

 

[Hardware]→[Generate Bitstream] 
を選択

[Hardware]→[Generate Netlist] 
を選択

ログが表示される 
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10.3.4. ソフトウェア設定 
10.3.4.1. ライブラリ, ドライバ設定 

[Software]→[Software Platform Settings] をクリックしてください。ここではプロセッサ、

OS、およびライブラリの設定を変更することが出来ます。Drivers をクリックすると、Driver の設定

が表示されます。 
追加した opb_gpio の Driver を generic に変更し、OK をクリックしてください。 

 
図 10-57 GPIO Driver 設定 

ここで設定した内容は mss ファイルに反映されます。mss ファイルはライブラリやドライバの設定を記述するファイ

ルです。Project タブをクリックし、Project Files→MSS File: xps_proj.mss をダブルクリックして開いてください。

一番下の記述が今回追加された設定です。 

例 10-2 GPIO の設定を追加した mss ファイル 

BEGIN DRIVER 
 PARAMETER DRIVER_NAME = generic 
 PARAMETER DRIVER_VER = 1.00.a 
 PARAMETER HW_INSTANCE = opb_gpio_1 
END 

 

 
 
TIPS  Bug Fix 

 
Software Platform Settings を変更すると、MSS ファイルに以下のような記述が入り、エラーが出ることがありま

す。この記述は必要ないので、削除してください。 
 
PARAMETER int_handler = , int_port = MAC_INTERRUPT_IN 
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10.3.4.2. ライブラリ, ドライバ生成 

Generate Libraries and Drivers をクリックして下さい。 
ライブラリや様々な設定を定義したヘッダファイルが出来上がります。 
 
xparametaers.h を開いてください。xparameters.h にはシステムのアドレスマップが定義されます。 
先ほど設定した GPIO の BASEADDR と HIGHADDR が自動で定義されています。 

 

 
図 10-58 xparameters.h 

 

xparameters.h 
をダブルクリックして

開く 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                                       EDK の使い方 
 

191

 
10.3.5. アプリケーション編集 

単色 LED を光らせるアプリケーションを作成します。 
Applications タブをクリックしてください。Add Software Application Project を右クリックし、

Add Software Application Project をクリックして下さい。 
 

 
図 10-59 アプリケーション作成 

右クリックして、Add Software Application Project を選択 
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下図が立ち上がるので、アプリケーションのプロジェクトの名前を入力します。ここでは hello-led とします。 
 

 
図 10-60 アプリケーションのプロジェクト名 

 
Project : hello-led が出来上がります。Sources を右クリックしメニューの Add New File をクリックして下さい。 

 

 
図 10-61 New File 作成 

プロジェクトの名前入力 

hello-led の Sources を 
右クリックしてメニューを出し、 
Add New File...をクリック 
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フォルダを作成し、作成したフォルダを開いてください。ここでは hello-led というフォルダを作成します。ファイル

名に main.c と入力し、[保存]をクリックして下さい。 

 

図 10-62 main.c 作成 

Sources に main.c が作成されます。ダブルクリックしてファイルを開いてください。 
 

 
図 10-63 main.c を開く 

新しいフォルダ作成 

main.c と入力 

main.c をダブルクリック 
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単色 LED を点灯するソースコードを記述します。 
 

 
#include "xparameters.h" 
 
int main(void) 
{ 
  *(volatile unsigned long *)XPAR_OPB_GPIO_1_BASEADDR = 0; 
  return 0; 
} 

図 10-64 単色 LED 点灯のソースコード(main.c) 

記述できたら[File]→[Save]を選択し、保存してください。 
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Project : hello-led を右クリックして、Mark to Initialize BRAMs をクリックして下さい。 
チェックマークがつき、Project : hello-led の横のアイコンが に変わります。これで hello-led が BRAM に初

期値として書き込まれるようになります。 
 

 
図 10-65 hello-led を書き込むように設定 

今回 BBoot("11.4.7 BBoot 編集"参照)は書き込みません。 
Project : BBoot を右クリックして、Mark to Initialize BRAMs をクリックして下さい。 
チェックマークが消え、Project : BBoot の横のアイコンが に変わります。 
 

 
 

図 10-66 BBoot は書き込まないように設定 

 

選択されるとチェックマークがつき、左のアイコン

から×マークがなくなる

選択されていないと、チェックマークがはずれ、 
左のアイコンに×マークが入る 
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10.3.5.1. リンカースクリプト設定 

SZ310,SZ410 の場合リンカースクリプトの設定が必要です。 
Project : hello-led を右クリックして、Set Compiler Options をクリックして下さい。 

 

 
図 10-67 リンカースクリプト設定 

Use Default Linker Script をチェックし、Program Start Address に 0xFFFFC000 と入力して[OK]をクリック

して下さい。0xFFFFC000 は BRAM の Base Address で、プログラムが BRAM から始まるように設定されます。 
 

 
図 10-68 スタートアドレス設定 

右クリックしてメニューを出し、 
Set Compiler Options をクリック

0xFFFFC000 と入力 
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10.3.6. アプリケーション生成 

[Software]→[Build All User Applications]  をクリックして下さい。コンパイラが起動さ

れ、各アプリケーションのプログラムソースの設定が読み込まれます。エラーがなければ

executable.elf が "C:¥suzaku¥sz***-add_uart_gpio¥microblaze_i(ppc405-i)¥code" の

下に出来上がります。 
 

 
図 10-69 elf ファイル作成 

 
 

10.3.7. プログラムファイル作成 
ハードウェアでつくった bit ファイルの中にアプリケーションを書き込みます。 
[Device Configuration]→[Update Bitstream] をクリックしてください。bit ファイルが生成されます。 

 

 
図 10-70 bit ファイル作成 

[Device Configuration]→[Update Bitstream] 
を選択

[Software]→[Build All User Applications] 
を選択
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TIPS  変な ERROR がでたら 

 
エラーを修正した後、Update Bitstream や Build All User Application を実行すると、エラーを修正できてな

いようなエラーが出ることがあります。そんな時は [Hardware]→ [Clean Hardware]や [Software]→ [Clean 
Software]を実行し、クリーンしてみてください。うまくいくことがあります。 

 

 
10.3.8. コンフィギュレーション 

bit ファイルを JTAG でコンフィギュレーションします。SUZAKU JP2 をショートさせ、

SUZAKU CON7 にダウンロードケーブルを接続し、LES/SW CON6 に AC アダプタ 5V を接

続し、電源を投入してください。 
 
 
 
 
 
 
 
 
 

 
図 10-71 ジャンパの設定等 

JP2 ショート 

電源投入 

ダウンロードケーブル接続 
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[Device Configuration]→[Download Bitstream] をクリックしてください。バッチモードの iMPACT を使用し

て FPGA に bit ファイルがコンフィギュレーションされます。 
 

 
図 10-72 コンフィギュレーション 

 
単色 LED（D1）が光ったでしょうか？ 

X
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図 10-73 単色 LED(D1)点灯 

 
フラッシュメモリに書き込む場合は、”C:¥suzaku¥sz***-add_uart_gpio¥implementation”フォルダ内に

download.bit が出来上がっているので、これを使って下さい。 

[Device Configuration]→[Download Bitstream] 
を選択
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10.3.9. 空きピン処理 

ISE の時と同様、D2、D3、D4 が少し光っています(SZ310,SZ410 ではほとんど光りません)。EDK で空きピン処

理をしたい場合、bitgen.ut ファイルを編集します。ここに UnusedPin の設定を記述することで、終端処理を設定す

ることが出来ます。デフォルトでこのピンは PullDown に設定されているため、SUZAKU のデフォルトでは明記して

いません。この設定を PullUｐにすることで D2、D3、D4 は光らなくなります。ただ、空きピンから電圧が出力されて

いるのはあまり良い状態ではないので、今回も D2、D3、D4 に信号を定義することで対処します。 
 

 
図 10-74 Bitgen のオプション設定 

-g UnserdPin:PullDown 
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Add External Port をクリックすると、External Ports に信号が追加されるので 3 つ追加してください。Name に

適当な名前を記述し(ここでは nLE2_pin, nLE3_pin, nLE4_pin と記述)、Direction を O に設定し、Range に

[0:0](Range は設定しなくてもかまいません。設定しなかった場合はピンアサインで<0>は不要)と記述し、Net に

net_vcc と記述してください。Net に net_vcc と記述すると、'1'が出力されます。 
 

 
図 10-75 EDK での空きピンの処理 

xps_proj.ucf を開き、ピンアサインを追記してください。 

表 10-5 ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nLE2_pin<0> C12 F12 L15 F2 
nLE3_pin<0> D11 B11 L14 F1 
nLE4_pin<0> E11 A11 L13 E1 
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TIPS  Flat View 

 
以下のような表示になって元に戻したいと思ったことはないでしょうか。右クリックしてメニューを出して Flat View

のチェックをはずせば、元の表示に戻すことができます。 
 

 
図 10-76 Flat View 

 

このあたりを右クリックしてメニューを出す 

Flat View のチェックをはずす 
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10.4. UART の追加 

UART を追加し、BRAM の中のアプリケーションに受信した文字をそのまま送信するソースコ

ードを追加します。 
 
10.4.1. ハードウェア設定 
10.4.1.1. IP コアの追加 

IP Catalog のタブをクリックし、Communication Low-Speed の中にある opb_uartlite を右

クリックしてメニューを出し、Add IP を選択してください。opb_uartlite_0 が追加されます。 
 

 
図 10-77 opb_uartlite の追加 

 

opb_uartlite を 
右クリックしてメニューを出し 
Add IP を選択  

IP コア（opb_uartlite_0）が追加される  
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10.4.1.2. OPB バスに接続 

Bus Interface を選択し、opb_uartlite_0 の横の丸をクリックしてください。  →    
これで OPB バスに接続されます。 

 

 
図 10-78 OPB バスに接続 

 
10.4.1.3. IP コアの設定 

opb_uartlite_0 を右クリックしてメニューを出し、Configure IP を選択してください。 
 

 
図 10-79 Configure IP 

 
 

Bus Interface を選択 

白丸をクリック  → 

右クリックしてメニューを出し、 
Configure IP を選択 
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以下の設定にしてください。 

 
・UART Lite Baud Rate 115200 
・Number of Data Bits in a Serial Frame 8 
・Use Parity FALSE 
・Parity Type ODD 

 
 

 
図 10-80 UART 設定変更 

設定変更 
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[System]タブをクリックし、[Base Address]、[High Address]に入力してください。メモリアドレスは SUZAKU の

メモリマップで Free と書いてあるところに割り当てます。 
（”1.4 メモリマップ”参照） 

表 10-6 UART メモリアドレス 

 SZ010、SZ030
SZ130 SZ310、SZ410 

Base Address 0xFFFFA６00 0xF0FFA600 
High Address 0xFFFFA6FF 0xF0FFA6FF 

 
 
 

 
図 10-81 メモリアドレス設定 

 
 

System タブをクリック 

Base Address を入力 

High Address を入力 
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OPB をクリックし、[OPB Clock Frequency]にクロック周波数を入力して、[OK]をクリックしてください。 

 
表 10-7 OPB Clock Frequency 

 SZ010、SZ030
SZ130 SZ310 SZ410 

OPB Clock Frequency 51609600Hz 66355200Hz 87500000Hz 
 
 
 

 
図 10-82 クロック周波数の設定 

クロック周波数入力 
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10.4.1.4. メモリマップ確認 

Addresses を選択し、opb_uartlite_0 の BaseAddress と High Address と Size に間違いがないか確認してく

ださい。 
 

 
図 10-83 メモリマップ確認

Addresses を選択 

メモリマップを確認 
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10.4.1.5. 信号の定義 
Ports を選択してください。opb_uartlite_0 の RX と TX の Net に名前をつけ、その後 Make External を選択

して確定してください。 
External Ports に信号が定義されているか確認してください。 

 

 
図 10-84 信号の定義 

 

CONSOLE_RX2_pin, CONSOLE_TX2_pin 
が定義されているのを確認 

名前を入力し、確定 
CONSOLE_RX2 
CONSOLE_TX2 
↓ 
Make External を選択し、確定 
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10.4.1.6. ピンアサイン 

Project タブをクリックし、UCF ファイルを開き、増えた 2 ピンを追加し、保存してください。 

表 10-8 CONSOLE ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

CONSOLE_RX2_pin B4 M3 F13 P4 
CONSOLE_TX2_pin A3 M6 E13 E15 

 

 
図 10-85 UART(xps_prj.ucf) 

 
 

 
10.4.2. ネットリスト, プログラムファイル(Hard のみ) 作成 

[Hardware]→[Generate Netlist]  をクリックして下さい。ネットリストが生成されます。 
[Hardware]→[Generate Bitstream]  をクリックして下さい。ソフトウェアを含まない bit フ

ァイルが生成されます。エラーが出た場合は、今までの工程を見直してみてください。 
 
 
 
 

ピンアサイン追記 
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10.4.3. ソフトウェア設定 
10.4.3.1. ライブラリ, ドライバ設定 
 [Software]→[Software Platform Settings] をクリックしてください。 
追加した opb_uartlite の Driver を generic に変更し、OK をクリックしてください。 
 

 
図 10-86 UART Driver 設定 
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10.4.3.2. ライブラリ, ドライバ生成 

Generate Libraries and Drivers をクリックして下さい。 
ライブラリと様々な設定を定義したヘッダファイルが出来上がります。 
 
xparametaers.h を開いてください。xparameters.h にはシステムのアドレスマップが定義されます。 
先ほど設定した UART の BASEADDR と HIGHADDR も自動で定義されています。 

例 10-3 xparameters.h の定義の例 

/* Definitions for peripheral OPB_UARTLITE_0 */ 
#define XPAR_OPB_UARTLITE_0_BASEADDR 0xFFFFA600 
#define XPAR_OPB_UARTLITE_0_HIGHADDR 0xFFFFA6FF 

 
ソフトウェアに関するファイルは”C:¥suzaku¥sz***-add_uart_gpio¥microblaze_i(ppc405_i)”の下に収められ

ます。このフォルダの下の"¥include¥xuartlite_l.h"を開いてください。UART を扱うことのできる関数等が定義さ

れています。以下の関数を使います。 

例 10-4 xuartlite_l.h に定義されている関数 

/* 受信 FIFO のデータの有無をチェックする */ 
#define XUartLite_mIsReceiveEmpty(BaseAddress) ¥ 
  ((XUartLite_mGetStatusReg((BaseAddress)) & XUL_SR_RX_FIFO_VALID_DATA) != ¥ 
    XUL_SR_RX_FIFO_VALID_DATA)  
 
/* 送信 FIFO に 1Byte 分 Write する */ 
void XUartLite_SendByte(Xuint32 BaseAddress, Xuint8 Data); 
 
/* 受信 FIFO のデータを 1Byte 分 Read する */ 
Xuint8 XUartLite_RecvByte(Xuint32 BaseAddress); 
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10.4.4. アプリケーション編集 

Applications タブをクリックし、先ほど作成した hello-led の main.c を開いてください。

uartlite のヘッダファイルの定義を追加し、先ほど書いた単色 LED を点灯する一文を消し、受信

した文字をそのまま送信するコードを追加し、保存してください。 
 

 
#include "xparameters.h" 
#include "xuartlite_l.h" 
int main(void) 
{ 
  while (1) { 
    while(XUartLite_mIsReceiveEmpty(XPAR_OPB_UARTLITE_0_BASEADDR)); 
          XUartLite_SendByte(XPAR_OPB_UARTLITE_0_BASEADDR, 
          (Xuint8)XUartLite_RecvByte(XPAR_OPB_UARTLITE_0_BASEADDR)); 
  } 
  return 0; 
} 

図 10-87 送受信ソースコード追加(main.c) 
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10.4.5. アプリケーション生成 

[Software]→[Build All User Applications]  をクリックして下さい。コンパイラが起動され、

各ソフトウェア アプリケーションのプログラム ソースの設定が読み込まれます。 エラーがなけれ

ば executable.elf が出来上がります。 
 
10.4.6. プログラムファイル作成 

ハードウェアでつくった bit ファイルの中にソフトウェアを書き込みます。 
[Device Configuration]→[Update Bitstream] をクリックしてください。bit ファイルが生成

されます。エラーがでたら間違いを修正して再び[Update Bitstream]をクリックしてください。bit
ファイルは download.bit という名前で”C:¥suzaku¥sz***-
add_uart_gpio¥implementation”フォルダに出来上がります。 
 

 
図 10-88 bit ファイルの作成 

 
10.4.7. コンフィギュレーション 

シリアル通信用ソフトウェアを立ち上げ、シリアル通信の設定を行ってください。（"5.2 シリアル通信ソフトウェア" 
参照） 

SUZAKU JP2 をショートし、SUZAKU CON7 にダウンロードケーブルを接続してください。 
LED/SW CON7 にシリアルケーブルを接続してください。 
最後に LED/SW CON6 に AC アダプタ 5V を接続し、電源を投入してください。 

 

 
図 10-89 ジャンパの設定等

Update Bitstream
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電源投入 

ダウンロードケーブル接続 

シリアルケーブル接続 
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[Device Configuration]→[Download Bitstream] をクリックしてください。バッチモードの iMPACT を使用し

て FPGA に bit ファイルがコンフィギュレーションされます。 
 

 キーボードから何か文字を打ち込んでください。打ち込んだ文字がそのまま送信されてコンソールに表示されま

す。 
 

キーボード

受信した文字をそのまま送信
 

X
il
in
x

S
pa
r
ta
n3
E

 
図 10-90 シリアル通信 動作確認 

 

abcdefghijk・・ 

abcdefghijk・・
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11. スロットマシンのコアを CPU で制御する 
 

 
 

ここからはまた、スロットマシンに戻ります。“9. FPGA 入門 スロットマシン製作”で作った回路を少し改造してコア

にして、SUZAKU のデフォルトの回路に接続し、スロットマシンを作り上げます。作業手順は以下の通りです。 

 
図 11-1 スロットマシンへの道のり 

 
付属 CD-ROM の”¥suzaku¥fpga_proj¥x.x¥sz***¥sz***-yyyymmdd.zip”をハードディスクに展開してくださ

い。ここでは展開後のフォルダを”C:¥suzaku”の下にコピーして作業を進めます。 
”C:¥suzaku¥sz***- yyyymmdd”の中の”xps_proj.xmp”をダブルクリックして開いてください。 
Xilinx Platform Studio が起動し、SUZAKU のデフォルトが開きます。 
 
スロットマシンのコアは"opb_sil00u"という名前で下図のように製作します。 

seg_in1

seg_in2

seg_in3

le_trig
sw
code

nSW

nCODE

nLE

nSEL

SEGopb_sil00u

intr

user_logic.vhd

opb_sil00u.vhd

sil00u_core.vhd

 
図 11-2 自作 IP コア 
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11.1. ウィザードを使って OPB インターフェースをつくる 

OPB バスに接続するインターフェースをつくります。EDK にはインターフェースを作るウィザ

ードが用意されているので、簡単にインターフェースをつくることが出来ます。スロットマシンのコ

アを CPU から制御するためには、バスに接続しなければいけません。 
 

 [Hardware]→[Create or Import Peripheral...]をクリックしてください。 
 

 
図 11-3 Create and Import Peripheral Wizard の起動のさせ方 

 
Create and Import Peripheral Wizard が立ち上がります。[Next]をクリックして下さい。 
 

 

図 11-4 Create and Import Peripheral Wizard

[Hardware]→[Create or Import Peripheral...]をクリック 
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Create and Import Peripheral Wizard が立ち上がります。新規で作るので Select flow の[Create 
templates for a new peripheral]をチェックして[Next]をクリックしてください。 
 

 
図 11-5 Peripheral Flow 

 
コアを生成する場所を指定します。[To an XPS project]をチェックし、現在のプロジェクトの下に作成します。入力

できたら[Next]をクリックして下さい。 
 

 
図 11-6 コアの生成場所の指定 

C:¥suzaku¥sz***- yyyymmdd ¥ 
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コアに名前をつけます。[Name]に名前を入力してください。opb_sil00u とします。 

 

 
図 11-7 コアの名前 

 
バスを選択します。OPB につなぐので[On-chip Peripheral Bus(OPB)]を選択して[Next]をクリックしてください。 

 

 
図 11-8 バスの選択 

 
 

opb_sil00u と入力
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IPIF にはアドレスのデコード、バイト調整などの基本的な機能に加えて、ペリフェラルの作成を大幅に簡略化する

オプションの機能が備わっています。選択した項目により OPB ペリフェラルテンプレートが生成されます。 
今回は[User logic interrupt support]、[User logic S/W register support]を選択し、[Next]をクリックしてくだ

さい。割り込みのユーザーテンプレート、ソフトウェアアクセス可能レジスタが生成されるユーザーテンプレートが追加

されます。 

 
図 11-9 テンプレート追加 

 
割り込みの設定をします。割り込みに使用するカウンタの Duty が 50%なのでエッジ取り込みにし、今回は立ち上

がりエッジを使用します。[Use Device ISC(interrupt source controller)]のチェックボタンをはずし、 Interrupt 
capture mode を[Rising Edge Detect]に設定して、[Next]をクリックして下さい。 
 

 
図 11-10 Interrupt 設定
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ソフトウェアアクセス可能レジスタ数と、サイズ（バイト、ハーフワード、ワード、ダブルワード）を指定します。今回必

要となるレジスタは、読み込み/書き込みのレジスタが 4 つ（７セグメント LED の値を設定するレジスタ 3 つ、単色

LED のトリガ信号を設定するレジスタ）、読み込みのレジスタが 2 つ（押しボタンスイッチの情報をやり取りするレジス

タ、ロータリコードスイッチの情報をやり取りするレジスタ）の合計 6 つです。サイズは 4 ビットでいいのですが、最小

単位がバイトなので、8 ビットとします。 
[Number of software accessible resiters]を 6 にし、[Data width of each register]を 8bit にし、[Next]をクリ

ックしてください。 
 

 
図 11-11 レジスタ数とバス幅指定 
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IPIC を設定します。すでにいくつか ON になっていますが、IPIF Services ページで指定した機能をインプリメン

トするために必要なものに自動でチェックされています。このまま[Next]をクリックしてください。 
 

 
図 11-12 IPIC 設定 

 
ここを ON にすると、カスタムロジックおよび機能のシミュレーションに使用するサポートファイルを生成できますが、

今回は使いません。そのまま[Next]をクリックしてください。 
 

 
図 11-13 サポートファイル生成確認 
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下図の項目をチェックし、[Next]をクリックしてください。 
ソフトフェアドライバテンプレートファイルとドライバディレクトリ構成が作成されます。 

 

 
図 11-14 オプション設定 

以上で終了です。[Finish]をクリックしてください。 
 

 
図 11-15 終了 
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“C:¥suzaku¥sz***- yyyymmdd ¥pcores”の下に OPB バスに接続するインターフェースの雛形が生成されま

す。 
 

 
図 11-16 フォルダ構成 
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11.2. 今まで作ってきた回路をまとめる 
下図の仕様で今まで作ってきた回路を OPB バスに接続できるようにまとめます。

sil00u_core.vhd をテキストエディタ等で新規作成してください。 
 
 
 
 
 
 

７セグメントLEDの数
字をデコード

seg7_decoder

sil00u_core.vhd

単色LED
順次点灯

le_seq_blink

７セグメントLED
ダイナミック点灯
dynamic_ctrl

CPUに押しボタンスイッチの情
報を送る（sw)

CPUにロータリコードスイッチの情
報を送る(code)

CPUからセグメント値の設定を
受ける(seg_in1,seg_in2,seg_in3)

CPUから単色LEDの順次点灯
のトリガ信号を受ける(le_trig)

押しボタンスイッチの入力（nSW）

ロータリコードスイッチの入力（nCODE）

７セグメントLEDの
セレクト信号を出力（nSEL）

７セグメントLEDに値を出力（SEG）

単色LEDに出力（nLE）

カウンタ
slot_counter

割り込みを発生させる(intr)

 
図 11-17 自作 IP コア（ソフト版）の仕様 

 
 
11.2.1. sil00u_core.vhd 

SZ010、SZ030、SZ130 ではバスクロックが 51.6096MHz、SZ310 では 66.3552MHz、SZ410 では 87.5MHz
になっています。カウンタのビット数を４ビット増やし 23 ビットにします。sil00u_core.vhd を上位階層として今まで作

った回路、slot_counter、le_seq_blink、seg7_decoder、dynamic_ctrl 回路を呼び出します。また、押しボタンスイ

ッチ、ロータリコードスイッチ、割り込みの信号の定義をします。 

例 11-1 コア(sil00u_core.vhd) 

library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
entity sil00u_core is 
  generic (  
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    C_CNT_WIDTH : integer := 23 --カウンタのビット幅 
  ); 
 
  Port (  
    SYS_CLK : in STD_LOGIC; --クロック信号  
    SYS_RST : in STD_LOGIC; --リセット信号 
 
    -- External 
    SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグ LEDにダイナミック点灯で値を出力 
    nSEL : out STD_LOGIC_VECTOR(0 to 2); --7セグ LEDにセレクトをを出力 
    nLE : out STD_LOGIC_VECTOR(0 to 3); --単色 LEDに順次点灯を出力 
    nSW : in STD_LOGIC_VECTOR(0 to 2); --押しボタンスイッチを入力 
    nCODE : in STD_LOGIC_VECTOR(0 to 3); --ロータリコードスイッチを入力 
 
    -- Register Write 
    seg_in1 : in STD_LOGIC_VECTOR(0 to 3); --CPUからセグメント値の設定を受ける 
    seg_in2 : in STD_LOGIC_VECTOR(0 to 3); --CPUからセグメント値の設定を受ける 
    seg_in3 : in STD_LOGIC_VECTOR(0 to 3); --CPUからセグメント値の設定を受ける 
    le_trig : in STD_LOGIC; --CPUから単色 LEDの順次点灯のトリガ信号の設定を受ける 
 
    -- Register Read 
    sw : out STD_LOGIC_VECTOR(0 to 2); --CPUに押しボタンスイッチの情報を送る 
    code : out STD_LOGIC_VECTOR(0 to 3);  --CPUにロータリコードスイッチの情報を送る 
    intr : out STD_LOGIC  --カウンタの出力を割り込みコントローラに送る  
  ); 
end sil00u_core; 
 
architecture IMP of sil00u_core is 
  signal count : STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1); 
  signal le : STD_LOGIC_VECTOR(0 to 3); 
  signal le_t : STD_LOGIC_VECTOR(0 to 3); 
  signal seg_data : STD_LOGIC_VECTOR(0 to 3); 
 
  component slot_counter 
    generic (  
      C_CNT_WIDTH : integer := C_CNT_WIDTH 
    ); 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号  
      SYS_RST : in STD_LOGIC; --リセット信号 
      count : out STD_LOGIC_VECTOR(0 to C_CNT_WIDTH-1) --カウンタ値 
    ); 
  end component; 
 
  component le_seq_blink 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号  
      SYS_RST : in STD_LOGIC; --リセット信号 
      le : out  STD_LOGIC_VECTOR(0 to 3); --単色 LED出力信号 
      le_timing : in  STD_LOGIC --タイミング信号 
    ); 
  end component; 
 
  component dynamic_ctrl 
    Port (  
      SYS_CLK : in STD_LOGIC; --クロック信号  
      SYS_RST : in STD_LOGIC; --リセット信号 

sil00u_core.vhd
の入出力を定義 

4つの回路の 
コンポーネント宣言 
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      nSEL  : out STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号（負論理） 
      seg7_timing : in  STD_LOGIC; --7セグタイミング信号 
      seg_in1 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED1の値 
      seg_in2 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED2の値 
      seg_in3 : in  STD_LOGIC_VECTOR(0 to 3); --7セグメント LED3の値 
      seg_data : out  STD_LOGIC_VECTOR(0 to 3) --4ビットバイナリコード 
    ); 
  end component; 
 
  component seg7_decoder 
    Port (  
      SEG : out STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号 
      seg_data : in STD_LOGIC_VECTOR(0 to 3) --4ビットバイナリコード 
    ); 
  end component; 
 
begin 
  slot_counter_0 : slot_counter    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      count => count 
    ); 
 
  le_seq_blink_0 : le_seq_blink    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      le => le,  
      le_timing => count(0) 
    ); 
 
  dynamic_ctrl_0 : dynamic_ctrl    
    Port map( 
      SYS_CLK => SYS_CLK, 
      SYS_RST => SYS_RST, 
      nSEL => nSEL, 
      seg7_timing => count(8), 
      seg_in1 => seg_in1, 
      seg_in2 => seg_in2, 
      seg_in3 => seg_in3, 
      seg_data => seg_data 
    ); 
 
  seg7_decoder_0 : seg7_decoder    
    Port map( 
      SEG => SEG, 
      seg_data => seg_data 
    ); 
--トリガ信号が’1’の時順次点灯 
  le_t <= le and "1111" when le_trig = '1' else "0000";  
  nLE <= not le_t; --外部に出力 
  sw <= not nSW; --正論理にして入力 
  code <= not nCODE; --正論理にして入力 
  intr <= count(4); --カウンタの出力を割り込みコントローラに送る 
end IMP; 
 
 

 

4つの回路の 
インスタンス 
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11.3. OPB インターフェースとコアを接続し、自作 IP コアを仕上げる 
今まとめた回路(sil00u_core.vhd、slot_counter.vhd、dynamic_ctrl.vhd、seg7_decoder.vhd、

le_seq_blink.vhd)を“C:¥suzaku¥sz***- yyyymmdd ¥pcores¥opb_sil00u_v1_00_a¥hdl¥vhdl”にコピーして

ください。 
 

 
図 11-18 コアをコピー 
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11.3.1. user_logic.vhd 
user_logic.vhd を開いてください。自動生成されたコードを編集していきます。user_logic

を上位階層として、sil00u_core 回路を呼び出すソースコードを追加します。押しボタンスイッ

チ、ロータリコードスイッチは読み込むだけで書き込みは出来ません。この 2 つのために新た

に、読み込み/書き込みレジスタではなく、読み込みレジスタを定義しています。ソースコードを

追加するところには、大体--USER xxx added here とコメントが入っているので、目印に

してください。 
 
 

例 11-2 sil00u（user_logic.vhd） 

------------------------------------------------------------------------------ 
-- user_logic.vhd - entity/architecture pair 
------------------------------------------------------------------------------ 
--中略 
-- DO NOT EDIT BELOW THIS LINE -------------------- 
library ieee; 
use ieee.std_logic_1164.all; 
use ieee.std_logic_arith.all; 
use ieee.std_logic_unsigned.all; 
library proc_common_v2_00_a; 
use proc_common_v2_00_a.proc_common_pkg.all; 
-- DO NOT EDIT ABOVE THIS LINE -------------------- 
 
 library opb_sil00u_v1_00_a;      --ライブラリとして呼び出す 
 use opb_sil00u_v1_00_a.all; 
 
--中略 
------------------------------------------------------------------------------ 
-- Entity section 
------------------------------------------------------------------------------ 
entity user_logic is 
  generic 
  ( 
    -- ADD USER GENERICS BELOW THIS LINE --------------- 
    --USER generics added here 
    -- ADD USER GENERICS ABOVE THIS LINE --------------- 
    -- DO NOT EDIT BELOW THIS LINE --------------------- 
    -- Bus protocol parameters, do not add to or delete 
    C_DWIDTH                       : integer              := 8; 
    C_NUM_CE                       : integer              := 6; 
    C_IP_INTR_NUM                 : integer              := 1 
    -- DO NOT EDIT ABOVE THIS LINE --------------------- 
  ); 
  port 
  ( 
    -- ADD USER PORTS BELOW THIS LINE ------------------ 
 
    SEG : out STD_LOGIC_VECTOR(0 to 7);    -- 7セグメント LED出力 
    nSEL : out STD_LOGIC_VECTOR(0 to 2);   -- セレクト出力 
    nLE : out STD_LOGIC_VECTOR(0 to 3);    -- 単色 LED出力 
    nSW : in STD_LOGIC_VECTOR(0 to 2);     -- スイッチ入力 
    nCODE : in STD_LOGIC_VECTOR(0 to 3);   -- ロータリ SW入力 
    intr : out STD_LOGIC; 
 
    -- ADD USER PORTS ABOVE THIS LINE ------------------ 
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    -- DO NOT EDIT BELOW THIS LINE --------------------- 
    -- Bus protocol ports, do not add to or delete 
    Bus2IP_Clk                     : in  std_logic; 
    Bus2IP_Reset                   : in  std_logic; 
    Bus2IP_Data                    : in  std_logic_vector(0 to C_DWIDTH-1); 
    Bus2IP_BE                      : in  std_logic_vector(0 to C_DWIDTH/8-1); 
    Bus2IP_RdCE                    : in  std_logic_vector(0 to C_NUM_CE-1); 
    Bus2IP_WrCE                    : in  std_logic_vector(0 to C_NUM_CE-1); 
    IP2Bus_Data                    : out std_logic_vector(0 to C_DWIDTH-1); 
    IP2Bus_Ack                     : out std_logic; 
    IP2Bus_Retry                   : out std_logic;  
    IP2Bus_Error                   : out std_logic; 
    IP2Bus_ToutSup                : out std_logic 
    -- DO NOT EDIT ABOVE THIS LINE --------------------- 
  ); 
 
end entity user_logic; 
------------------------------------------------------------------------------ 
-- Architecture section 
------------------------------------------------------------------------------ 
architecture IMP of user_logic is 
 
  signal slv_reg_r4  : std_logic_vector(0 to C_DWIDTH-1);    --押しボタンスイッチ用 
  signal slv_reg_r5  : std_logic_vector(0 to C_DWIDTH-1);    --ロータリコードスイッチ用 
 
  ------------------------------------------ 
  -- Signals for user logic slave model s/w accessible register example 
  ------------------------------------------ 
  signal slv_reg0     : std_logic_vector(0 to C_DWIDTH-1); --7セグメント LED1用 
  signal slv_reg1     : std_logic_vector(0 to C_DWIDTH-1); --7セグメント LED2用 
  signal slv_reg2     : std_logic_vector(0 to C_DWIDTH-1); --7セグメント LED3用 
  signal slv_reg3     : std_logic_vector(0 to C_DWIDTH-1); --単色 LEDトリガー用 
  signal slv_reg4     : std_logic_vector(0 to C_DWIDTH-1); 
  signal slv_reg5     : std_logic_vector(0 to C_DWIDTH-1); 
  signal slv_reg_write_select   : std_logic_vector(0 to 5); 
  signal slv_reg_read_select    : std_logic_vector(0 to 5); 
  signal slv_ip2bus_data         : std_logic_vector(0 to C_DWIDTH-1); 
  signal slv_read_ack            : std_logic; 
  signal slv_write_ack           : std_logic; 
 
  ------------------------------------------ 
  -- Signals for user logic interrupt example 
  ------------------------------------------ 
  signal interrupt    : std_logic_vector(0 to C_IP_INTR_NUM-1); --割り込み用 
begin 
 
 -- 下位モジュール呼び出し sil00u_coreインスタンス 
 sil00u_core_0 : entity opb_sil00u_v1_00_a.sil00u_core 
  PORT MAP( 
    SYS_CLK => Bus2IP_Clk, 
    SYS_RST => Bus2IP_Reset,  
 
    -- External 
    SEG => SEG, 
    nSEL => nSEL, 
    nLE => nLE, 
    nSW => nSW, 
    nCODE => nCODE, 
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    -- R/Wレジスタ 
    seg_in1 => slv_reg0(4 to 7), 
    seg_in2 => slv_reg1(4 to 7), 
    seg_in3 => slv_reg2(4 to 7), 
    le_trig => slv_reg3(7), 
 
    -- Readレジスタ 
    sw => slv_reg_r4(5 to 7), 
    code => slv_reg_r5(4 to 7), 
    intr => interrupt(0) 
  ); 
 
--中略 
  slv_reg_write_select <= Bus2IP_WrCE(0 to 5); 
  slv_reg_read_select <= Bus2IP_RdCE(0 to 5); 
  slv_write_ack <= Bus2IP_WrCE(0) or Bus2IP_WrCE(1) or Bus2IP_WrCE(2)  
                           or Bus2IP_WrCE(3) or Bus2IP_WrCE(4) or Bus2IP_WrCE(5); 
  slv_read_ack <= Bus2IP_RdCE(0) or Bus2IP_RdCE(1) or Bus2IP_RdCE(2)  
                           or Bus2IP_RdCE(3) or Bus2IP_RdCE(4) or Bus2IP_RdCE(5); 
  -- implement slave model register(s) 
  SLAVE_REG_WRITE_PROC : process( Bus2IP_Clk ) is 
  begin 
    if Bus2IP_Clk'event and Bus2IP_Clk = '1' then 
      if Bus2IP_Reset = '1' then 
        slv_reg0 <= (others => '0'); 
        slv_reg1 <= (others => '0'); 
        slv_reg2 <= (others => '0'); 
        slv_reg3 <= (others => '0'); 
        slv_reg4 <= (others => '0'); 
        slv_reg5 <= (others => '0'); 
      else 
        case slv_reg_write_select is 
          when "100000" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                 slv_reg0(byte_index*8 to byte_index*8+7)  
                   <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
          when "010000" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                slv_reg1(byte_index*8 to byte_index*8+7)  
                  <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
          when "001000" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                slv_reg2(byte_index*8 to byte_index*8+7) 
                  <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
          when "000100" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                slv_reg3(byte_index*8 to byte_index*8+7) 
                  <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
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          when "000010" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                slv_reg4(byte_index*8 to byte_index*8+7) 
                  <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
          when "000001" => 
            for byte_index in 0 to (C_DWIDTH/8)-1 loop 
              if ( Bus2IP_BE(byte_index) = '1' ) then 
                slv_reg5(byte_index*8 to byte_index*8+7) 
                  <= Bus2IP_Data(byte_index*8 to byte_index*8+7); 
              end if; 
            end loop; 
          when others => null; 
        end case; 
      end if; 
    end if; 
  end process SLAVE_REG_WRITE_PROC; 
  -- implement slave model register read mux 
 
-- CPUからのレジスタ読み込み 
 -- SLAVE_REG_READ_PROC : process( slv_reg_read_select, slv_reg0,  
 -- slv_reg1, slv_reg2, slv_reg3, slv_reg4, slv_reg5 ) is 
  SLAVE_REG_READ_PROC : process( slv_reg_read_select, slv_reg0, slv_reg1, 
                                   slv_reg2, slv_reg3, slv_reg_r4, slv_reg_r5 ) is 
 
  begin 
    case slv_reg_read_select is 
      when "100000" => slv_ip2bus_data <= slv_reg0; 
      when "010000" => slv_ip2bus_data <= slv_reg1; 
      when "001000" => slv_ip2bus_data <= slv_reg2; 
      when "000100" => slv_ip2bus_data <= slv_reg3; 
 
      -- when "000010" => slv_ip2bus_data <= slv_reg4; 
      -- when "000001" => slv_ip2bus_data <= slv_reg5; 
      when "000010" => slv_ip2bus_data <= slv_reg_r4; 
      when "000001" => slv_ip2bus_data <= slv_reg_r5; 
 
      when others => slv_ip2bus_data <= (others => '0'); 
    end case; 
  end process SLAVE_REG_READ_PROC; 
  ------------------------------------------ 
  -- Example code to generate user logic interrupts 
  --  
  -- Note: 
  -- The example code presented here is to show you one way of generating 
  -- interrupts from the user logic. This code snippet infers a counter 
  -- and generate the interrupts whenever the counter rollover (the counter 
  -- will rollover ~21 sec @50Mhz). 
 
 ------------------------------------------ 
  -- INTR_PROC : process( Bus2IP_Clk ) is 
  --   constant COUNT_SIZE   : integer := 30; 
  --  constant ALL_ONES     : std_logic_vector(0 to COUNT_SIZE-1) := (others => '1');
  --   variable counter      : std_logic_vector(0 to COUNT_SIZE-1); 
  -- begin 
  -- 
  --   if ( Bus2IP_Clk'event and Bus2IP_Clk = '1' ) then 
  --     if ( Bus2IP_Reset = '1' ) then 
  --       counter := (others => '0'); 

CPU からのレジスタ 
読み込み部の記述追加 
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  --       interrupt <= (others => '0'); 
  --     else 
  --       counter := counter + 1; 
  --         if ( counter = ALL_ONES ) then 
  --           interrupt <= (others => '1'); 
  --         else 
  --           interrupt <= (others => '0'); 
  --         end if; 
  --       end if; 
  --     end if; 
  -- 
  --   end process INTR_PROC; 
 
  IP2Bus_IntrEvent <= interrupt;  - 割り込みを counterからの出力に接続 
 
  ------------------------------------------ 
  -- Example code to drive IP to Bus signals 
  ------------------------------------------ 
  IP2Bus_Data        <= slv_ip2bus_data; 
  IP2Bus_Ack         <= slv_write_ack or slv_read_ack; 
  IP2Bus_Error       <= '0'; 
  IP2Bus_Retry       <= '0'; 
  IP2Bus_ToutSup     <= '0'; 
 
end IMP; 

 
11.3.1.1. ライブラリ 

ライブラリはデザインデータの集まりで、パッケージ宣言、エンティティ宣言、アーキテクチャ宣言などで構成されま

す。ライブラリを使用すると、コンポーネント宣言を省略することができます。 
 
library opb_sil00u_v1_00_a; 
use opb_sil00u_v1_00_a.all; 
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11.3.2. opb_sil00u.vhd 

opb_sil00u.vhd を開いてください。自動生成されたコードを編集していきます。

opb_sil00u を上位階層として、user_logic 回路を呼び出すコードを追加します。 
 
 
 
 

例 11-3 sil00u（opb_sil00u.vhd） 

------------------------------------------------------------------------------ 
-- opb_sil00u.vhd - entity/architecture pair 
------------------------------------------------------------------------------ 
-- 中略 
library ieee; 
use ieee.std_logic_1164.all; 
use ieee.std_logic_arith.all; 
use ieee.std_logic_unsigned.all; 
 
library proc_common_v2_00_a; 
use proc_common_v2_00_a.proc_common_pkg.all; 
use proc_common_v2_00_a.ipif_pkg.all; 
library opb_ipif_v3_01_c; 
use opb_ipif_v3_01_c.all; 
 
library opb_sil00u_v1_00_a; 
use opb_sil00u_v1_00_a.all; 
 
------------------------------------------------------------------------------ 
-- Entity section 
------------------------------------------------------------------------------ 
entity opb_sil00u is 
  generic 
  ( 
    --中略 
  ); 
  port 
  ( 
    -- ADD USER PORTS BELOW THIS LINE ------------------ 
 
    SEG : out  STD_LOGIC_VECTOR(0 to 7); --7セグメント LEDへの出力信号 
    nSEL: out  STD_LOGIC_VECTOR(0 to 2); --7セグメント LEDセレクト信号 
    nLE : out  STD_LOGIC_VECTOR(0 to 3); --単色 LEDへの出力信号  
    nSW  : in STD_LOGIC_VECTOR(0 to 2); --押しボタンスイッチからの入力信号 
    nCODE : in STD_LOGIC_VECTOR(0 to 3); --ロータリコードスイッチからの入力信号 
 
    -- ADD USER PORTS ABOVE THIS LINE ------------------ 
    -- DO NOT EDIT BELOW THIS LINE --------------------- 
    -- Bus protocol ports, do not add to or delete 
    OPB_Clk                        : in  std_logic; 
    OPB_Rst                        : in  std_logic; 
    Sl_DBus                        : out std_logic_vector(0 to C_OPB_DWIDTH-1); 
    Sl_errAck                      : out std_logic; 
    Sl_retry                       : out std_logic; 
    Sl_toutSup                     : out std_logic; 
    Sl_xferAck                     : out std_logic; 
    OPB_ABus                       : in  std_logic_vector(0 to C_OPB_AWIDTH-1); 
    OPB_BE                         : in  std_logic_vector(0 to C_OPB_DWIDTH/8-1); 
    OPB_DBus                       : in  std_logic_vector(0 to C_OPB_DWIDTH-1); 
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    OPB_RNW                        : in  std_logic; 
    OPB_select                     : in  std_logic; 
    OPB_seqAddr                    : in  std_logic; 
    IP2INTC_Irpt                   : out std_logic 
    -- DO NOT EDIT ABOVE THIS LINE --------------------- 
  ); 
  attribute SIGIS : string; 
  attribute SIGIS of OPB_Clk       : signal is "Clk"; 
  attribute SIGIS of OPB_Rst       : signal is "Rst"; 
  attribute SIGIS of IP2INTC_Irpt  : signal is "INTR_LEVEL_HIGH"; 
 
end entity opb_sil00u; 
------------------------------------------------------------------------------ 
-- Architecture section 
------------------------------------------------------------------------------ 
architecture IMP of opb_sil00u is 
--中略 
begin 
  ------------------------------------------ 
  -- instantiate the OPB IPIF 
  ------------------------------------------ 
  OPB_IPIF_I : entity opb_ipif_v3_01_c.opb_ipif 
    generic map 
    ( 
--中略 
    ) 
    port map 
    ( 
--中略 
    ); 
  ------------------------------------------ 
  -- instantiate the User Logic 
  ------------------------------------------ 
  USER_LOGIC_I : entity opb_sil00u_v1_00_a.user_logic 
    generic map 
    ( 
--中略 
    ) 
    port map 
    ( 
      -- MAP USER PORTS BELOW THIS LINE ------------------ 
 
      SEG => SEG, 
      nSEL => nSEL, 
      nLE => nLE, 
      nSW => nSW, 
      nCODE => nCODE, 
 
      -- MAP USER PORTS ABOVE THIS LINE ------------------ 
      Bus2IP_Clk                     => iBus2IP_Clk, 
      Bus2IP_Reset                   => iBus2IP_Reset, 
      Bus2IP_Data                    => uBus2IP_Data, 
      Bus2IP_BE                      => uBus2IP_BE, 
      Bus2IP_RdCE                    => uBus2IP_RdCE, 
      Bus2IP_WrCE                    => uBus2IP_WrCE, 
      IP2Bus_Data                    => uIP2Bus_Data, 
      IP2Bus_Ack                     => iIP2Bus_Ack, 
      IP2Bus_Retry                   => iIP2Bus_Retry, 
      IP2Bus_Error                   => iIP2Bus_Error, 
      IP2Bus_ToutSup                 => iIP2Bus_ToutSup 
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    ); 
--中略 
end IMP; 

 
 
11.3.3. opb_sil00u_v2_1_0.mpd 

“C:¥suzaku¥sz***- yyyymmdd ¥pcores¥opb_sil00u_v1_00_a¥data”を開い

てください。 
 
 
 
 
 
 
 
 

 
図 11-19 フォルダ構成 

 
opb_sil00u_v2_1_0.mpd を編集します。mpd(Microprocessor Peripheral Definition)ファイルでは信号の入

出力の方向やビット幅等を定義できます。７セグメント LED、7 セグメント LED セレクト、単色ＬＥＤ、押しボタンスイッ

チ、ロータリコードスイッチの信号を外部と接続できるように定義します。 
以下の文を一番下に追加してください。 

例 11-4 opb_sil00u_v2_1_0.mpd 

PORT SEG  = "", DIR = O, VEC = [0:7] 
PORT nSEL  = "", DIR = O, VEC = [0:2] 
PORT nLE  = "", DIR = O, VEC = [0:3] 
PORT nSW  = "", DIR = I, VEC = [0:2] 
PORT nCODE  = "", DIR = I, VEC = [0:3] 

 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                  スロットマシンのコアを CPU で制御する 
 

237

 
11.3.4. opb_sil00u_v2_1_0.pao 

opb_sil00u_v2_1_0.pao を編集します。pao(Peripheral Analyze Order)ファイルはペリフェラルのコンパイル

（構成およびシミュレーション用）に必要な HDL ファイルと、その解析順を指定します。自分で書いたソースコードを

追加します。 
以下の文を一番下に追加してください。 

 
例 11-5 opb_sil00u_v2_1_0.pao 

lib opb_sil00u_v1_00_a sil00u_core vhdl 
lib opb_sil00u_v1_00_a slot_counter vhdl 
lib opb_sil00u_v1_00_a le_seq_blink vhdl 
lib opb_sil00u_v1_00_a seg7_decoder vhdl 
lib opb_sil00u_v1_00_a dynamic_ctrl vhdl 

 
 
11.3.5. opb_sil00u.c 

“C:¥suzaku¥sz***- yyyymmdd ¥drivers¥opb_sil00u_v1_00_a¥src¥opb_sil00u.c”を編集します。

SUZAKU では stdio を使用しておらず、xil_printf( )は生成されません。OPB_SIL00U_Intr_DefaultHandler
関数の中に記述されている xil_printf( )の行をコメントアウトしてください。 

例 11-6 opb_sil00u.c 

void OPB_SIL00U_Intr_DefaultHandler(void * baseaddr_p) 
{ 
  Xuint32 baseaddr; 
  Xuint32 IntrStatus; 
  Xuint32 IpStatus; 
 
  baseaddr = (Xuint32) baseaddr_p; 
 
  /* 
   * Get status from Device Interrupt Status Register. 
   */ 
  IntrStatus = OPB_SIL00U_mReadReg(baseaddr, OPB_SIL00U_INTR_DISR_OFFSET); 
 
//  xil_printf("Device Interrupt! DISR value : 0x%08x ¥n¥r", IntrStatus); 
 
  /* 
   * Verify the source of the interrupt is the user logic and clear the interrupt 
   * source by toggle write baca to the IP ISR register. 
   */ 
  if ( (IntrStatus & INTR_IPIR_MASK) == INTR_IPIR_MASK ) 
  { 
//    xil_printf("User logic interrupt! ¥n¥r"); 
    IpStatus = OPB_SIL00U_mReadReg(baseaddr, OPB_SIL00U_INTR_ISR_OFFSET); 
    OPB_SIL00U_mWriteReg(baseaddr, OPB_SIL00U_INTR_ISR_OFFSET, IpStatus); 
  } 
} 

 
 
これで自作 IP コアの完成です。 
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11.4. 自作 IP コアの追加 

EDK で、自作 IP コアを SUZAKU のデフォルトのプロジェクトに追加します。 
まず、SUZAKU のデフォルトに追加した時のブロック図を見てください。 

 自作 IP コアは、OPB と接続され、外部(押しボタンスイッチや単色 LED)とつながります。 
 

11.4.1. SZ010、SZ030 の場合 
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図 11-20 SZ010、SZ030 のデフォルトに自作 IP コアを追加 
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11.4.2. SZ130 の場合 
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図 11-21 SZ130 のデフォルトに自作 IP コアを追加 
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11.4.3. SZ310 の場合 
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図 11-22 SZ310 のデフォルトに自作 IP コアを追加 
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11.4.4. SZ410 の場合 

PPC405

MMU
ICACHE 16KB
DCACHE 16KB

TIMER

PLB SDRAM
Controller

OPB UART 
lite

OPB Interrupt
Controller

OPB GPIO

PLB
TEMAC

OPB

DDR2 SDRAM

RS232C 
トランシーバ

100MHz

I-PLB

D-PLB

PLB

PLB2
OPB

BRAM

OPB GPIO
ユーザコントロール

LED

Ether PHY

SPI フラッシュ

DDR2 SDRAM

DCM

DCM

DCM

200MHz 1

270
180
90

FX
150MHz

87.5MHz

PPC405

×2

×½

×2

PLB DDR2

×½

起動モードジャンパ
ソフトウェアリセット

OPB SPI S

50MHz

FX

PLB DDR2 
300MHz

175MHz

350MHz

内部ロジック

HARD
TEMAC

OBP SIL00U
ユーザ
I/O

ユーザロジックを接続

 

図 11-23 SZ410 のデフォルトに自作 IP コアを追加 
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11.4.5. ハードウェア設定 

自作コアが、EDK に読み込まれているか確認します。 
EDK に自作コアが作成されたことを伝えるため、[Project]→[Rescan User Repositories]をクリックしてください。 

 

 
図 11-24 自作 IP コア読み込み 

 
 

IP Catalog の Project Repository(EDK9.1i の場合は Project Local pcores)に自分のコア opb_sil00u が追

加されます。 
 
もしうまく追加されなかった場合は、一回 Xilinx Platform Studio を閉じて、再起動し、xps_proj.xmp を開き直

してください。 
 

[Project]→[Rescan User Repositories]をクリック 
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11.4.5.1. IP コアの追加 

opb_sil00u を右クリックして出てくるメニューの Add IP を選択してください。 
opb_sil00u が追加されます。 

 
図 11-25 自作 IP コア追加 

11.4.5.2. OPB バスに接続 
Bus Interface を選択し、opb_sil00u_０の横の丸をクリックしてください。  →  
OPB バスに接続されます。 

 
図 11-26 OPB バスに接続 

IP Catalog のタブをクリック 

Project Repository に自作コア 
opb_sil00u が追加されている 

右クリックしてメニューを出し、 
Add IP を選択 

IP コアが追加される 

Bus Interface を選択 

白丸をクリック  → 
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11.4.5.3. IP コアの設定 
opb_sil00u_0 を右クリックし、メニューの Configure IP...を選択してください。 

 

 
図 11-27 アドレス設定画面呼び出し 

メモリアドレスを設定します。[C_BASEADDR]、[C_HIGHADDR]にメモリアドレスを入力し、[OK]をクリックして下さ

い。メモリアドレスは SUZAKU のメモリマップで Free と書いてあるところに割り当てます。（”1.4 メモリマップ”参照） 

表 11-1 sil00u メモリアドレス 

 SZ010、SZ030
SZ130 SZ310、SZ410 

Base Address 0xFFFFD000 0xF0FFD000 
High Address 0xFFFFD1FF 0xF0FFD1FF 

 

 
図 11-28 アドレス設定 

右クリックしてメニューを出し 
Configure IP を選択 

BASEADDR を入力 

HIGHADDR を入力 
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11.4.5.4. メモリマップ確認 
Addresses を選択し、opb_sil00u_0 の BaseAddress と High Address と Size に間違いがないか、確認してく

ださい。 
 

 
図 11-29 メモリマップ確認 

Addresses を選択 

メモリマップを確認 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                  スロットマシンのコアを CPU で制御する 
 

246

 
11.4.5.5. 信号の定義 

Ports を選択し、opb_sil00u_0 の をクリックして開いてください。mpd ファイルで自分で設定した信号線＋自動

生成された割り込み線が出来上がっていると思います。 
SEG の Net の部分をクリックし、Net 名を SEG と入力し、欄外をクリックし確定させてください。 

 

 
図 11-30 NET 名入力 

Ports を選択 

クリックし、SEG と入力し、確定させる 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                  スロットマシンのコアを CPU で制御する 
 

247

 
もう一度 SEG の Net をクリックし、今度は をクリックし、 [Make External]を選択し、欄外をクリックして確定さ

せてください。 

 
図 11-31 外部信号にする 

Make External を選択し、確定させる 
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External Ports の をクリックして開いてください。Name:SEG_pin という信号が出来上がっています。変えなくても

良いのですが、後々の読みやすさのため信号名を変更します。SEG_pin をクリックし、名前を SEG に変更してくだ

さい。これで、外部出力信号 SEG が定義されます。 
 

 
図 11-32 出力信号定義 

 

クリックし、SEG_pin→SEG に変更 
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nSEL、nLE、nSW、nCODE も SEG と同様の操作を行ってください。 

 

 
図 11-33 残り出力信号定義 

名前を入力し、確定 
↓ 
Make External を選択し、確定 

名前を変更 
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MicroBlaze および PowerPC は外部から 1 つの割り込みしか受けることができません。SUZAKU では、複数の

割り込み要因があるため、割り込みコントローラを用いて、割り込み処理を行います。割り込みが発生すると、割り込

みハンドラが呼び出され、優先順位が高いものから割り込みが処理されます。 
IP2INTC_Irpt の Net に sil_intr と入力し、system_inc の Intr の Net に、sil_intr & と追記してください。こ

れで自作コアの割り込みが割り込みコントローラに接続されます。右側に書いたものほど割り込みの優先順位が高く

なります。 
 

 
 
 
 
 
 
 

図 11-34 割り込みコントローラ 

 

sil_intr & を追記する 

sil_intr と入力し、確定させる 
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11.4.5.6. 割り込み  

SZ310,SZ410 はハードプロセッサの PowerPC なので、設定が SZ010,SZ030,SZ130 と違います。PowerPC
では、EVPR(例外ベクタプレフィックスレジスタ)に割り込みベクタをセットする必要があります。EVPR は上位 16bit
のみが使用され、下位 16bit は無視されるレジスタです。デフォルトのプロジェクトでは、boot セクションが

0xFFFFFFFC にあり、BRAM を 0xFFFFC000～0xFFFFFFFF に割り当てています。EVPR に割り込みベクタ

をセットするためには、0xFFFF0000 まで拡張しないといけないのですが、これだと BRAM の容量が 64kByte に

なってしまいます。SZ310 に採用している Virtex-II Pro は 48kByte の BRAM しか内蔵していないため容量が足

りません。SZ410 では足りないことはありませんが、もったいないので xFFFFC000～0xFFFFFFFF の他に、もうひ

とつ BRAM を用意し、0xFFFF0000～0xFFFF3FFF にセットし、ここに割り込みベクタを割り当てるようにします。

また、text セクションが 15kByte になっていますので、rodata、data、bss なども、0xFFFF0000～0xFFFF3FFF
側に割り当てて、必要容量を分散することにします。plb_bram_if_cntlr を追加して、PLB に接続し、bram_block
を追加して、plb_bram_if_cntlr に接続してください。 
 
 

 
 
 

図 11-35 割り込み設定１ 

bram_block を追加し、 
plb_bram_if_contlr_0 に 接 続

する

plb_bram_if_cntlr を追加し、 
PLB に接続する  
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plb_bram_if_cntlr_0 の設定画面を開き、Base Address に[0xFFFF0000]、 
High Address に[0xFFFF3FFF]と入力し、[OK]をクリックして下さい。 
 

 
図 11-36 割り込み設定 2 

 
 
リンカースクリプトを作ります。[Software]→[Generate Linker Script...]を選択してください。 

 

 
図 11-37 割り込み設定 3 

0xFFFF0000 と入力 

0xFFFF3FFF と入力 
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[Sections View]の Memory の部分を編集し、[Generate]をクリックして下さい。 

 

 
図 11-38 割り込み設定 4 

 

.vecotrs plb_bram_if_cntlr_0 

.text  plb_bram_cntlr 

.rodata  plb_bram_if_cntlr_0 

.sdata2  plb_bram_if_cntlr_0 

.sbss2  plb_bram_if_cntlr_0 

.data  plb_bram_if_cntlr_0 

.fixup  plb_bram_if_cntlr_0 

.sdata  plb_bram_if_cntlr_0 

.sbss  plb_bram_if_cntlr_0 

.bss  plb_bram_if_cntlr_0 

.boot0  plb_bram_cntlr 
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11.4.5.7. ピンアサイン 

Project Files の UCF File:data/xps_proj.ucf をダブルクリックしてください。ピンアサインのファイルが開きます。 
ピンアサインを追加入力し、保存してください。 

 
 

 
図 11-39 自作 IP コア（xps_proj.ucf） 

 

UCF File: data/xps_proj.ucf 
をダブルクリック 
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表 11-2 自作 IP コア ピンアサイン 

 SZ010 
SZ030 SZ130 SZ310 SZ410 

nCODE<0> C8 J1 J16 H5 
nCODE<1> A9 F9 J15 E2 
nCODE<2> A12 E9 J14 D2 
nCODE<3> C10 A10 J13 U9 

nSW<0> A14 D11 K16 L1 
nSW<1> B14 C11 K15 M1 
nSW<2> A13 F11 K14 G4 
SEG<0> C5 L5 F15 P1 
SEG<1> B5 L6 F16 P2 
SEG<2> E6 L4 G13 L2 
SEG<3> D6 L3 G14 M2 
SEG<4> C6 L2 G15 N2 
SEG<5> B6 L1 G16 N3 
SEG<6> A8 C9 N9 Y7 
SEG<7> B8 D9 P9 W7 
nSEL<0> D7 K6 H13 N5 
nSEL<1> C7 K4 H14 M3 
nSEL<2> B7 K3 H15 M4 
ｎLE<0> E11 A11 L13 E1 
ｎLE<1> D11 B11 L14 F1 
ｎLE<2> C12 F12 L15 F2 
ｎLE<3> B12 E12 L16 G2 

 
 
以上で自作コアの追加は終わりです。 
 
11.4.5.8. 自作 IP コア追加 作業まとめ 
 

１． IP コアが EDK に読み込まれているか確認 
２． IP コアを SUZAKU のデフォルトに追加 
３． OPB に接続 
４． アドレスを設定 
５． 入出力信号の接続 
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11.4.6. ネットリスト, プログラムファイル(Hard のみ) 作成 

これで自作 IP コアの追加が終了しました。自作 IP コアに間違いがないかチェックします。 
[Hardware]→[Generate Netlist]  をクリックして下さい。ネットリストが生成されます。 
[Hardware]→[Generate Bitstream]  をクリックして下さい。ソフトウェアを含まない bit

ファイルが生成されます。 
もし自作 IP コアにエラーがある場合、synthesis/opb_sil00u_0_wrapper_xst.srp にログが

表示されるので、これを開いてエラーを確認し、修正を行ってください。 
 
 
 
 
 
 
 

 
図 11-40 エラーレポート 

 
 
 

“synthesis/opb_sil00u_0_wrapper_xst.srp”に 
自作コアのログが格納される 
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11.4.7. BBoot 編集 

今回は、SUZAKU のデフォルトに入っている BBoot に手を加えて、アプリケーションを作成し

ます。 
BBoot とは、FPGA の BRAM に配置され、電源を投入すると最初に動作するプログラムで、

ブートローダ Hermit の起動や書き換えを行うものです。 
 
初めに BBoot のプロジェクトにスロットマシンのサンプルソフトを追加します。 
そして、main.c に変更を加えていきます。 
BBoot に追加するスロットマシンのソフトウェアの仕様を下記に示します。 
 
• スタート検出（押しボタンスイッチ（チャタリング除去）を 2 つ以上押した時、7 セグメント

LED の数字を回転させる） 

• ストップ検出（押しボタンスイッチ（チャタリング除去）を 1 つ押した時、それぞれ対応す

る 7 セグメント LED の数字の回転を停止させる） 

• 3 つの数字一致検出（7 セグメント LED の数字が 3 つそろったら、単色 LED を順次点灯させるトリガー信

号を出力する） 

• 回転速度制御（ロータリコードスイッチの入力により、７セグメント LED の数字の回転速度を変更する） 

• 電源投入時は自作 IP コアからの割り込みでタイミングをはかり、コンソールから"t"の文字を受けたら、ビジ

ーループでタイミングをはかるモードに変更 

 
スロットマシンのソフトウェアは、自作 IP コアからの割り込みでタイミングをはかるモードと、ビジーループでタイミン

グをはかるモードを実装しています。 
組み込みソフトウェアにとって、割り込みは重要機能のひとつです。 

"11.6 ソフトウェアのデバッグ"でデバッカを起動し、サンプルソフトウェアの流れを確認しますので、是非、詳細動作

を確認してください。 
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11.4.7.1.  BBoot フロー 

SUZAKU に電源投入後、最初に動くデフォルトの SUZAKU のブートローダ BBoot は、以下のフローで実行さ

れます。 
 

起動モードジャンパ
オープン？

セカンドブートローダ
Hermit起動

LED D3(赤)点灯

電源投入

モトローラS形式
ダウンロードモード

起動モード選択画面
表示

LED D3(赤)消灯

キー入力待ち

Yes

No

‘S’

Z長押し?

Yes

No

 
 

図 11-41 BBoot のフロー 
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Applications のタブをクリックしてください。BBoot は下記のソースファイル等で構成されます。 

 

 
medium.c UART での送受信 
spi.c SPI フラッシュメモリに対する Read、Write(SZ130,SZ410 で使用) 
srec.c モトローラ S 形式のファイルの受信 
flash.c フラッシュメモリに対する Read、Write（SZ010,SZ030,SZ310 で使用） 
main.c ブートモードのチェック、コマンドの受信、ブートローダ Hermit のコピーとジャンプ、モトローラ S

形式のファイルの受信 
(EDK では、ベクタやリンカがデフォルトで設定されているため、main 関数を書けば、main 関

数からプログラムがスタートするようにコンパイルしてくれます。) 
図 11-42 BBoot の構成 
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下図のように、BBoot にスロットマシンのソフトウェアを追加します。スロットマシンはビジーループ

モードと、割り込みモードの 2 通りで追加します。 
 

 

起動モードジャンパ
オープン？

セカンドブートローダ
Hermit起動

LED D3(赤)点灯

電源投入

モトローラS形式
ダウンロードモード

起動モード選択画面
表示

LED D3(赤)消灯

キー入力待ち

スロットマシンの
割り込み許可

割り込み禁止

スロットマシン
ビジーループ実行

割り込み禁止

Yes

No

‘S’

//Z長押し?
（コメントアウト）

Yes

No

‘T’

割り込み禁止

スロットマシン
割り込み実行

ピンクが
スロット用に

新規追加した所です

グレイは
コメントアウトした

ところです。

 
図 11-43 スロットマシンのフロー 
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11.4.7.2. プロジェクトにソースファイル追加 
 

付属 CD-ROM の”¥suzaku-starter-kit¥fpga”の中の圧縮ファイル “slot_c_source.zip”を展開してください。 
”C¥suzaku¥sz***- yyyymmdd ¥code”フォルダに展開後のフォルダの中の slot.c、interrupt.c、slot.h、

interrupt.h をコピーしてください。 
 

 

 
図 11-44 ソースファイルコピー 

Applications の Sources を右クリックし、メニューの Add Existing Files...を選択し、Sources に slot.c、
interrupt.c を追加してください。 
 

・スタート検出（押しボタンスイッチ（チャタリ
ング除去）を2つ以上押した時、7セグメントLED
の数字を回転させる）

・ストップ検出（押しボタンスイッチ（チャタリ
ング除去）を1つ押した時、それぞれ対応する7セ
グメントLEDの数字の回転を停止させる）

・3つの数字一致検出（7セグメントLEDの数字が3
つそろったら、単色LEDを順次点灯させるトリガ
ー信号を出力する）

・回転速度制御（ロータリコードスイッチの入力
により、７セグメントLEDの数字の回転速度を変
更する）

・割り込みの初期化をし、許可をする

・割り込みの禁止をする

・割り込みが発生した時、スロットマシンを動作
させる
（割り込みハンドラ:timer_interrupt_handler）
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図 11-45 ソースファイル追加 

 

 
図 11-46 ソースファイル選択 

 
Applications の Headers を右クリックし、メニューの Add Existing Files...を選択し、Headers に slot.h、

interrupt.h を追加してください。 
 

右クリックをしてメニューを出し 
Add Existing Files...を選択 

“interrupt.c”、”slot.c”を 
追加 
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図 11-47 ヘッダファイル追加 

 

slot.h、interrupt.h 追加 
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11.4.7.3. main.c ソースコード編集 

Applications タブをクリックしてください。Project:BBootの Sourcesのmain.cをダブルクリックして開いてくださ
い。main.cを編集し BBootにスロットの機能を追加します。 
 

例 11-7 自作 IP コア（main.c） 

#include <ctype.h> 
#include <xuartlite_l.h> 
#include "version.h" 
#include "memmap.h" 
#include "srec.h" 
#include "medium.h" 
#include "spi.h" 
#include "flash.h" 
 
 #include "slot.h"  
 #include "interrupt.h" 
 
#define LED_GPIO(v)    (*(volatile unsigned long *)(LED_REGISTER_BASEADDR) = (v) 
#define LED_ON                    (0) 
#define LED_OFF                   (1) 
 
#define MAX_BUFFER_SIZE         (128) 
 
#ifdef   XPAR_SPI_FLASH_BASEADDR 
#define BOOTLOADER_OFFSET_SPI  (0x00100000) 
#else 
#define FLASH_4MiB (0x16) 
#define FLASH_8MiB (0x17) 
#define BOOTLOADER_OFFSET_4MiB_FLASH (0x00080000) 
#define BOOTLOADER_OFFSET_8MiB_FLASH (0x00100000) 
#endif 
 
//中略 
 
int main(void) 
{ 
    unsigned int bootloader_offset; 
    char      key; 
 
    LED_GPIO(LED_OFF); 
 
#ifdef defined(__PPC__) || defined(__powerpc__) 
    XCache_DisableDCache(); 
    XCache_DisableICache(); 
    XCache_InvalidateICache(); 
    busy_wait(1000000); 
#ifdef XPAR_SPI_FLASH_BASEADDR 
 /* phy reset */ 
    LED_GPIO(LED_OFF|NRST_DISABLE); 
    busy_wait(15000);    /* about 10msec */ 
    LED_GPIO(LED_OFF|NRST_ENABLE); 
    busy_wait(15000);    /* about 10msec */ 
    LED_GPIO(LED_OFF|NRST_DISABLE); 
#else 
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    busy_wait(15000);    /* about 10msec */ 
#endif 
 
    if (get_bootloader_offset(&bootloader_offset) < 0) 
        goto halt; 
 
    if (is_autoboot_mode()) { 
        second_bootloader(bootloader_offset); 
    } 
 
 // myprint("¥r¥n¥r¥n"BBOOT_NAME " v" BBOOT_VERSION " (" TARGET_CPU ")¥r¥n"); 
 // myprint("Press 'z' or 'Z' for BBoot Menu.¥r¥n"); 
 
  /* busy loop to wait getting a char 'z' or 'Z' */ 
 
 // busy_wait(BBOOTMENU_WAITTIME);  
 // if (XUartLite_mIsReceiveEmpty(XPAR_CONSOLE_UART_BASEADDR) || 
 //                          ((key = get_char()) != 0 && key != 'z' && key != 'Z')) 
 //     second_bootloader(bootloader_offset); 
 
 
    interrupt_init();       //割り込み許可 
 
    /* clear for long time pushing */ 
    clear_rx_fifo(); 
    myprint("¥r¥n¥r¥nPlease choose one of the following and hit enter.¥r¥n"); 
    myprint("a: activate second stage bootloader (default)¥r¥n"); 
    myprint("s: download a s-record file¥r¥n"); 
 
    myprint("t: busy loop type slot-machine¥r¥n"); 
 
    while (1) { 
        key = get_char(); 
        switch (key) { 
            case 'a':    /* activate second stage bootloader */ 
            case 'A': 
            case '¥r': 
            case '¥n': 
 
                interrupt_clean();      //割り込み禁止 
 
                second_bootloader(bootloader_offset); 
                break; 
            case 's': 
            case 'S': 
 
                interrupt_clean();      //割り込み禁止 
 
#ifndef XPAR_SPI_FLASH_BASEADDR 
                myprint("Erasing Flash..."); 
                flash_erase(bootloader_offset); 
                myprint("Done¥r¥n"); 
#endif 
                myprint("Start sending S-Record!!¥r¥n"); 
                download(); 
                break; 
 

ここをコメントアウトしない場合、Z の
長押しをしないと、ダウンローダ

Hermitがすぐに起動してしまう 
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            case 't': 
            case 'T': 
                interrupt_clean(); //割り込み禁止 
                myprint("busy loop type slot-machine¥r¥n"); 
                while(1){ 
                     busy_wait(10000); 
                     slot(); 
                } 
 
            default: 
                myprint("Invalid selection.¥r¥n"); 
            case 'z': 
            case 'Z': 
                clear_rx_fifo(); 
                break;             
            } 
        } 
halt: 
    myprint("Halting...¥r¥n");  
    return 0; 
 
} 

 
 
11.4.8. アプリケーション生成 

mian.cの編集が終わったら、[Software]→[Build All User Applications]  をクリックして下さい。コンパイラ
が起動され、各ソフトウェア アプリケーションのプログラム ソースの設定が読み込まれます。 エラーがなければ
executable.elfが出来上がります。 
 
11.4.9. プログラムファイル作成 
ハードウェアでつくった bitファイルの中にソフトウェアを書き込みます。 

 [Device Configuration]→[Update Bitstream] をクリックしてください。bit ファイルが生成されます。エラーが
でたら間違いを修正して再び[Update Bitstream]をクリックしてください。 

コンソールから'T'が入力されたら
ビジーループでスロットマシンを

実行 
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11.4.10. コンフィギュレーション 

JP1,JP2 をショートし、JTAG のコネクタを接続し、シリアルケーブルを向きに注意して接続し

てください。シリアル通信用ソフトウェアを立ち上げ、AC アダプタ 5V を接続して電源を入れてく

ださい。 
 
 
 
 
 
 
 
 
 

CONFIGUART7SEGR-SWLED SW

- 
   +

 
図 11-48 ジャンパの設定等 

 
[Device Configuration]→[Download Bitstream] をクリックしてください。バッチモードの iMPACT を使用し

て FPGA に bit ファイルがコンフィギュレーションされます。 
 

 
11.5. スロットマシン完成 

以上でスロットマシンの完成です！ 
 
11.5.1. スロットマシン動作確認 

スロットが割り込みモードで動きます。色々触って動きを確認してみてください。 
下図のように表示されるので、”T”を押してください。 

 

JP1、JP2 ショート 

電源投入 

ダウンロードケーブル接続 

シリアルケーブル接続 
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図 11-49 スロットマシン実行画面 1 

 
スロットマシンがビジーループモードで動きます。スロットを色々触って動きを確かめてみてください。 
スロットマシンの動きにはほとんど変わりはありませんが大きな違いが一つあります。さきほどまではシリアルコンソ

ールでキー入力を受け付けていましたが、受け付けなくなっていると思います。割り込みでは同時に平行して複数の

作業を行うことができます。割り込みが使えると、できる作業の幅がビジーループに比べ格段に増えます。 

X
i
l
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n
x

S
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a
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E

 
図 11-50 スロットマシン完成 
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11.6. ソフトウェアのデバッグ 

EDK にはプロセッサと通信し、ソフトウェアをデバッグする機能がついています。 
ソフトウェアの処理の流れや変数の確認、メモリのダンプ、CPU レジスタのダンプなどが行え、

ソフトウェアの開発にとても便利です。 
 
このデバッグ機能を用いてスロットマシンのプログラム"interrupt.c"、"slot.c"の動作を確認し

ます。 
今回は、下記の 2 つの動作をステップ実行で確認します。 
 
• 割込みが発生したときの流れ 
• スロットの動作 

 
11.6.1. ソフトウェアデバッグ用に FPGA プロジェクトを更新 

まずは、デバッグが行えるようプロジェクトを更新します。SZ310、SZ410 の場合はプロジェクトを更新しなくてもデ

バッグを行えるので、次のデバッガの設定に進んでください。 
 
microblaze_i を右クリックしてメニューを出し、Configure IP を選択してください。Debug タブをクリックし、

[Enable MicroBlaze Debug Module Interfaｃe]をチェックしてください。デバッグロジックがイネーブルになります。

次にブレークポイント数を設定します。最大 8 まで設定することが出来ます。ここでは、 [Number of PC 
Breakpoints]を 2 にします。設定できたら[OK]をクリックして下さい。 

 

 
図 11-51 MicroBlaze のデバッグ設定 
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今回は FSL を使わないのですが、勝手に FSL の設定をされてエラーが出ることがあります。 
エラーが出たら、MHS ファイルを開き、PARAMETER C_FSL_DATA_SIZE = 32 に変更してください。 

 

 
図 11-52 FSL のエラー 

 
IP Catalog のタブをクリックし、Debug→opb_mdm を追加し、OPB バスに接続してください。 
 

 
図 11-53 opb-mdm を追加してバスに接続 
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opb_mdm_0 を右クリックしてメニューを出し、Configure IP を選択してください。[System]タブをクリックし、

[Base Address]に 0xFFFFE000、[High Address]に 0xFFFFE0FF と入力し、[OK]をクリックして下さい。アドレ

スは SUZAKU のメモリマップの Free のところならばどこでも構いません。("1.4 メモリマップ"参照) 
 

 
図 11-54 デバッガのアドレス設定 
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今回はデバッグのため、プログラムを最適化しないでコンパイルします。そのため、BRAM の容量が足りなくなりま

す。そこで BRAM の容量を 8kByte から 16kByte に増やします。 
d_lmb_bram_if_cntlr を右クリックしてメニューを出し、Configure IP を選択してください。[LMB BRAM High 

Address]を 0x00003ＦＦＦに変更し、[OK]をクリックして下さい。i_lmb_bram_if_cntlr も同様に 0x00003FFF に

変更してください。これで BRAM 容量が 16kByte に変更されます。 
 

 
図 11-55 8kByte → 16kByte に変更 
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11.6.2. デバッガの設定 

 Applications タブをクリックし、[Project: BBoot]→[Compiler Option]をダブルクリックして開いてください。以

下のような画面が表示されます。Debug and Optimization タブをクリックし、最適化をしないので、Optimization 
Level を[No Optimization]にして下さい。[Generate Debug Symbols] 、[Create Symbols for Debugging] が

チェックされているのを確認し、[OK]をクリックしてください。 
 

 
図 11-56 コンパイラオプション 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                  スロットマシンのコアを CPU で制御する 
 

274

 
[Debug] → [XMD Debug Options] をクリックしてください。 
[Connection Type]を[Hardware]、[JTAG Cable]の Type を[Auto]にし、[Auto Discover JTAG Chain 

Definition]をチェックしてください。[JTAG Cable]の Type はお使いのケーブルを選んでいただいてもかまいませ

ん。設定できたら[Save]をクリックし、設定を保存してください。 
 

 
図 11-57 デバッグオプション 

以上でプロジェクトの更新は終わりです。 
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[Device Configuration]→[Update Bitstream] をクリックしてください。 
SZ130 の場合、次のようなエラーが出る場合があります。 

 
ERROR:Place:249 - Automatic clock placement failed.  Please attempt to analyze the 
Global clocking required for thisdesign and either lock the clock placement or area 
locate the logic driven by the clocks so that that the clocks may be placed in such 
a way that all logic driven by them may be routed.  The main restriction on clock 
placement is that only one clock output signal for any Primary / Secondary pair of 
clocks may enter any region.  For further information see the "Using Global Clock 
Networks" section in the V-II User Guide (Chapter 2: Design Considerations) 
Phase 4.30 (Checksum:26259fc) REAL time: 53 secs  
 
#中略 
 
PAR done! 
ERROR:Xflow - Program par returned error code 31. Aborting flow execution...  

 
この場合、MHS ファイルを開き、SPI_SCK の信号定義部分に"SIGIS = CLK"と追記してください。 
 
PORT SPI_SCK = SPI_SCK, DIR = IO, SIGIS = CLK 
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11.6.3. XMD の起動 

XMD とは、プロセッサ(MicroBlaze や PowerPC)と PC のデバッグアプリケーションの仲立ちをしてくれるもので

す。XMD とデバッグアプリケーションは、TCP 経由でやり取りをしますので、ネットワーク経由でも接続できます。 
 

PC

GDB XMD
TCP/IP

MDM

FPGA

SUZAKU

JTAG

 
図 11-58 XMD の接続 

 
[Device Configuration]→[Download Bitstream] をクリックして下さい。FPGA にデバッグ機能付きのスロッ

トマシンのコンフィギュレーションデータがダウンロードされます。 
 

[Debug]→[Launch XMD...] をクリックして下さい。 
コマンドプロンプトが立ち上がり、以下のように表示されます。 

例 11-8 XMD の起動ログ(SZ130 の場合) 

Xilinx Microprocessor Debug (XMD) Engine 
Xilinx EDK 8.2.02 Build EDK_Im_Sp2.4 
Copyright (c) 1995-2005 Xilinx, Inc.  All rights reserved. 
 
XMD% 
Loading XMP File.. 
Processor(s) in System :: 
 
Microblaze(1) : microblaze_i 
Address Map for Processor microblaze_i 
  (0x00000000-0x00001fff) d_lmb_bram_if_cntlr   d_lmb_v10 
  (0x00000000-0x00001fff) i_lmb_bram_if_cntlr   i_lmb_v10 
  (0x80000000-0x81ffffff) sdram_controller      d_opb_v20 
  (0x80000000-0x81ffffff) sdram_controller      microblaze_IXCL 
  (0x80000000-0x81ffffff) sdram_controller      microblaze_DXCL 
  (0xff000000-0xff0001ff) spi_flash     d_opb_v20 
  (0xffe00000-0xffe0ffff) system_memcon d_opb_v20 
  (0xffff1000-0xffff10ff) system_timer  d_opb_v20 
  (0xffff2000-0xffff20ff) console_uart  d_opb_v20 
  (0xffff3000-0xffff30ff) system_intc   d_opb_v20 
  (0xffffa000-0xffffa1ff) opb_gpio_0    d_opb_v20 
  (0xffffa200-0xffffa3ff) led_gpio      d_opb_v20 
  (0xffffa600-0xffffa6ff) opb_uartlite_0        d_opb_v20 
  (0xffffd000-0xffffd1ff) opb_sil00_0   d_opb_v20 
  (0xffffe000-0xffffe0ff) opb_mdm_0     d_opb_v20 
 
Connecting to cable (Parallel Port - LPT1). 
Checking cable driver. 
 Driver windrvr6.sys version = 7.0.0.0. LPT base address = 0378h. 
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 ECP base address = 0778h. 
Cable connection established. 
 
JTAG chain configuration 
-------------------------------------------------- 
Device   ID Code        IR Length    Part Name 
 1       01c2e093           6        XC3S1200E 
Assuming, Device No: 1 contains the MicroBlaze system 
Connected to the JTAG MicroProcessor Debug Module (MDM) 
No of processors = 1 
 
MicroBlaze Processor 1 Configuration : 
------------------------------------- 
Version............................4.00.b 
No of PC Breakpoints...............2 
No of Read Addr/Data Watchpoints...0 
No of Write Addr/Data Watchpoints..0 
Instruction Cache Support..........on 
Instruction Cache Base Address.....0x80000000 
Instruction Cache High Address.....0x81ffffff 
Data Cache Support.................on 
Data Cache Base Address............0x80000000 
Data Cache High Address............0x81ffffff 
Exceptions  Support................off 
FPU  Support.......................off 
FSL DCache Support.................on 
FSL ICache Support.................on 
Hard Divider Support...............on 
Hard Multiplier Support............on 
Barrel Shifter Support.............on 
MSR clr/set Instruction Support....on 
Compare Instruction Support........on 
JTAG MDM Connected to MicroBlaze 1 
Connected to "mb" target. id = 0 
Starting GDB server for "mb" target (id = 0) at TCP port no 1234 
XMD% 

 
以上のようにコンソールに表示がでたら、起動成功です。 
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11.6.4. GDB を起動し、ソフトウェアのスタートをさせる 

GDB はソフトウェアデバッグのユーザインターフェースになります。まずは GDB を起動します。 
[Debug]→[Launch Software Debugger] をクリックして下さい。以下の画面が立ち上がります。 
ここではデフォルト設定のままとします。そのまま[OK]をクリックして下さい。立ち上がらない場合は[File]→

[Target Settings...]から以下の画面を立ち上げることが出来ます。 
 

 
図 11-59 デバッグ設定 

以 下 の 画 面 が 立 ち 上 が り ま す 。 [Run] → [Run] を ク リ ッ ク し て 下 さ い 。 main 関 数 で Break し ま す 。

LED_GPIO(LED_OFF)が緑色にハイライトされるとおもいます。 

 
図 11-60 main で Break 
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11.6.5. ステップ実行で割り込みの流れをみる 

 [View]→ [Breakpoints]をクリックして下さい。現在の Breakpoint が表示されます。 "main"と "exit"に

Breakpoint が設定されています。Breakpoint は割り込みベクタだけでいいので、[Global]→[Remove All]をクリ

ックし、Breakpoint を消去してください。 
MicroBlaze の割り込みベクタは 0x10、PowerPC の割り込みベクタは 0xFFFF0500 です。ここに Breakpoint

を設定します。 
XMD で以下のコマンドを実行してください。 

例 11-9 Breakpoint 設定(SZ010, SZ030, SZ130 の場合) 

XMD% bps 0x10 hw 

 
例 11-10 Breakpoint 設定(SZ310, SZ410 の場合) 

XMD% bps 0xFFFF0500 hw 

 
 
 
 

 
 
TIPS  XMD コマンド 

 
コマンド 使用例 説明 

bps <address/function> <hw/sw> bps 0x10 sw 
bps main hw 

address または function の開始部分にハード

ウェアまたはソフトウェアブレークポイントを設定 
bpr <address/function/all> bpr 0x10 

bpr main 
bpr all 

ブレークポイントを削除 

bpl bpl 現在のブレークポイントを表示 
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__interrupt_handler( )には、 
PORT INTERRUPT に接続されているコア 
(SUZAKU では OPB-INTC)の割込みハンドラ

(XIntc_DeviceInterruptHandler( ) ) 
へジャンプする命令が記述されています。 

 
[Continue]をクリックしてください。割り込みハンドラ 0x10（PowerPC の場合は 0xFFFF0500）で Break します。 
ここから[Step]で順に動きを見ます。どのように割り込みが入るのかが分かります。 

 

 
図 11-61 0x10 で Break 

 [Step]を押してください。 
 

 
図 11-62 _interrupt_handler( )で Break 

 
 
 

MicroBlaze の場合、割込みが入ると 割込みベ

クタ 0x10 にジャンプします。 
PowerPC の場合、割り込みが入ると割り込みベ

クタ 0xFFFF0500 にジャンプします。 
これらのアドレスは、FPGA 内部の BRAM の領

域です。MicroBlaze の場合、割込みハンドラ

__interrupt_handler( )へのジャンプ命令が記

述 さ れ て い ま す 。 PowerPC の 場 合 、

XIntc_DeviceInterruptHandler( )へのジャン

プ命令が記述されています。 
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XIntc_DeviceInterruptHandler( ) に は 、

OPB-INTC の PORT Intr に接続されている

コア達の中から、実際に割込みを発生させたコ

アを見つけ、そのコアの割込みハンドラへのジ

ャンプする命令が記述されています。 

OPB-SIL00 は"Default Handler"ではなく、 
timer_interrupt_handler を 使 用 し て い ま

す。 

何度か[Step]を押してみてください。 
 

 
図 11-63 XIntc_DeviceInterruptHandler( )で Break 

 
 

 
図 11-64 timer_interrupt_handler( )で Break 
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11.6.6. slot.c の動作を確認してみる 

 
slot.c にジャンプしてきました。 
[View]→[Loval Variables]をクリックして下さい。ローカル変数の一覧が表示されます。 
[View]→[Stack]をクリックして下さい。現在スタックしている関数の一覧が表示されます。 
ステップ実行やその他メニューの[View]で開くことのできる各種情報を元に、ソースコードと合わせてプログラムの

流れやローカル変数を参照し、スロットの動作を確認してください。 
かなりのステップ実行をしなくてはいけませんが、7 セグメント LED に 3→2→1 と数字が表示される様子を見るこ

とが出来ます。また、slot.c の一通りの動作が終わると、スタックにしたがって、関数が戻っていく様子を見ることが出

来ます。 
 

 
図 11-65 slot( )で Break 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図 11-66 ローカル変数やスタックの一覧 
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12. こんなこともやってみよう 
 

 
 

最後にこんなこともできますというのを紹介します。* 
 
12.1. EDK を ISE のサブモジュールとして読み込む 

ここでは EDK を ISE のサブモジュールとして読み込む方法を説明します。 
SUZAKU は EDK だけで構築されています。EDK だけで作業しても良いのですが、

EDK だけで作業すると、自分で書いたロジックを追加したい時に、EDK に読み込めるよ

うにしなければいけません。自分のロジックのほかにロジック追加用の設定ファイル(mpd
ファイル、pao ファイル)を書かなければいけなかったり、Xilinx の命名規則にのっとって

いなければならなかったりします。EDK に読み込めるようにしておけば、再利用しやすい

というメリットはあるのですが、少々面倒です。 
EDK と ISE は連携しており、EDK で構築生成させたネットリストを ISE でサブモジュ

ールとして読み込ませることができます。この機能を使えば、EDK で GPIO や簡単な OPB インターフェースだけを

用意しておき、EDK の External 設定することで、ISE でこれらの信号をサブモジュールの入出力として取り扱える

ようになり、ISE で作りこんだ自分のロジックへ容易に組み込むことができます。 
さらに、自分のロジックのみに変更があった場合、開発フローの ISE のみを実行するだけですむので、コンパイル

時間を半減させることができます。また、ISE は、配置配線ツールや制約ツール、タイミング解析ツールなど GUI で

設定することができ分かりやすいです。 
 
ISE と EDK を連携させるには、 
1. EDK から ISE のプロジェクトを生成させる(EDK で Export to Project Navigator を実行する)  
2. ISE に EDK を取り込む 
の２通りがあります。1 の方法は今後サポートされなくなる予定なので、ここでは、2.の"ISE に EDK を取り込む方

法"を紹介します。 
 
2006 年 4 月以前の SUZAKU は EDK を ISE のサブモジュールとして読み込んでプロジェクトを作成していま

した。この 2 の方法により、EDK だけで構築されている SUZAKU のプロジェクトを、昔の EDK を ISE のサブモジ

ュールとして読み込んだプロジェクトにつくりかえることができます。 
 

                                                  
* SZ410 に関しては現在動作確認中につき少々お待ちください。 

EDK

ISE
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12.1.1. EDK で作業 

例として SUZAKU のデフォルトの EDK のプロジェクトを ISE に取り込みます。 
付属 CD-ROM の”¥suzaku¥fpga_proj¥x.x¥sz***¥sz***- yyyymmdd.zip”をハードディスクに展開してくだ

さい。 
適当な名前のフォルダを作り、フォルダの下に、展開した EDK フォルダをコピーしてください。ここで

は”C:¥suzaku¥suzaku-ise¥sz***- yyyymmdd”として作業を進めます。 
”C:¥suzaku¥suzaku-ise¥sz***- yyyymmdd”の中の”xps_proj.xmp”をダブルクリックして開いてください。 
Xilinx Platform Studio が起動し、SUZAKU のデフォルトが開きます。 
ISE/EDK が 8.1i の場合、[Project]→[Project Options...]をクリックし、Hierarchy and Flow タブをクリックして

下さい。 
 

 
図 12-1 EDK SUZAKU のデフォルト 
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 [Processor Design is a ・・・・・]と、[Use Project Navigator ・・・・・]の 2 つをチェックしてください。 
 

 
図 12-2 ISE/EDK8.1i の場合のオプション設定 

 
[Hardware]→[Generate Netlist] をクリックし、ネットリストを作成してください。 
ネットリストを作成すると、”C:¥suzaku¥suzaku-ise¥sz***- yyyymmdd ¥hdl”に xps_proj_stub.vhd というファ

イルが出来上がります。 
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12.1.2. EDK から ISE へ移行 
この xps_proj_stub.vhd を"C:¥suzaku¥suzaku-ise"にコピーしてください。この際、この名前のままだと少し分か

りづらいので、ファイルの名前を top.vhd に変更してください。（もちろん変えなくても良いです。。） 
 

 
 

 
図 12-3 xps_proj_stub.vhd をコピー 

xps_proj_stub.vhd をコピーして名前を top.vhd に変更 
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12.1.3. ISE で作業 
Project Navigator を起動してください。[File]→[New Project]をクリックしてください。 

 

 
図 12-4 Project Navigator 起動 

 
New Project Wizard が表示されます。[Project Location]の[…]をクリックし、プロジェクトのディレクトリパスを指

定します。ここでは C:¥suzaku¥suzaku-ise となります。[Project Name]に プロジェクト名を入力します。 top と

入力し、[Top-Level Source Type]が[HDL]となっていることを確認し、[Next]をクリックしてください。 
 

 
 

図 12-5 プロジェクトの新規作成 
 
 
 
 

[File]→[New Project]をクリック

ディレクトリパスを指定 

確認 
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SUZAKU に実装されている FPGA デバイスを選択します。お使いの SUZAKU の型式の設定にし、[Next]をク

リックしてください。 
 

型式 SZ010 SZ030 SZ130 SZ310 SZ410 
Product Category All 
Family Spartan3 Spartan3E Virtex2P Virtex４ 
Device XC3S400 XC3S1000 XC3S1200E XC2VP4 XC4VFX12
Package FT256 FG320 FG256 SF363 
Speed －4 －5 －10 
Synthesis Tool XST(VHDL/Verilog) 
Simulator ISE Simulator(VHDL/Verilog) 

 

 
図 12-6 デバイスの選択(SZ130 の場合) 

 
後は設定の変更をしないので、[Next]、[Finish]をクリックし、ウィザードを終了してください。 
 
top.vhd と xps_proj.xmp と xps_proj.ucf をプロジェクトに追加します。[Project]→[Add Source]をクリックしてフ

ァイルを追加してください。xps_proj.xmｐは”C:¥suzaku¥suzaku-ise¥sz***- yyyymmdd”の下に xps_proj.ucf
は 

”C:¥suzaku¥suzaku-ise¥sz***- yyyymmdd ¥data”の下にあります。 
 
xps_proj_stub をダブルクリックして開いてください。ライブラリの追加を行います。また、少し分かりづらいので、

STRUCTURE となっているアーキテクチャ名を IMP に変更し(2 箇所)、xps_proj_stub となっているエンティティ

名を top に変更します(3 箇所)。（ライブラリの追加は必須です。名前の変更は必須ではありません。。） 
変更ができたら[File]→[Save]をクリックし、保存してください。 

デバイスの選択 

デザインフローの選択 
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library IEEE; 
use IEEE.STD_LOGIC_1164.ALL; 
 
use IEEE.STD_LOGIC_ARITH.ALL; 
use IEEE.STD_LOGIC_UNSIGNED.ALL; 
 
library UNISIM; 
use UNISIM.VCOMPONENTS.ALL; 
 
entity top is 
  port ( 
    --中略 
  ); 
end top; 
 
architecture IMP of top is 
  component xps_proj is 
  port ( 
    --中略 
  ); 
  end component; 
begin 
  xps_proj_i : xps_proj 
    port map ( 
    --中略 
    ); 
end architecture IMP; 

図 12-7 ソースコード入力 

ライブラリを追加 
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Generate Programming File をダブルクリックして下さい。ソフトウェアを含まない bit ファイルが生成されます。 
Update Bitstream with Processor Data をダブルクリックして下さい。ハードウェアでつくった bit ファイルの中

にアプリケーションを書き込みます。top_download.bit が出来上がります。 
SZ310 のプロジェクトを ISE 8.1i で作っている場合、ハードウェアでつくった bit ファイルの中にアプリケーション

がうまく書き込まれず、top_download.bit がきちんと生成されないことがあります。コマンドプロンプト等を立ち上げ、

"C:¥suzaku¥suzaku-ise"に移動し、以下のコマンドで新たに bit ファイルを生成してください。 
 

data2mem -bm sz310- yyyymmdd¥implementation¥xps_proj_bd.bmm  
 -bt top.bit  
 -bd sz310- yyyymmdd ¥ppc405_i¥code¥executable.elf  
 tag bram -o b top_new.bit 

 
 
iMPACT を立ち上げ、top_download.bit(top_new.bit)を書き込んでください。SUZAKU のデフォルトが書き込

まれます。 
 
EDK で External の信号を追加削除した場合は、ネットリストを作成し直し、新たに生成された 
xps_proj_stub.vhd を参考に、top.vhd の xps_proj の component 宣言および、そのインスタンスに変更を加

えてください。 
ISE はコンパイル前に EDK に変更がないか確認をします。EDK で mhs ファイルや mss ファイル、ソフトウェアを

変更した場合、自動的にバックエンドで EDK を動作させコンパイルを実行してくれます。
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12.2. IP コア(ハード版) 

先ほどソフトウェアで実現したスロットマシンの機能をハードウェアに置き換え、ソフトの負担を減らすことができます。 
実はこちらの方法のほうが SUZAKU らしいやり方といえます。slot.vhd の中身の説明はしませんので、各自見て

考えてみてください。ソフト版と違うのはカウンタのみで、他はほぼ同じ作りになっています。 

７セグメントLEDの数
字をデコード

seg7_decoder

slot.vhd

単色LED
順次点灯

le_seq_blink

７セグメントLED
ダイナミック点灯
dynamic_ctrl

ロータリコードスイッチの情報を送る
(code)

セグメント値の設定を受ける
(seg_in1,seg_in2,seg_in3)

単色LEDの順次点灯の
トリガ信号を受ける
(le_trig)

押しボタンスイッチの入力（nSW）

ロータリコードスイッチの入力（nCODE）

７セグメントLEDの
セレクト信号を出力（nSEL）

７セグメントLEDに値を出力（SEG）

単色LEDに出力（nLE）

チャタリング
除去

ステートマシン

回転速度制御

スタート検出
ストップ検出

押しボタンスイッチの情報を送る
(sw)

sil00h_core.vhd

3つの数字の
一致検出

カウンタ
slot_counter

7セグメントLED
数値の回転

CPUから
読み込み可能

CPUから
読み込み可能

 
図 12-8 IP コア（ハード版）の仕様 

 
“C¥suzaku¥sz***- yyyymmdd”をコピーしてその場にペーストし、名前を変更してください。 
ここでは”C¥suzaku¥sz***-h- yyyymmdd”として作業を進めます。 
付属 CD-ROM の”suzaku-starter-kit¥fpga¥opb_sil00h_vx_xx_x.ziｐ”をハードディスクに展開してください。 
展開後のフォルダ”opb_sil00h_v1_00_a”を”C¥suzaku¥sz***-h- yyyymmdd ¥pcores”にコピーしてください。 
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図 12-9 IP コア（ハード版）追加 

 
”C:¥suzaku¥szz***-h- yyyymmdd”の中の”xps_proj.xmp”を開いてください。 
IP Catalog の Project Repository に opb_sil00h があるのを確認してください。 

 

 
図 12-10 IP コア(ハード版)追加確認 
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自作 IP コア（ソフト版）opb_sil00u を IP コア（ハード版）opb_sil00h に置き換えます。opb_sil00h は割り込みを

使用していないので、割り込みに関する記述を削除します。 
まず、ハードウェアの変更をします。 
 

Project の MSS File: xps_proj.mss をダブルクリックして開いてください。opb_sil00u のドライバの記述をしてい

るところを探して削除し、保存してください。opb_sil00h ではドライバを使用しません。 
 

 
図 12-11 MSS File 変更 

 
Project の MHS File: xps_proj.mhs をダブルクリックして開いてください。 
opb_sil00u を記述しているところを探してこれを opb_sil00h の記述に変更します。その際、HW_VER があって

いるかも確認してください。 
opb_intc を記述しているところを探して、割り込みの記述を削除します。 
変更が終わったら保存してください。 

 

 
図 12-12 MHS File 変更 

削除 

BEGIN opb_sil00h に変更 
HW_VER があっているか確認 

PORT IP2INTC_Irpt = sil_intr
を削除

sil_intr &を削除 
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以上で IP コアが置き換わりました。 

IP Type が opb_sil00h に変更されます。 
 

 
図 12-13 IP コア（ハード版）に置き換え 

次にソフトウェアから割り込みの設定、記述を削除していきます。 
Applications の Sources から interrupt.c、Headers から interrupt.h を削除してください。これらのファイルは使

用しません。 
 

 
図 12-14 不要なファイルの削除 

 
 

interrupt.c
interrupt.h 
を削除 
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Applications の main.c をダブルクリックして開いてください。 
割り込みに関する記述が全部で 5 箇所にあるのでこれを全て削除してください。削除する記述は 
 #include "interrupt.h" 
 interrupt_init(); 
 interrupt_clean(); ×3 

です。例 11-7  自作 IP コア（main.c）を参考に探してください。削除できたら保存してください。 
 

 
図 12-15 main.c から割り込みの記述を削除 

 
これで変更は終了です。コンフィギュレーションしてください。数字の回転が少し速いですが、ソフト版とほぼ同じス

ロットマシンが動きます。 
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12.3. CGI で 7 セグメント LED をコントロール 

自分で作ったスロットマシンの IP コアを CGI でコントロールします。“C:¥suzaku¥sz***- yyyymmdd 
¥implementation”の中にある download.bit をつかって フラッシュメモリを書き換えてください。 

フラッシュメモリの中に入っている Linux では最初から CGI が動作しています。 
(フラッシュメモリの中の Linux を書き換えてしまっている場合は、フラッシュメモリの image を書き直して下さい。

image は付属 CD-ROM の”¥suzaku-starter-kit¥image”の中の image-sz***-sil.bin を使ってください。) 
シリアル通信ソフトウェアを起動後、SUZAKU スターターキットの JP1、JP2 をオープンにして電源を投入してく

ださい。Linux が起動するので、ネットワークの設定をしてください。 
IP アドレスを確認し、お使いのブラウザで”http://IP アドレス/7seg-led-control.cgi”にアクセスしてください。スロ

ットマシンの７セグメント LED の回路がブラウザから制御できます。 

 

X
il
in
x

Sp
ar

ta
n3
E

 
図 12-16 自作のコアをコントロール 

1~F(16 進数)の数字を設定

して[OK]をクリックすると、７

セグメント LED に設定した

数字が表示される 
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これは、以下のソースコードで CGI を作成することにより実現しています。以下のソースコードだけでは CGI を作

成することはできませんので、ご注意ください。 
CGI の作成方法やコンパイル方法、フラッシュメモリに書き込むためのデータの作成方法等ついては、"SUZAKU 

スターターキットガイド（Linux 開発編）"、"SUZAKU ソフトウェアマニュアル"、"uClinux-dist Developers Guide"
を参照してください。 
 
12.3.1. 7seg-led-control.c 

例 12-1 CGI で 7 セグメント LED をコントロール(7seg-led-control.c) 

#include <sys/types.h> 
#include <sys/stat.h> 
#include <fcntl.h> 
#include <unistd.h> 
#include <stdio.h> 
#include <string.h> 
#include <stdlib.h> 
 
#define PROGRAM_NAME             "7seg-led-control" 
#define CGI_PATH PROGRAM_NAME    ".cgi" 
 
#define DEV_NAME                 "/dev/sil7segc" 
 
#define FORM_OK_BUTTON           "ok_button" 
#define FORM_LED1_TEXT_BOX       "led1" 
#define FORM_LED2_TEXT_BOX       "led2" 
#define FORM_LED3_TEXT_BOX       "led3" 
 
static void print_content_type(void) 
{ 
  printf("Content-Type:text/html¥n¥n"); 
} 
 
static void print_style_sheet(void) 
{ 
  printf("<style type=¥"text/css¥">¥n¥n"); 
 
  printf("body {¥n"); 
  printf("margin: 0 0 0 0;¥n"); 
  printf("padding: 10px 10px 10px 10px;¥n"); 
  printf("font-family: Arial, sans-serif;¥n"); 
  printf("background: #ffffff;¥n"); 
  printf("}¥n¥n"); 
 
  printf("h1 {¥n"); 
  printf("margin: 0 0 0 0;¥n"); 
  printf("padding: 0 0 0 0;¥n"); 
  printf("color: #cc0000;¥n"); 
  printf("font-weight: normal;¥n"); 
  printf("}¥n¥n"); 
 
  printf("h2 {¥n"); 
  printf("margin: 0 0 0 0;¥n"); 
  printf("padding: 0 0 0 0;¥n"); 
  printf("font-size: 14px;¥n"); 
  printf("}¥n¥n"); 
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  printf("hr {¥n"); 
  printf("height: 1px;¥n"); 
  printf("background-color: #999999;¥n"); 
  printf("border: none;¥n"); 
  printf("margin: 5px 0 70px 0;¥n"); 
  printf("}¥n¥n"); 
 
  printf(".leds {¥n"); 
  printf("font-size: 12px;¥n"); 
  printf("font-weight: bold;¥n"); 
  printf("line-height: 20px;¥n"); 
  printf("}¥n¥n"); 
 
  printf("</style>¥n¥n"); 
} 
 
static void print_html_head(void) 
{ 
  printf("<!DOCTYPE html PUBLIC ¥"-//W3C//DTD XHTML 1.0 Transitional//EN¥" 
                     ¥"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd¥">¥n"); 
  printf("<html xmlns=¥"http://www.w3.org/1999/xhtml¥" lang=¥"ja¥" xml:lang=¥"ja¥">¥n¥n");
 
  printf("<head>¥n¥n"); 
 
  printf("<meta http-equiv=¥"content-type¥" content=¥"text/html; charset=utf-8¥"/>¥n¥n"); 
  printf("<title>%s</title>¥n¥n", PROGRAM_NAME); 
 
  print_style_sheet(); 
 
  printf("</head>¥n¥n"); 
 
  printf("<body>¥n¥n"); 
} 
 
static void print_html_tail(void) 
{ 
  printf("</body>¥n¥n"); 
  printf("</html>¥n"); 
} 
 
static void display_page(int fd) 
{ 
  unsigned char leds[3]; 
 
  read(fd, leds, 3); 
 
  print_content_type(); 
 
  print_html_head(); 
 
  printf("<h1>7SEG LED CONTROL</h1>¥n"); 
  printf("<h2>ATMARK TECHNO</h2>¥n¥n"); 
 
  printf("<hr />¥n¥n"); 
 
  printf("<form action=¥"%s¥" method=¥"get¥">¥n¥n", CGI_PATH); 
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  printf("<table border=¥"0¥" cellpadding=¥"10¥" cellspacing=¥"0¥" width=¥"200px¥" 
                                                       align=¥"center¥" class=¥"leds¥">¥n"); 
 
  printf("<tr>¥n"); 
 
  printf("<td align=¥"center¥">"); 
 
  printf("LED3<br />¥n"); 
  printf("<input type=¥"text¥" name=¥"%s¥" value=¥"%x¥" size=¥"1¥" maxlength=¥"1 
                                                       ¥"/>¥n",FORM_LED3_TEXT_BOX, leds[2]); 
 
  printf("</td>¥n<td align=¥"center¥">"); 
 
  printf("LED2<br />¥n"); 
  printf("<input type=¥"text¥" name=¥"%s¥" value=¥"%x¥" size=¥"1¥" maxlength=¥"1 
                                                      ¥" />¥n",FORM_LED2_TEXT_BOX, leds[1]); 
 
  printf("</td>¥n<td align=¥"center¥">"); 
 
  printf("LED1<br />¥n"); 
  printf("<input type=¥"text¥" name=¥"%s¥" value=¥"%x¥" size=¥"1¥" maxlength=¥"1 
                                                      ¥" />¥n",FORM_LED1_TEXT_BOX, leds[0]); 
 
  printf("</td>¥n"); 
 
  printf("</tr><tr>¥n"); 
 
  printf("<td colspan=¥"3¥" align=¥"center¥">¥n"); 
 
  printf("<input type=¥"submit¥" value=¥"OK¥" name=¥"%s¥" />¥n", FORM_OK_BUTTON); 
 
  printf("</td>¥n"); 
 
  printf("</tr>¥n"); 
 
  printf("</table>¥n¥n"); 
 
  printf("</form>¥n¥n"); 
 
  print_html_tail(); 
} 
 
static unsigned int get_query_pair_hex_value(char *query, char *query_pair_name) 
{ 
  char *pair_start, *pair_value; 
  unsigned int hex_value = 0; 
 
  pair_start = strstr(query, query_pair_name); 
  if (pair_start) { 
    pair_value = strchr(pair_start, '=') + 1; 
    if (pair_value) { 
      sscanf(pair_value, "%x", &hex_value); 
    } 
  } 
  return hex_value; 
} 
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static void handle_query(int fd) 
{ 
  char *query; 
  unsigned char leds[3]; 
 
  query = getenv("QUERY_STRING"); 
  if (!query) { 
    return; 
  } 
 
  if (!strstr(query, FORM_OK_BUTTON)) { 
    return; 
  } 
  leds[0] = (unsigned char) get_query_pair_hex_value(query, FORM_LED1_TEXT_BOX); 
  leds[1] = (unsigned char) get_query_pair_hex_value(query, FORM_LED2_TEXT_BOX); 
  leds[2] = (unsigned char) get_query_pair_hex_value(query, FORM_LED3_TEXT_BOX); 
  write(fd, leds, 3); 
} 
 
int main(int argc, char *argv[]) 
{ 
  int fd; 
  fd = open(DEV_NAME, O_RDWR); 
  handle_query(fd); 
  display_page(fd); 
  close(fd); 
 
  exit(EXIT_SUCCESS); 
} 
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12.4. SDK を使ってデバッグ 

Eclipse ベースの SDK(Software Develpment Kit)でデバッグします。11.6 ソフトウェアのデバッグと基本的に

出来ることは同じです。 
"11.6.1 ソフトウェアデバッグ用に FPGA プロジェクトを更新"の作業まで行ったプロジェクトを開き、[Software]→

[Launch Platform Studio SDK] をクリックして下さい。 
 

 
図 12-17 SDK 起動 

 
SDK でプロジェクトを開く前に、以下の画面が表示されます。良ければ[OK]をクリックして下さい。 

 

 
図 12-18 SDK 起動の際の注意 
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以下のウィザードが立ち上がるので[Import XPS Application Projects]を選択し、[Next]をクリックして下さい。 
 

 
図 12-19 アプリケーションのインポート 

 
BBoot にチェックをし、[Finish]をクリックして下さい。 
 

 
図 12-20 BBoot のインポート 
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BBoot がインポートされます。インポート後自動的に Build され、BBoot.elf が作成されます。(SDK

の設定によっては Build されません)BBoot の上で右クリックをし、メニューの[Propeties]を選択してく

ださい。 

 
図 12-21 Build 設定 

C/C++ Build を選択し、Configuration Settings の Tool Settings タブの Debug and Optimization を選択

し、Optimization Level を[No Optimization]に設定して[OK]をクリックして下さい。 

 
図 12-22 Optimization Level 設定 
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変更があった場合は自動的に Build されます。自動的に Build されない場合は BBoot の上で右クリックをし、メ

ニューで Build Project を選択し、Build して下さい。 
 

 
図 12-23 BBoot.elf 作成 

 
[Device Configuration]→[Program Hardware Settings]をクリックし、Initialization ELF に先ほど作成され

た BBoot.elf ファイルを指定し、[Save]をクリックして下さい。 
 

 
 
 
 
 

図 12-24 Program Hardware Setting 
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[Device Configuration]→[Program Hardware]をクリックして下さい。FPGA にデバッグ機能付きのスロットマ

シンのコンフィギュレーションデータがダウンロードされます。 
 

 
図 12-25 コンフィギュレーションデータダウンロード 

 
 

BreakPoint を設定します。今回は BreakPoint を timer_interrupt_handler に設定します。interrupt.c を開

き、int timer_interrupt_handler と書いてある行を探し、行の数字の横でダブルクリックして下さい。BreakPoint
が設定されます。 

 

 
図 12-26 BreakPoint 設定 
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[Run]→[Debug]をクリックして下さい。 
 

 
図 12-27 デバッガの設定 

 
以 下 の 画 面 が 表 示 さ れ る の で 、 [New] を ク リ ッ ク し て 下 さ い 。 BBoot が 追 加 さ れ 、 Project : BBoot 、

C/C++Application : Debug¥BBoot と設定されます。 
 

 
図 12-28 BBoot を追加 
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[XMD Target Connection]タブをクリックして下さい。XMD Target Type、XMD Connect Command を確認

し、[Debug]をクリックして下さい。 
 

 
図 12-29 XMD の設定(Microblaze の場合) 

 

 
図 12-30 XMD の設定(PowerPC の場合) 
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XMD、GDB が立ち上がります。main 関数で Break し、以下のような画面になります。 
 

 
図 12-31 main 関数で Break 

 
Resume をクリックして下さい。先ほど設定した BreakPoint で Break します。Step Into 等をクリックしてく

ださい。Instruction Stepping Mode をクリックすると、インストラクション単位でステップ実行できるようになります。 
 

 
図 12-32 timer_interrupt_handler で Break 
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ローカル変数やスタックの一覧を確認してみてください。 

 

 
図 12-33 スタック一覧やローカル変数を確認 

スタック一覧 

ローカル変数 
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12.5. これから先は・・・ 

本書はこれで終わりです。FPGA 開発する上での基礎知識、ISE や EDK といった専用開発ツールの使い方、

VHDL 言語の記述方法、FPGA に搭載されるプロセッサの使用方法、そして SUZAKU の効果的な使い方は身に

ついたでしょうか。スターターキットを通して学んだことは、ほんの足掛かりにすぎません。ここからは自ら調べ、情報

を仕入れ、勉強をし、アイデアを練り、情報を発信し、SUZAKU 開発者のスペシャリストを目指してください。 
本書と対になる SUZAKU スターターキットガイド(Linux 開発編)では本書とは違った切り口で SUZAKU の開発

を行うので、是非ご一読ください！ 
 
12.6. 最新版のダウンロード 

本書で紹介いたしましたソースコードやファイルは、不具合解決や機能増強等のアップグレードを行うことがありま

す。下記サイトに最新版がございますのでダウンロードしてお使いください。 
 
開発に関するファイル  http://suzaku.atmark-techno.com/downloads/all  
各種マニュアル   http://suzaku.atmark-techno.com/downloads/docs  
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13. SUZAKU＋LED/SW ボードのピンアサイン 
 

 
SUZAKU と LED/SW ボードの全ピンアサインを載せます。SUZAKU で新たに何かを開発する時などにご参照

ください。 
13.1. SUZAKU のピンアサイン 
13.1.1. SUZAKU CON1 RS-232C 

RS-232C コネクタです。レベルバッファを介して、FPGA と接続しています。ボード側で使用しているコネクタは、

型式：A1-10PA-2.54DSA、メーカ：ヒロセ（相当品）です。 

表 13-1 シリアルコンソールの設定 

項目 設定 
転送レート 115.2kbps 
データ 8bit 
パリティ なし 
ストップ bit 1bit 
フロー制御 なし 

 
表 13-2 SUZAKU CON1 RS-232C 

FPGA 接続ピン番号 
番号 信号名 I/O 機能  SZ010 

SZ030 SZ130 SZ310 SZ410 

1   空き      
2   空き      
3 RXD I  E2 C12 C10 Y4 
4 RTS O  F4 B13 D9 V4 
5 TXD O  E4 A13 C9 U4 
6 CTS I  E1 D12 D10 V3 
7   空き      
8   空き      
9 GND  グランド      

10 +3.3VOUT O 内部ロジック用電源出力+3.3V      
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13.1.2. SUZAKU CON2 外部 I/O、フラッシュメモリ用コネクタ 

外部 I/O 及びフラッシュメモリ用コネクタです。LED/SW ボードの CON2 とコネクタ接続します。 

表 13-3 SUZAKU CON2 外部 I/O、フラッシュメモリ用コネクタ 

FPGA 接続ピン番号 
番号 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1  グランド      
2 O 内部ロジック用電源出力+3.3V      
3 I FPGA プログラム用 TCK CLK TCK CLK 
4 I FPGA プログラム用 TDI D TDI D 
5 O FPGA プログラム用 TDO DO TDO DO 
6 I FPGA プログラム用 TMS nCS TMS nCS 
7 I/O 外部 I/O  A5 N5 E14 E14 
8 I/O 外部 I/O  A7 N4 E15 D15 
9 I/O 外部 I/O  A3 M6 E13 E15 
10 I/O 外部 I/O  D5 M5 F12 F15 
11 I/O 外部 I/O  B4 M3 F13 P4 
12 I/O 外部 I/O  A4 M4 F14 P5 
13 I/O 外部 I/O  C5 L5 F15 P1 
14 I/O 外部 I/O  B5 L6 F16 P2 
15 I/O 外部 I/O  E6 L4 G13 L2 
16 I/O 外部 I/O  D6 L3 G14 M2 
17 I/O 外部 I/O  C6 L2 G15 N2 
18 I/O 外部 I/O  B6 L1 G16 N3 
19  グランド or 誤挿入防止用       
20 I/O 外部 I/O （GCLK） A8 C9 N9 Y7 
21  グランド       
22 I/O 外部 I/O （GCLK） B8 D9 P9 W7 
23 I/O 外部 I/O  E7 K5 G12 N4 
24 I/O 外部 I/O  D7 K6 H13 N5 
25 I/O 外部 I/O  C7 K4 H14 M3 
26 I/O 外部 I/O  B7 K3 H15 M4 
27 I/O 外部 I/O  D8 J2 H16 H4 
28 I/O 外部 I/O  C8 J1 J16 H5 
29 I/O 外部 I/O  A9 F9 J15 E2 
30 I/O 外部 I/O  A12 E9 J14 D2 
31 I/O 外部 I/O  C10 A10 J13 U9 
32 I/O 外部 I/O  D12 B10 K12 V10 
33 I/O 外部 I/O  A14 D11 K16 L1 
34 I/O 外部 I/O  B14 C11 K15 M1 
35 I/O 外部 I/O  A13 F11 K14 G4 
36 I/O 外部 I/O  B13 E11 K13 G5 
37 I/O 外部 I/O  B12 E12 L16 G2 
38 I/O 外部 I/O  C12 F12 L15 F2 
39 I/O 外部 I/O  D11 B11 L14 F1 
40 I/O 外部 I/O  E11 A11 L13 E1 
41  グランド      
42  グランド      
43 I 電源入力+3.3V      
44 I 電源入力+3.3V      
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13.1.3. SUZAKU CON3 外部 I/O コネクタ 

外部 I/O コネクタです。LED/SW ボードの CON3 とコネクタ接続します。 

表 13-4 SUZAKU CON3 外部 I/O コネクタ 

FPGA 接続ピン番号 
番号 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1 I 電源入力+3.3V      
2 I 電源入力+3.3V      
3  グランド      
4  グランド      
5 I/O 外部 I/O   B11 B14 L12 K3 
6 I/O 外部 I/O   C11 A14 M13 K2 
7 I/O 外部 I/O  D10 D14 M16 K1 
8 I/O 外部 I/O   E10 C14 N16 J2 
9 I/O 外部 I/O  A10 B16 M15 H3 
10 I/O 外部 I/O  B10 A16 M14 H2 
11 I/O 外部 I/O  B16 C18 P15 L5 
12 I/O 外部 I/O  C16 C17 P13 L4 
13 I/O 外部 I/O  C15 D17 R14 K5 
14 I/O 外部 I/O  D14 D16 P14 K4 
15 I/O 外部 I/O  D15 F15 T15 J6 
16 I/O 外部 I/O  D16 F14 T14 J5 
17 I/O 外部 I/O  E13 G14 N12 H1 
18 I/O 外部 I/O  E14 G13 P12 G1 
19 I/O 外部 I/O  E15 F18 N11 F3 
20 I/O 外部 I/O  E16 F17 M11 E3 
21 I/O 外部 I/O  F12 G15 M10 C3 
22 I/O 外部 I/O  F13 G16 N10 C2 
23 I/O 外部 I/O （GCLK） C9 E10 R9 W5 
24  グランド       
25 I/O 外部 I/O （GCLK） D9 D10 T9 Y5 
26  グランド       
27 I/O 外部 I/O  F14 H14 P10 B2 
28 I/O 外部 I/O  F15 H15 T8 C1 
29 I/O 外部 I/O  G12 H16 R8 A3 
30 I/O 外部 I/O  G13 H17 P8 B3 
31 I/O 外部 I/O  G14 J12 N8 J4 
32 I/O 外部 I/O  G15 J13 P7 J3 
33 I/O 外部 I/O  H13 J15 N7 D4 
34 I/O 外部 I/O  H14 J14 M7 D3 
35 I/O 外部 I/O  H15 J17 M6 D5 
36 I/O 外部 I/O  H16 J16 N6 E5 
37 I/O 外部 I/O  P16 K15 P5 B4 
38 I/O 外部 I/O  R16 K14 N5 C4 
39 I/O 外部 I/O  K15 K13 T3 C6 
40 I/O 外部 I/O  G16 K12 T2 C5 
41        
42  未接続      
43 O 内部ロジック用電源出力+3.3V      
44  グランド      
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13.1.4. SUZAKU CON4 外部 I/O コネクタ 

外部 I/O コネクタです。コネクタは実装されていません。 

表 13-5 SUZAKU CON4 外部 I/O コネクタ 

FPGA 接続ピン番号 
番号 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1  空き      
2  空き      
3 I/O 外部 I/O  L15 L18 N8 B5 
4 I/O 外部 I/O  L14 L17 P7 A5 
5 I/O 外部 I/O  K12 L16 N7 A6 
6 I/O 外部 I/O  L12 L15 M7 B6 
7 I/O 外部 I/O  K14 N18 M6 D8 
8 I/O 外部 I/O  K13 M18 N6 C8 
9 I/O 外部 I/O  J14 M16 P5 M5 
10 I/O 外部 I/O  J13 M15 N5 M6 
11 I/O 外部 I/O  J16 P17 T3 C13 
12 I/O 外部 I/O  K16 P18 T2 D13 

 
 

13.1.5. SUZAKU CON5 外部 I/O コネクタ 
外部 I/O コネクタです。コネクタは実装されていません。 

表 13-6 SUZAKU CON5 外部 I/O コネクタ 

FPGA 接続ピン番号 
番号 I/O 機能 SZ010 

SZ030 SZ130 SZ310  

1  グランド      
2 O 内部ロジック用電源出力 +3.3V      
3 I/O 外部 I/O  P15 M14 P4 F4 
4 I/O 外部 I/O  P14 M13 R3 F5 
5 I/O 外部 I/O  N16 R15 P3 F6 
6 I/O 外部 I/O  N15 R16 P2 E6 
7 I/O 外部 I/O  M14 R18 M10 D6 
8 I/O 外部 I/O  N14 T18 N10 E7 
9 I/O 外部 I/O  M16 U18 P10 D9 

10 I/O 外部 I/O  M15 T17 T8 C9 
11 I/O 外部 I/O  L13 T15 R8 C12 
12 I/O 外部 I/O  M13 R14 P8 D12 
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13.1.6. SUZAKU CON6 電源入力+3.3V 

SUZAKU と LED/SW ボードを接続時は使用しないでください。詳細は"5.3.1 電源について"を参照してくださ

い。 
13.1.7. SUZAKU CON7 FPGA JTAG 用コネクタ 

FPGA JTAG 用コネクタです。コンフィギュレーションする時は SUZAKU JP1、JP2 をショートしてください。 
詳細は"6.2 FPGA の書き換えかた"を参照してください。 

表 13-7 SUZAKU CON7 FPGA JTAG 用コネクタ 

番号 信号名 I/O 機能   
1 GND  グランド   
2 +2.5VOUT O 内部ロジック用電源出力 +2.5V   
3 TCK I JTAG   
4 TDI I JTAG   
5 TDO O JTAG   
6 TMS I JTAG   

 

 
図 13-1 JTAG ピンアサイン 

13.1.8. SUZAKU D1,D3 LED 
ユーザーコントロール LED(赤)とパワーON LED(緑)です。 

表 13-8 SUZAKU D1、D3 LED 

FPGA 接続ピン番号 
信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

D1 O ユーザーコントロール LED G5 T3 A9 T4 
D3 O SUZAKU ボードに＋3.3V が供給されると点灯     
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13.1.9. SUZAKU JP1,JP2 設定用ジャンパ 

ジャンパによりオートブートモード、ブートローダモード、FPGA コンフィギュレーション待ちの 3 つの状態に設定し

ます。 

表 13-9 SUZAKU JP1、JP2 設定用ジャンパ 

信号名 I/O 機能   

JP1 I 
起動モード設定用ジャンパです。オープンでオートブート（SUZAKU
起動時に Linux が自動的に起動）します。ショートでブートローダモ

ード（ブートローダのみを起動した状態）になります。 

JP2  

FPGA に JTAG からコンフィギュレーションする時と、フラッシュメモリ

にコンフィギュレーションデータをダウンロードする時に使用するジャン

パです。（本ジャンパをショートすると、電源再投入時 FPGA に対し、

コンフィギュレーションを停止することができます） 

 
13.1.10. SUZAKU L2 Ethernet 10BASE-T/100BASE-TX 

ボード側で使用しているコネクタ型式/メーカは、J0026D21B/PULSE です。 

表 13-10 SUZAKU L2 Ethernet 10BASE-T/100BASE-TX 

番号 信号名 I/O 機能 
1 TX+  差動ツイストペア出力+ 
2 TX‐  差動ツイストペア出力‐ 
3 RX+  差動ツイストペア入力+ 
4    75Ω終端（4 番ピンと 5 番ピンはショートしています) 
5    75Ω終端（4 番ピンと 5 番ピンはショートしています) 
6 RX‐  差動ツイストペア入力‐ 
7    75Ω終端（7 番ピンと 8 番ピンはショートしています) 
8    75Ω終端（7 番ピンと 8 番ピンはショートしています) 

 
 
 
13.2. LED/SW ボードのピンアサイン 
13.2.1. LED/SW CON1 テスト拡張用コネクタ 

CON3 と同じピンアサインで信号が配線接続されています。詳しくは CON3 を参照してください。 
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13.2.2. LED/SW CON2 SUZAKU 接続コネクタ 

SUZAKU CON2 と接続します。 

表 13-11 LED/SW CON2 SUZAKU 接続コネクタ 

FPGA 接続ピン番号 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1 GND  グランド      
2 +3.3V I +3.3V SUZAKU 側から供給      
3 CONF_C   TCK CLK TCK CLK 
4 CONF_I   TDI D TDI D 
5 CONF_O   TDO DO TDO DO 
6 CONF_S   TMS nCS TMS nCS 
7 NC   A5 N5 E14 E14 
8 UART3 I RTS A7 N4 E15 D15 
9 UART2 O TXD A3 M6 E13 E15 
10 UART1 O CTS D5 M5 F12 F15 
11 UART0 I RXD B4 M3 F13 P4 
12 NC    A4 M4 F14 P5 
13 SEG7 O セグメント DP "Hiｇｈ"で点灯 C5 L5 F15 P1 
14 SEG6 O セグメント G "High"で点灯 B5 L6 F16 P2 
15 SEG5 O セグメント F "High"で点灯 E6 L4 G13 L2 
16 SEG4 O セグメント E "High"で点灯 D6 L3 G14 M2 
17 SEG3 O セグメント D "High"で点灯 C6 L2 G15 N2 
18 SEG2 O セグメント C "High"で点灯 B6 L1 G16 N3 
19   誤挿入防止用       
20 SEG1 O セグメント B "High"で点灯 A8 C9 N9 Y7 
21 GND  グランド       
22 SEG0 O セグメント A "High"で点灯 B8 D9 P9 W7 
23 NC    E7 K5 G12 N4 
24 nSEL2 O 7 セグメント LED3 "Low"でコモン選択 D7 K6 H13 N5 
25 nSEL1 O 7 セグメント LED2 "Low"でコモン選択 C7 K4 H14 M3 
26 nSEL0 O 7 セグメント LED1 "Low"でコモン選択 B7 K3 H15 M4 
27 NC    D8 J2 H16 H4 
28 nCODE3 I ロータリスイッチ 4 ビット目 選択時"Low" C8 J1 J16 H5 
29 nCODE2 I ロータリスイッチ 3 ビット目 選択時"Low" A9 F9 J15 E2 
30 nCODE1 I ロータリスイッチ 2 ビット目 選択時"Low" A12 E9 J14 D2 
31 nCODE0 I ロータリスイッチ 1 ビット目 選択時"Low" C10 A10 J13 U9 
32 NC    D12 B10 K12 V10 
33 nSW2 I 押しボタンスイッチ SW3 押下で"Low" A14 D11 K16 L1 
34 nSW1 I 押しボタンスイッチ SW2 押下で"Low" B14 C11 K15 M1 
35 nSW0 I 押しボタンスイッチ SW1 押下で"Low" A13 F11 K14 G4 
36 NC   B13 E11 K13 G5 
37 nLE0 O 単色 LED(緑) D1 "Low"で点灯 B12 E12 L16 G2 
38 nLE1 O 単色 LED(緑) D2 "Low"で点灯 C12 F12 L15 F2 
39 nLE2 O 単色 LED(緑) D3 "Low"で点灯 D11 B11 L14 F1 
40 nLE3 O 単色 LED(緑) D4 "Low"で点灯 E11 A11 L13 E1 
41 GND  グランド      
42 GND  グランド      
43 +3.3V O 電源出力 +3.3V SUZAKU 側に供給      
44 +3.3V O 電源出力 +3.3V SUZAKU 側に供給      
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13.2.3. LED/SW CON3 SUZAKU 接続コネクタ 

SUZAKU CON3 と接続しています。 

表 13-12 LED/SW CON3 SUZAKU 接続コネクタ 

番号 信号名 I/O 機能 
1 +3.3V O +3.3V SUZAKU 側に供給 
2 +3.3V O +3.3V SUZAKU 側に供給 
3 GND  グランド 
4 GND  グランド 
5      
6      
7      
8      
9      

10      
11      
12      
13      
14      
15      
16      
17      
18      
19      
20      
21      
22      
23      
24 GND  グランド 
25      
26 GND  グランド 
27      
28      
29      
30      
31      
32      
33      
34      
35      
36      
37      
38      
39      
40      
41      
42      
43 +3.3V I +3.3V SUZAKU 側から供給 
44 GND  グランド 
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13.2.4. LED/SW CON4 テスト拡張用コネクタ 
CON2 と同じピンアサインで信号が配線接続されています。信号についての詳細は CON2 を参照してください。

1~6 ピンにフラッシュメモリ書き込み用コネクタが実装されています。SUZAKU と接続時、フラッシュメモリにデータ

を書き込めます。書き込む時は SUZAKU JP1、JP2 をショートしてください。 
詳細は"6.2 FPGA の書き換えかた"を参照してください。 

表 13-13 LED/SW CON4 フラッシュメモリ書き込み用コネクタ 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1 GND       
2 +3.3V       
3 CONF_C I  TCK CLK TCK CLK 
4 CONF_I I  TDI D TDI D 
5 CONF_O O  TDO DO TDO DO 
6 CONF_S I  TMS nCS TMS nCS 

 

 
図 13-2 フラッシュメモリ書き込み ピンアサイン 

 
13.2.5. LED/SW CON6 ＋5V 入力コネクタ 

＋5V±5％の電源を入力してください。AC アダプタ 5V は添付品をご使用ください。（＋5V 出力 EIAJ＃2） 

表 13-14 LED/SW CON6 ＋5V 入力コネクタ 

番号 信号名 I/O 機能 
1 ＋5V I ＋5V センタープラスピン 
2 GND  グランド 

 

 
図 13-3 ＋5V センタープラスピン 



SUZAKU                                                 Starter Kit Guide (FPGA) Version 2.2.0 
 

                         LED/SW ボードのピンアサイン 
 

320

 
13.2.6. LED/SW CON7 RS-232C コネクタ 

D-sub9 ピンが実装されています。 

表 13-15 LED/SW CON7 RS-232C コネクタ 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

1        
2 UART0 I RXD B4 M3 F13 P4 
3 UART2 O TXD A3 M6 E13 E15 
4         
5 GND  グランド      
6         
7 UART3 O RTS A7 N4 E14 D15 
8 UART1 I CTS D5 M5 F12 F15 
9         

 
 
13.2.7. LED/SW 7 セグメント LED セレクタ 

7 セグメント LED 選択用 PNP トランジスタが実装されています。”Low”を入力すると、それぞれに対応する 7 セ

グメント LED を選択することができます。 

表 13-16 LED/SW ７セグメント LED セレクタ 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

LED1 nSEL0 O LED1 コモン "Low"で選択 B7 K3 H15 M4 
LED2 nSEL1 O LED2 コモン "Low"で選択 C7 K4 H14 M3 
LED3 nSEL2 O LED3 コモン "Low"で選択 D7 K6 H13 N5 
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13.2.8. LED/SW LED1～3  7 セグメント LED 

7 セグメント LED が 3 つ実装されています。”High”を入力すると、それぞれに対応するセグメントを点灯させるこ

とができます。 

表 13-17 LED/SW LED1~3  7 セグメント LED 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

A SEG0 O セグメント A "High"で点灯 B8 D9 P9 W7 
B SEG1 O セグメント B " High"で点灯 A8 C9 N9 Y7 
C SEG2 O セグメント C " High"で点灯 B6 L1 G16 N3 
D SEG3 O セグメント D " High"で点灯 C6 L2 G15 N2 
E SEG4 O セグメント E " High "で点灯 D6 L3 G14 M2 
F SEG5 O セグメント F "High"で点灯 E6 L4 G13 L2 
G SEG6 O セグメント G "High"で点灯 B5 L6 F16 P2 

DP SEG7 O セグメント DP "High"で点灯 C5 L5 F15 P1 
 

 

 
図 13-4 7 セグメント LED 

 
 
13.2.9. LED/SW D1～4 単色 LED(緑) 

単色 LED（緑）が４つ実装されています。”Low”を入力すると点灯します。 

表 13-18 LED/SW D1～4 単色 LED(緑) 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

D1 nLE0 O 単色 LED(緑） D1  "Low"で点灯 B12 E12 L16 G2 
D2 nLE1 O 単色 LED(緑） D2  "Low"で点灯 C12 F12 L15 F2 
D3 nLE2 O 単色 LED(緑） D3  "Low"で点灯 D11 B11 L14 F1 
D4 nLE3 O 単色 LED(緑） D4  "Low"で点灯 E11 A11 L13 E1 
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13.2.10. LED/SW SW1～3 押しボタンスイッチ 

押しボタンスイッチが 3 つ実装されています。押すと”Low”を出力します。 

表 13-19 LED/SW SW1～3 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

SW1 nSW0 I 押しボタンスイッチ SW1 押下で"Low" A13 F11 K14 G4 
SW2 nSW1 I 押しボタンスイッチ SW2 押下で"Low" B14 C11 K15 M1 
SW3 nSW2 I 押しボタンスイッチ SW3 押下で"Low" A14 D11 K16 L1 
 

13.2.11. LED/SW SW4 ロータリコードスイッチ 
ロータリコードスイッチが実装されています。選択時”Low”を出力します。 

表 13-20 LED/SW SW4 

FPGA 接続先 
番号 信号名 I/O 機能 SZ010 

SZ030 SZ130 SZ310 SZ410 

nCODE0 I ロータリコードスイッチ 20  選択で”Low” C10 A10 J13 U9 
nCODE1 I ロータリコードスイッチ 2１  選択で”Low” A12 E9 J14 D2 
nCODE2 I ロータリコードスイッチ 2２  選択で”Low” A9 F9 J15 E2 SW4 

nCODE3 I ロータリコードスイッチ 2３  選択で”Low” C8 J1 J16 H5 
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● 本書記載の社名、製品名について 
本書に記載されている社名、および製品名は、一般的に開発メーカの登録商標です。

なお、本文中では TM、®、©の各名称を明記しておりません。 

 
改訂履歴 

Ver. 年月日 改訂内容 
1.0.0 2006/07/14 ・初版作成 
1.0.1 2006/07/19 ・誤記訂正 
1.0.2 2006/07/24 ・ピンアサイン訂正（CON4 の 9、10 ピン） 
2.0.0 2006/08/11 ・SZ010、SZ030、SZ310 対応のための全面変更（以下重要な変更のみ記） 

  “JTAG Clock に変更する”の記載を消去 
   BBoot の変更、CD-ROM の内容変更 
   自作コアに割り込み機能追加 

2.0.1 2006/08/18 ・TE7720 の図の文字化けを修正 
2.0.2 2006/08/23 ・誤記訂正 
2.0.3 2006/10/18 ・Linux 編にあわせて章構成変更 

・保証に関する注意事項追記 
・半田付けの際の注意を追記 
・コネクタ説明箇所に JTAG、Flash メモリ書き込みについて追記 
・8.2i 対応のための内容を追記 

2.1.2 2006/11/30 ・構成を大幅変更(以下重要な変更のみ記) 
   ダイナミック点灯、単色 LED 順次点灯、デコーダの VHDL 修正 
   SZ130 のメモリマップ 誤記訂正 
   SZ310 の構成図 誤記訂正 
   IP コアハード編の項 誤記訂正 
   EDK の項 ソフトウェアについて追記 
   EDK の項 IP コアの説明を追記 
   シミュレーションの記述を追記 
   SUZAKU の書き込み方を一つにまとめて記述 
   デバッグの項追加 
   参考文献を追加 
   EDK を ISE のサブモジュールにする方法を追加 

2.1.3 2006/12/06 ・メモリマップ誤記訂正 
・JTAG、SPI のピンアサインの図に色づけ 
・その他誤記訂正 
・表紙デザイン改版 

2.1.4 2007/01/19 ・EDK の使い方の章に SZ310 のリンカースクリプトについて追記 
・EDK の使い方の章に BSB の使い方を追加 

2.1.5 2007/02/16 ・SUZAKU についての章に SUZAKU 全体ブロック図等追記 
・TIPS パラレルポートがなくても追加 
・TIPS FPGA の bin ファイルの作り方追加 
・TIPS XMD コマンド追加 
・TIPS MicroBlaze 追加 
・その他修正、構成変更 

2.1.6 2007/03/16 ・２段階Ｂｏｏｔの図を修正、誤記訂正 
2.1.7 2007/04/20 ・BSB で MicroBlaze の章に PowerPC の内容を追記 

・デバッグの章の内容修正 



 

 

 
Ver. 年月日 改訂内容 
2.1.8 2007/07/20 ・ISE/EDK9.1i にて内容確認&内容修正 

   静的割り込みから動的割り込みに変更 
・UCF に CMOS 3.3V を明記 
・SDK を使ってデバッグの章を追加 
・その他文章訂正 

2.2.0 2007/10/10 ・SZ410 対応のための全面変更 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

SUZAKU スターターキットガイド（FPGA 開発編）           2007 年 10 月 10 日 Version 2.2.0 
 

 
060-0035 札幌市中央区北 5 条東 2 丁目 AFT ビル 6F           TEL: 011-207-6550  FAX: 011-207-6570 

 


	SUZAKUについて
	SUZAKUの特徴
	仕様
	全体ブロック図
	SZ010、SZ030
	SZ130
	SZ310
	SZ410

	メモリマップ
	SZ010、SZ030
	SZ130
	SZ310
	SZ410


	LED/SWボードについて
	回路説明
	ピンアサイン

	SUZAKU＋LED/SWボードの構成
	各種インターフェースの配置

	電源を入れる前に
	必要なもの
	開発環境
	付属CD-ROMについて
	組み立て

	SUZAKU＋LED/SWボードを動かす
	接続方法
	シリアル通信ソフトウェア
	ブートローダモードでスロットマシンを動かす
	電源について
	スロットマシン起動

	オートブートモードでLinuxを動かす
	Linuxの起動
	ログイン
	ネットワークの設定
	ウェブ
	終了方法

	SUZAKUのブートシーケンス

	SUZAKUを書き換える
	フラッシュメモリマップ
	SZ130
	SZ010
	SZ030, SZ310
	SZ410

	FPGAの書き換えかた
	iMPACTで書き換える
	LBPlayer2で書き換える
	SPI Writerで書き換える

	ブートローダHermitの書き換えかた
	BBootで書き換える

	Linuxの書き換えかた
	ダウンローダHermitで書き換える


	ISEの使い方
	単色LEDを点灯させる
	単色LED周辺回路

	プロジェクトの新規作成
	プロジェクト作成
	デバイスの選択
	ソースファイル作成

	ソースファイル作成
	論理合成
	インプリメンテーション
	プログラムファイル作成
	コンフィギュレーション
	JTAGでコンフィギュレーション
	フラッシュメモリに保存してコンフィギュレーション

	空きピン処理

	VHDLによるロジック設計
	VHDLの基本構造
	ライブラリ宣言とパッケージ呼び出し
	エンティティ(entity)
	アーキテクチャ(architecture)
	組み合わせ回路(not、and、or)
	押しボタンスイッチ周辺回路
	not、and、orを使う

	順序回路
	D-FF(D型フリップフロップ)
	同期設計
	カウンタ

	ISE Simulatorの使い方
	プロジェクトの新規作成
	テストベンチの新規作成
	シミュレーション実行


	FPGA入門 スロットマシン製作
	単色LEDの順次点灯
	単色LED周辺回路
	プロジェクト新規作成、論理合成
	シミュレーション
	再度論理合成
	インプリメンテーション
	プログラムファイル作成、コンフィギュレーション
	バスのビットラベルについて

	7セグメントLED デコーダ
	ロータリコードスイッチ周辺回路
	7セグメントLED周辺回路
	プロジェクト新規作成、論理合成
	シミュレーション
	インプリメンテーション
	プログラムファイル作成、コンフィギュレーション

	ダイナミック点灯
	7セグメントLED周辺回路
	プロジェクト新規作成、論理合成
	シミュレーション
	インプリメンテーション
	プログラムファイル作成、コンフィギュレーション


	EDKの使い方
	BSBではじめてのMicroBlaze & PowerPC
	BSB
	XPS ハードウェア設定
	XPS アプリケーション作成
	プログラムファイルを作成してコンフィギュレーション

	SUZAKUのデフォルト
	SZ010, SZ030の構成
	SZ130の構成
	SZ310の構成
	SZ410の構成
	IPコア

	GPIOの追加
	GPIOの接続
	ハードウェア設定
	ネットリスト, プログラムファイル(Hardのみ) 作成
	ソフトウェア設定
	アプリケーション編集
	アプリケーション生成
	プログラムファイル作成
	コンフィギュレーション
	空きピン処理

	UARTの追加
	ハードウェア設定
	ネットリスト, プログラムファイル(Hardのみ) 作成
	ソフトウェア設定
	アプリケーション編集
	アプリケーション生成
	プログラムファイル作成
	コンフィギュレーション


	スロットマシンのコアをCPUで制御する
	ウィザードを使ってOPBインターフェースをつくる
	今まで作ってきた回路をまとめる
	sil00u_core.vhd

	OPBインターフェースとコアを接続し、自作IPコアを仕上げる
	user_logic.vhd
	opb_sil00u.vhd
	opb_sil00u_v2_1_0.mpd
	opb_sil00u.c

	自作IPコアの追加
	SZ010、SZ030の場合
	SZ130の場合
	SZ310の場合
	SZ410の場合
	ハードウェア設定
	ネットリスト, プログラムファイル(Hardのみ) 作成
	BBoot編集
	アプリケーション生成
	プログラムファイル作成
	コンフィギュレーション

	スロットマシン完成
	スロットマシン動作確認

	ソフトウェアのデバッグ
	ソフトウェアデバッグ用にFPGAプロジェクトを更新
	デバッガの設定
	XMDの起動
	GDBを起動し、ソフトウェアのスタートをさせる
	ステップ実行で割り込みの流れをみる
	slot.cの動作を確認してみる


	こんなこともやってみよう
	EDKをISEのサブモジュールとして読み込む
	EDKで作業
	EDKからISEへ移行
	ISEで作業

	IPコア(ハード版)
	CGIで7セグメントLEDをコントロール
	7seg-led-control.c

	SDKを使ってデバッグ
	これから先は・・・
	最新版のダウンロード

	SUZAKU＋LED/SWボードのピンアサイン
	SUZAKUのピンアサイン
	SUZAKU CON1 RS-232C
	SUZAKU CON2 外部I/O、フラッシュメモリ用コネクタ
	SUZAKU CON3 外部I/Oコネクタ
	SUZAKU CON4 外部I/Oコネクタ
	SUZAKU CON5 外部I/Oコネクタ
	SUZAKU CON6 電源入力+3.3V
	SUZAKU CON7 FPGA JTAG用コネクタ
	SUZAKU D1,D3 LED
	SUZAKU JP1,JP2 設定用ジャンパ
	SUZAKU L2 Ethernet 10BASE-T/100BASE-TX

	LED/SWボードのピンアサイン
	LED/SW CON1 テスト拡張用コネクタ
	LED/SW CON2 SUZAKU接続コネクタ
	LED/SW CON3 SUZAKU接続コネクタ
	LED/SW CON4 テスト拡張用コネクタ
	LED/SW CON6 ＋5V入力コネクタ
	LED/SW CON7 RS-232C コネクタ
	LED/SW 7セグメントLEDセレクタ
	LED/SW LED1～3  7セグメントLED
	LED/SW D1～4 単色LED(緑)
	LED/SW SW1～3 押しボタンスイッチ
	LED/SW SW4 ロータリコードスイッチ


	参考文献


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /PageByPage
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails true
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /Arial-Black
    /MS-Gothic
    /MS-PGothic
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee575284e8e9ad88d2891cf76845370524d6253537030028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f0030028fd94e9b8bbe7f6e89816c425d4c51655b574f533002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c9069752865bc9ad854c18cea76845370524d521753703002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f300290194e9b8a2d5b9a89816c425d4c51655b57578b3002>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


